


I
I’M GETTING SICK and tired of certain people
complaining about Linux distros, and the difficulties
they face when using them. Just to clarify, I’m not
talking about the majority, because I usually
sympathise with complaints about technology, but
when an IT implementer or a “tech freak” says
something like “Linux is not ready for the desktop”,
it’s the last straw. At a recent conference, a very
senior security analyst told me that there is no such
thing as an “easy-to-use-Linux distro”. 

In order to get users to switch an operating
system, you have to follow logic. If it’s not broken,
don’t fix it, but if it is, do whatever it takes to fix it.
All of us know the advantages of switching to Linux,
no viruses, spyware and the resulting crashes. In a
professional environment, this leads to a loss of
man hours, and worse, a lot of data loss.

So now, in a work environment, Linux begins to
sound like OS utopia. This is especially true when
you think of the average corporate environment,
where a lot of people on PCs need nothing more
than a browser, an office suite and a mail client.
With software usage restrictions in place, employees
are generally not allowed to use much else. Now
Linux can do all of this and more, and to be honest,
if you never get into the administrative functioning
of Windows-lookalike Linux distros, you’d never
notice the difference.

Now I’m not stupid enough to suggest that all
companies switch all employees to Linux. To begin
with, you’d have huge problems trying to pry
graphics professionals away from their Photoshop
machines, and suggesting alternate software to
them is likely to earn you a black eye. However,
those who don’t use Windows-only software for
their job roles can easily be ported to Linux. Even if
you factor the cost and time of the basic training
that’s required to get people used to Linux, you’d
still end up saving a fortune in OS costs, anti-virus
costs, and probably even IT staff costs.

Maybe it’s just me, but I don’t see any sense in
statements like “I’ve seen, implemented and used
Windows for so long, that I know what to expect
from it…” To me, this basically translates to, people
saying, “I’m so used to anti-virus and anti-spyware
software, that I can’t imagine life without it.” 

Another thing I want to clarify is that this is
not one of those popular “Windows-bashing”
articles that you will find thousands of. I run
Windows XP myself, and it’s never crashed on me
in 3 years. However, what’s really wrong with
operating systems is PEBKAC (Problem Exists
Between Keyboard And Chair). With millions of
malware, sitting on the Net waiting for a gullible
user to make just one wrong-click, employees who
don’t know better are the real problem for IT heads.
It takes just one virus to bring down a network, and
cause losses in the millions.

The tools to prevent such disasters exist, they’re
readily available, free, secure, easy-to-use and filled
to the brim with features, and yet some of the
people whose job it is to find these very solutions
spout idiotic tripe like “Desktop Linux is an
oxymoron”. Well, you got the “moron” part right sir,
but sadly, nothing else. 
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FREE
Sam & Max: Abe Lincoln
Must Die!

The
president’s
lost it.
Federally
mandated
group hugs, a

pudding embargo... what’s next, gun
control? Sam & Max are off to
Washington to take care of this
bozo, but the political climate will
only get stormier... and a new power
will rise... 

Energetic 1.0
It is a stealth
education
platform
game using
state of the

art 3D technologies to display 2D
graphics. Easy, fun, and with a
classic game play this game makes
an attempt at providing the player
with an entertaining experience
while also learning about energy
and the environment.
n Bontag
n I Wanna Be The Guy

DEMOS
Sins of a Solar Empire

In the future,
the survival of
humanity
stands on the
edge of utter
ruin as three
powerful
factions vie

for control of the galaxy. Take
command of one of three space-
faring races as you work to establish
your domination of the galaxy in
Sins of a Solar Empire. Through a
combination of diplomacy, economic
skill, cultural influence, and sheer
military might you will establish
order over your corner of the galaxy.

MOVIES
The Shadow
Strikes
(1937)
Lamont
Cranston
assumes his
secret identity
as “The
Shadow”, to
break up an attempted robbery at
an attorney’s office. When the
police search the scene, Cranston
must assume the identity of the
attorney. Before he can leave, a
phone call summons the attorney to
the home of Delthern, a wealthy
client, who wants a new will drawn
up. As Cranston meets with him,
Delthern is suddenly shot, and
Cranston is quickly caught up in a
new mystery.

CHANNEL 9
Nick Baker: Xbox 360
Architecture
What is the XBox 360, exactly? How
do you go about designing and
building a game console that meets
the high standards of today’s gamers
and handles the computational
pressures of today’s highly realistic
games (think real time physics
computation, incredibly rich graphics,
etc)? Did you know the XBox 360
team saw into the multi-core future
before most anybody else?

PhotoSynth: What.
How. Why
Blaise Aguera y Arcas is an
Architect of PhotoSynth, which is a
super cool 3-D image “tourism”
application that enables a new
methodology for exploring related
groups of images using a complex
imaging algorithm developed in
part by Microsoft Research. Here,
Charles sits down with Blaise to
learn the details of the What How
and Why of this highly innovative
distributed 3-D image processing
application. PhotoSynth enables a
whole new way of exlporing images.

PERSONAL
OpenOffice.org
3.0.0 Beta 1
OpenOffice.org is a free,
Open Source alternative to
MS Office with a Word
compatible word processor,
an Excel compatible spread
sheet program and a
PowerPoint like
presentation software. It
also allows to save to PDF.

Spicebird Beta 0.4
The Spicebird application
was designed to be a

complete comunication
platform for many

collaboration needs. It
provides e-mail,
calendaring and instant
messaging with intuitive
integration and unlimited
extensibility. 
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Edition 3.0
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n Movie Magic

Screenwriter 6 (Mac)
n Pagico 3.1.0.51 (Mac)
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MSDN Express
Library for Visual
Studio 2008
Express Editions
The Microsoft MSDN
Express Library is an
abridged version of the full
Microsoft MSDN Library. It
contains the most
important content for new
users of Visual Studio
2008 Express Editions and
Visual Studio 2008
Standard Edition to get
familiar with both the
Visual Studio Integrated
Development Environment
(IDE), Microsoft’s
Development Languages
(VB, C#, C++), and most of
the core .NET Framework
classes.

MULTIMEDIA
Vue 6 Personal Learning Edition

Designed for vfx studios, animators,
architects and matte painters, e-on
software’s professional solutions offer
the most advanced tools for creating,
animating and rendering natural 3D
environments, and integrating them into
any production pipeline. The Vue 6 PLE is
a fully functionnal version of Vue 6 that
lets you save your work, export and
render without size limit. But best of all,
it never expires, so you can learn Vue 6
at your own pace.

Adobe Audition 3
Recording, mixing, editing, and
mastering — Adobe Audition 3 software

is the all-in-one toolset for professional
audio production.
n Ayam
n BRL-CAD
n CinePaint (Mac)
n Frinika
n Google Earth
n Google SketchUp
n Microsoft Photosynth Tech Preview
n form.Z
n LoopWorx Hip Hop Edition 1.0

SYSTEM
Windows Vista Service Pack 1

Windows Vista Service
Pack 1 is an update to
Windows Vista that
addresses key feedback
from our customers.
SP1 addresses specific

reliability and performance issues,
supports new types of hardware, and adds
support for several emerging standards.

Mandriva Linux One 2008.1
(KDE)
Mandriva Linux One 2008 is the best way

to start using Linux. A full Linux
operating system on a single CD for both
new and experienced Linux users, it is
fast to download and install, and also
safe to try with a live mode. One is really
the one CD you need!
n AVG Anti-Virus Free Edition Update
n Comodo Memory Firewall 2.0.4.20
n Inguma

n Kaspersky Anti-Virus 7.0 Update
n Norton AntiVirus Update for Windows

2000/XP/Vista
n Remote Queue Manager Personal

4.2.162
n RemoveIT Pro 4 SE 9.4.2008
n Simple Machine Protect
n Windows Vista Service Pack 1 (x64)
n ZoneAlarm Free 7.1
n Agnitum Outpost Antivirus Pro
n Dr.Web 4.44.2
n ESET Smart Security 3.0.650
n Kerio WinRoute Firewall 6.4.2
n MOBILedit! Unlimited Edition 2.8.2.9
n NTI Ninja 2.0.5.19R2
n Security Desktop Tool 5.5.2.5
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n ATI Catalyst Software Suite Vista32 8.2
n ATI Catalyst Software Suite Vista64 8.2
n ATI Catalyst Software Suite xp32 8.2
n ATI Catalyst Software Suite xp64 8.2
n NVIDIA Forceware Vista32 174.16
n NVIDIA Forceware Vista64 174.16
n NVIDIA Forceware XP32 174.16
n NVIDIA Forceware XP64 174.16

Gaming
PERSONAL
Google Email Uploader

The Google Email Uploader is a open
source desktop utility for Microsoft
Windows. It uploads email and
contacts from desktop email
programs (like Microsoft Outlook)
into your Google Apps mailbox. It
preserves information such as sent
dates and sender/recipient data, as
well as the folder structure used by
email programs.

QuiiQ MOVIES 1.1

QuiiQ MOVIES is a brand new way to
archive, manage and watch your
entire movies collection. Just use
your remote control to transform
your TV box into a glamorous cinema
projector with direct links to your
favorite titles, actors, directors and
digital copies of your movies.
n Free PDF to Word Doc Converter
n Lingoes
n MP3 EZlib Music Library and

Playlist Manager 2.4
n ProgramLaunch
n TTMS 1.5
n Vista User Time Manager

FREE
And Yet It Moves

And Yet It
Moves is
basically a
mixture
between a
jump and run
and a puzzle

game, with the extra ability to rotate
the world. The player can run left,
right and jump, but can also turn the
world clockwise and
counterclockwise by 90 degrees.
When this happens physics works the
following way: as soon as rotation

starts all objects get frozen and after
rotation objects continue to move
with their velocities (direction and
speed) they had before.
n Blood Car! 2000! Deluxe!
n Every Extend
n flOw
n Infinite Underwear Attack
n Pogo Sticker
n Racing Pitch
n Rainpaper
n Super Mario—

Realm Of The 1000th Twilight
n Toribash
n Twin Tower
n Vegetable Soup Tactics

DEMOS
New Star Soccer
New Star
Soccer 3 is the
award winning
football game
that lets YOU
be the star
player. Take
full control of
your career and work your way to the
top. Defender, midfielder or attacker,
the choice is yours, just make sure
you keep the boss, fans and everyone
else happy on your rise to football
stardom!

ESSENTIALS
n .net Framework 2.0
n µTorrent 1.7.7
n Avast Home Edition 4.8
n Avast Update
n Comodo Firewall Pro 3
n Digit Software Archive 2006 Beta
n DirectX Redistributable 9.0c March

2008
n Foxit Reader
n Free Download Manager 2.5
n Irfan View 4.10
n Irfan View 4.10 Plugins
n Java(TM) 2 Runtime
n K-Lite Mega Codec Pack 3.8.5
n Microsoft XNA Framework n

Redistributable 1.0 Refresh
n Opera 9.27
n Silverlight
n Spybot Search and Destroy 1.52
n Spybot Search and Detection updates
n VLC Player 0.8.6f
n Winamp
n WinRAR 3.71

MULTIMEDIA
GIMPShop 2.2.11
(Ubuntu deb)

GIMPshop is a mod-
ification of the
free/open source
GNU Image
Manipulation
Program (GIMP),

intended to replicate the feel of Adobe

Photoshop. Its primary purpose is to make
users of Photoshop feel comfortable using
GIMP.

Kerkythea 2008 Echo
Kerkythea is
a free multi-
platform
standalone
rendering
software that
can be used
to create

photorealistic image renderings using
physically accurate materials and lighting
when integrated with Blender, SketchUp,
Wings3D, 3ds Max, Silo and any program
that exports files in OBJ and 3DS formats.
n Alien 303 1.2
n AuthorPOINT Lite
n Flash this
n i.Mage
n MandelFilm 1.00
n PhotoMesa
n Photoscape
n SUPER Free video converter
n WaveGenix FX Pack 1.0
n Digital Music Record Convert Burn

Station 7.4.1.10
n e-Radio Mixer 2.17
n Fake Voice 1.45
n inTone | Guitar Pro 1.0.9
n Soundmasker 6.00.32
n SuperMp3Normalizer 1.04
n YoGen Vocoder 1.1.0

SYSTEM
Ashampoo Antivirus 1.61

Free for Digit read-
ers! Ashampoo
AntiVirus gives you
comprehensive pro-
tection against
viruses, worms,
Trojans and dialers,
but it’s so efficient

you won’t even notice it’s there. And it’s
so easy to use that it won’t waste any
of your valuable time. Just set it and
forget it and get on with more impor-
tant things.

TuneUp Utilities 2008
Improve your
system’s per-
formance,
thoroughly
clean up your
hard drives,
solve your PC

problems with a few clicks, and cus-
tomize windows to your personal
requirements.
n DocShield
n Fisehippo Update Checker v1.021
n JkDefrag GUI
n Link Shell Extension
n O&O Defrag 2000
n PC Inspector File Recovery 4.0
n RecentFilesView
n Shell Tools

n ZipInstaller
n The Mop 4.44.20

INTERNET
Google Talk Labs Edition

Google Talk, plus
alerts from Gmail,
Calendar and
Orkut! You need to
be connected to
the Internet for
this installer to
work

Safari 3.1
Experience the web,
Apple style, with
Safari: the fastest,
easiest-to-use web
browser in the
world. With its sim-
ple, elegant inter-
face, Safari gets out
of your way and lets you
enjoy the web, up to 2 times faster than
Internet Explorer.
n Avant Browser 11.6
n F-ab
n Mikogo
n TightVNC 1.3.9
n Toggle Flash
n Tor
n XeroBank Browser
n LanFlow Net Diagrammer 6.01.2011
n Magnesium: RSS 2.0 Ticker

Tools
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Productivity
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GamingEntertainment

FREE GAME
Ocular Ink
In a strange and twisted land where evil,
dismembered body parts roam the
countryside, you play the role of a young
paintbrush-wielding eyeball that is
determined to free his home town from
the fearsome clutches of the evil eye-
pirate known far and wide as Patches
Deadlights. Travel through bizarre
environments, learning new and
powerful attacks with your paintbrush.

Featured
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FEATURED TUTORIAL FROM THE DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month we feature a member tutorial from the forum.

That’s it, I can’t see the slogan “Intel Inside, Idiot
outside” coming true & then users blaming Windows
just because they don’t know how to work on
Windows. No operating system in this world is good
enough out of the box, you always need to make it
good by installing or removing things you need &
don’t need. This is a process which will sure take
some time but the process is easy & you can save
the files & settings so that you don’t need to do it
again & simply use the old settings.
There is a way I use my computer due to which I
don’t need to install Windows again & again, like
many people do. In my case, it works when I want it
to, the way I want it to. I decided to share my
deployment expertise here which might help other
Windows Vista user. I don’t use many paid apps now,
& also use some OSS apps where applicable, so I am
making this tutorial in a step by step way.
1) Install Windows Vista, then go to Windows Update
& install every update available.
2) If you have a Bluetooth adapter, then don’t forget

to install BlueSoleil 5. It is a must have application
for all your Bluetooth needs in Windows Vista.
Although you can transfer & receive files without
BlueSoleil in Vista too, but since it is an OEM bundle,
chances are you already have it bundled with your
Bluetooth adapter.
3) Make sure you use Ad Muncher, it is a must have
application for Windows Vista. Just install it, then run
it & forget it, it won’t bug you & do its work auto-
matically. Vista comes with Windows Defender which
is good enough for removing Adware & Spyware. If
you want something else, there are many free tools
to choose from but once u start using Ad Muncher,
you won’t need an adware cleaner & you can very
well disable Windows Defender.

For more visit:
http://www.thinkdigit.com/forum/showthread.
php?t=78233

14-01-2008, 
09:28 PM

gx_saurav
The G-Axe Effect

Join Date: Jan
2007
Location:
Lucknow
Posts: 4,584

UUssiinngg WWiinnddoowwss VViissttaa:: TThhee MMVVPP WWaayy

Buying
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all the categories
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before buying

Get A Taste Of The All New ThinkDigit
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tech blogs online,

and submit your
own blog for
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your favourite
tech magazine,

available online,
for free!
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hard drives are cheap, easy
to fabricate and can provide
terabytes of storage, they are
not very reliable and also
very fragile. Flash memory,
on the other hand, is quite
rugged, yet wear out after
repeated use and are
relatively expensive. Another
option is combining hard
drives and flash memories—a
data storage medium that is
cheap and easy to make and
maintain with almost
unlimited storage!
Manufacturers have for long
been researching this area.
Now IBM claims to have hit
the jackpot by inventing
such a medium and plans to
introduce it to the market
after four years.

Referred to as “racetrack”
by scientists, this data
storage medium is based on
spintronics—a physical
phenomenon that uses the
charge and spin properties
of electrons to store data.
When there is a need to read
or write data, an electric
charge is passed through the
nano wire, causing magnetic
domains to move and data to
be transferred. 

IBM has been working on
this project using the spin
properties of atoms for four
years. In the latest
prototypes, current pulses
were used with a frequency

the same as the resonant
frequency of the nano wire.
As a result, the current
requirement has been
reduced by five-folds,
making this new technology
more practical. The
fabrication of the
nanowires, as well as the
ability to move the domains
linearly are the main
challenges. 

Thousands of nanowires
can be accommodated by
fabrication on a silicon chip,
thereby making further
miniaturisation of memory
a reality. Once the
fabrication process is
perfected, the memory chips
will be virtually
indestructible, consume very
low power and reliably store
huge amounts of data.

LEAVE SILICON ALONE

Pushing
Boundaries

Conventional silicon
chips are fast
approaching the

boundaries imposed by
physical laws, at least in
terms of the number of
transistors that can be
squeezed in a given surface
area. For quite a while now,
chipmakers have been

looking at alternate
materials that can
overcome these limitations
of silicon and stay in line
with the popular Moore’s
law without unpleasant
consequences—like
overheating and data
corruption. 

IBM and a host of
partners from the
semiconductor industry
have recently announced
the discovery of one such
material. Referred to as

Windows 7
Touch-based
inputs, and
MinWin that
basically is the
new kernel that

uses almost negligible
amounts of memory.
Windows 7 will be much
zippier than Vista, or so we
hear... let’s wait and watch

So Soon?
“But you just made
me pay for Vista?”
is the standard
user response to
the announcement
of Windos 7.

It’s only fairtoo... since XP
did last many years, and
already many feel that Vista
wasn’t needed. Again, wait
and watch.
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SCEE’s Zeno Colaço was in
Mumbai for DevStation 2008 this
April—Sony’s first in India

What do you expect to get out
of DevStation Mumbai 08?
Firstly, we’re really excited about
our first technical conference for
Indian game developers. We
intend to give them assistance in
developing games for our
platforms, and reduce the
barriers to their entry in the
market. We’re also looking to
provide commercial assistance—
kit loans, consultancy, and
perhaps even publishing. 

What’s the Indian game
development scene for your
platform been like thus far?
We’ve not had games come out
of India yet, but we know that
the technical knowhow is here.
We’re funding a project based on
Hanuman right now, and we’re
looking for more such projects—
properties that will appeal to the
Indian market. What we’re
definitely not doing is telling
developers what to develop.

What platform are you focusing
your efforts on, and why?
For DevStation 08, the main focus
is the PS2—we have a huge install
base in the Indian market waiting
to be tapped into, with specific
games developed for Indians. We
also have about 120 million PS2s
worldwide, so exporting these
games will be a lot easier. We’re
not ignoring the PS3, but it will
still take some time for it to grow
into a larger market.

How much life do you think the
PS2 has left?
In the next next 12-18 months,
we should hit 50 million units
in the Asia-Pacific market—a
20-25 per cent growth. The PS2
will continue to be a viable
platform for the next 3-4 years
at least, and key developers
and publishers realise that too.
It’s priced right, and will
coexist happily with the PS3,
just like the original
PlayStation did with the PS2.

Boom Blox For Wii
Steven Spielberg, along with Electronic Arts, is on
the verge of releasing a puzzle game Boom Blox for
kids. The game has over 300 levels, several unique
game modes and 30-odd characters, which could be
altered and customised with an editor. 

Free Music On Mobile
Nokia has signed up a deal with Sony BMG to
provide free access for a year, to artists from Sony
BMG for specific phone models branded under
“Comes With Music”branded cellphones by the end
of the year.

Child porn is one of the
toughest evils our
society faces today.

Paedophilia and other
sickening crimes against
sweet and joy-filled kids only
depict the levels to which
mankind can stoop. However
strongly we may try to deny
it, reality bites! Even though
it’s been around for long, it
was the Internet which
unfortunately led to it
becoming a mass
phenomenon. The Internet
simplified distribution of
media of all kinds, which
was traditionally the most
difficult to do. As  Web sites
proliferated, money flowed
in and the exploitation and
child abuse increased.
Taking advantage of poor
economic conditions,
criminals have managed to
lure children, many of them
less than ten years of age,
with some as young as two.
The results are a schocking
tale—disturbing pictures of
them being sexually abused
to a worldwide audience. 

Fortunately, many
organisations have now
started dedicated efforts to
curb the spread of child
porn. A few years ago,
Microsoft donated $1
million for fighting under
age porn. Google, on its part
has vowed to block child
porn related advertisements.
Recently, cell phone
operators across Europe and
Africa got together to found
the Mobile Alliance Against
Child Sexual Abuse to ban
these images from cellular
networks. With all the
efforts commonly targetting
this social evil, governments

and law enforcement
agencies have started a
worldwide crack down.
However, as a result of the
online patronage, one
Website would replace
another that was blocked.

After sustained efforts,
there is finally some good
news for organisations and
activists working for the
welfare of children—the
number of Web sites
peddling child porn has
actually decreased. From a
peak of 3,052 such sites in
2006, the number has fallen
to 2,752 last year. All these
Web sites are in English, and
most of them are based in
Russia and the US.
According to the Internet
Watch Foundation (IWF), an
NGO that monitors these
efforts, it is possible to put

an end to this crime with
more manageable number
of sites and an agreement in
place with hosting
companies that stipulate the
taking down of child porn
Web sites. 

If everything goes
according to plan, the Net
will be a lot safer for the
next generation.

BIG BLUE’S TWISTER

Spinning
Electrons To
Store Data

Hard drives and Flash
drives, two most
commonly used

memory devices have their
own pros and cons. While

Enter

Security Watch

MORALS BEFORE MONEY

Hope For Kids

15
n Distributed computing project for earthquake monitoring coming soon in California n Europe clears use of mobiles on aircrafts n Open standard Linux-based mobile device platform LiMO released n IBM launches Mashup Suite, a mashup application for businesses

Zeno Colaço
Vice-President, Publisher & Developer

Relations, Sony Computer
Entertainment Europe

Vulnerabilities in
Flash Player
The problem
Adobe recently found critical
vulnerabilities in Adobe Flash
Player version 9.0.115.0 and
8.0.39.0 and previous versions. 

If Web sites carrying
malware in an SWF file, e-mails
or links leading to SWF source
files are accessed, then it
invites the arbitrarily malicious
code to reside on the computer
and run remotely. 

Solution
Similar to Adobe Reader and
Acrobat, vulnerabilities in
Adobe products are announced
with a solution by Adobe. Well,
that’s all secondary—what you
need to do is to download and
install the latest version of
Adobe Flash Player from
http://lin.cr/ac. The player
must be updated to the latest
version 9.0.124.0 either by fresh
download or using auto-update.

With this update, the
potential issues of DNS
rebinding attack can be
mitigated. The code parameters
for the cross-domain policy will
be updated from ‘always’ to
‘sameDomain’ for all SWF
players from version 7 and
earlier. Thus, the process of
cross-domain policy files
becomes stricter.

How green are your computing habits?

I print only what’s essential I unplug all appliances when not in use

I donate/recycle old computer parts I’m not very green, but I can improve DC

BA

(You, too, can participate in this poll—at www.thinkdigit.com)

Opinion Poll

“I choose option 2. I’m normally the one
who leaves office last, ensuring that all the
computers on my 
way out are switched off. It’s
just my small way of giving
back to the planet.”
Akhil Singh
Delhi

Since they are becoming scarce, energy
generated from renewable and non-
renewable sources of energy
needs to be saved. If a single
man saves energy, imagine
how much energy could be
saved when the whole world
starts acting wisely.
Ashish Tiwari
Delhi

I guess by unplugging your appliances first
and foremost cut downs your elecrticity
bills  to large extent and saves
money. Also when not
required, the system should be
shutdown and unplugged to
save them from damage.
Netra Parikh
Mumbai

My choice is option 2. When you’re not
going to be using it for a long time, turn it
off. The same can be said for
peripherals, too. It all adds up.
Not only will you save energy
and money, you’ll also protect
your computer from unneces-
sary wear and tear.
Jeet Patel
Pune

I work with frequently changing scripts,
so if I keep taking print outs, then there
would be a lot wastage. Hence,
I wait for the final draft, until
then I continue with my work
with a pencil or pen. This way
I save at least a tree or two.
Jaladhi Chhaya
Baroda

“I choose 4. I am a designer by profession
and it is very important for me to check
how the final design looks like
on paper. Unless some way is
invented, there no way in
which I see myself going
‘green’ “
Yashwant Miranda
Delhi.
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high-k or metal gate, this
new material will not
replace silicon in the entire
transistor, but will be
grafted in parts of the
transistor that control
power and switching, quite
similar to an FET (Field
Effect Transistor). With this
newly developed material,
chips can be further
miniaturised, made more
power efficient and also
faster. High-k is a term for
materials with a high
dielectric constant, which,
in layman’s terms, are
materials that can hold
plenty of electric charge.
High-k materials are also
very efficient, as they can
switch between on and off
states even when the
current is either very low
or very high. Some
materials with a dielectric
constant higher than
silicon dioxide used in
conventional chips, are
zirconium dioxide and
titanium dioxide. The name
of the new material that
IBM is using in the chips is
a closely guarded secret.

These new hybrid chips
are likely to be used in the
new 32-nm chip fabrication

process. IBM and its
partners have announced
that foundries for
customers fabricating low
cost 32-nm chips would be
available by the end of this
year. Hopefully, by 2009,
chips with high-k materials
would be available to
consumers.

MOBILE 2.0

Handheld
Blogging

Terms such as
“twittering” and
“funwalls” are

popular on the Web these
days. It’s the fun way of
sharing the latest
happenings in your life
with your near and dear
ones. Now consider doing
all this from your
handheld or mobile phone!
With a range of Web 2.0
ideas like blogging, video
sharing, image sharing or
audio sharing online, this
is a reality. Taking the time
constraint into
consideration, a new Web
2.0 is born—“micro-
blogging” has evolved. But

we knew that already.
Micro-blogs are posted

on-the-move using mobile
phones or other mobile
Internet devices. Twitter,
Utterz, JuiceCaster, Haiku,
and several other sites have
been around for a couple of
years, and are now
extending their services to
the mobile arena. 

According to Randy
Corke, President—Utterz,
“What are the four things
you can do with a mobile
phone? You can talk, you
can send text, you can take
pictures and send video.
We want to use the
technology that you have
in your pocket.”

In fact, it’s surprising
that several sites,
applications and services
based on sites like Twitter
are cropping up to add a
tinge of flavour to the
micro-blogging recipe. 

Micro-blogging is 
meant to be friendly, but
can also turn out to be a
killer. Head to
http://lin.cr/e5 to read the
stream of tweets lashing at
BusinessWeek reporter
Sarah Lacy’s interview of
Mark Zuckerberg, CEO—

Facebook, and you’ll know
what we mean.

Messaging through
mobile phones can also
turn out to be a cause for
concern for users in terms
of cost per message and also
to the service providers,
who after all, have to
manage tonnes of messages
rushing to their switches.
However, on a positive note,
this gives rise to new
technologies in both
hardware and software,
what with most hackers
turning their attention to
mobiles and mobile
Internet devices.

WHAT’S COOKING?

EU Panel
Pulls On
Search
Engines

Recetly, Internet
search engines
Google, Yahoo and

MSN were questioned over
users’ privacy by an EU
panel. These search
engines monitor user

A Round-up Of Technology News From Across The GlobeThe Digital World

n YouTube videos to be added in Google Maps listings n Yahoo’s Flickr expands into video n AT&T says Internet to hit full capacity by 2010

MALAYSIA
Abdul Rahman Dahlan,
secretary general of the
United Malays National
Party’s Youth wing,
announced that all the
leaders of the ruling party
will need to set up blogs
for self introduction

JAPAN
As per the Machine
Industry Memorial
Foundation, robots would
be capable of filling the
jobs of 3.5 million people
by 2025

ISRAEL
As per a new list of rules announced,
the soldiers and Defence Ministry
employees would be prevented from
revealing classified details on social
networking sites. These were called for
since some soldiers had uploaded their
photos with classified equipment

BRAZIL
Judge Flavio Rabello passed
a judgement to ban the
controversial game “Bully”,
since it was too violent for
young kids and teenagers

IRAQ 
The first generation of “war
bots” deployed were recalled
after they “refused to obey”
their human operators and
started firing when they were
not supposed to. Few weeks
ago a debate was sparked on
ethics of deploying war bots.

INDONESIA
YouTube was blocked after the site
carried a Dutch lawmaker’s film
accusing the Koran of sparking
violence. The Web site was blocked
for two days, but officials believe
it’s going to be a long chase since
the film would keep moving from
one site to another. 
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Photograph Vinod Chandak Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

The number you have called
is currently unreachable

behaviour (search query
history) for statistical
analysis and further
utilisation 
in improving their
algorithms.  

The report from Article
29 of the Data Protection
Working Party says that
“search engine providers
must delete or irreversibly
anonymise personal data
once they no longer serve
the specified and legitimate
purpose they were collected
for”. Hence, even if the data
is collected through
cookies, their lifetime
shouldn’t be significant.
Also, the data should be
used for personalised
adverts, only if the user has
consented for the same.

These data fields are
anonymised by Yahoo after
13 months, while Google
and MSN anonymise user
data after 18 months.
However, do these search
engines safely anonymise
your personal data when it
can reveal critical
information such as your
location or service
provider? The possibility of
this data of yours being

misused does not go in
your favour! Can you really
be certain that the
inferences of your search
behaviour and pattern are
not sold off to any
advertising major?

Popularly referred to as
stalking, search engines
normally track user’s
search history by collecting
their unique IP addresses
an including a unique ID in
cookies. Search engines
collect information
reagarding search query
patterns and results for
billing the advertisers,
through these very same
cookies. Such
comprehensive data with
regard to different search
patterns, queries, choice of
results and user profile,
which includes
demogrpahics is like a
haven for advertising firms
to bombard users with
their ads. 

The data could possibly
be compromised or
exploited. Also, the main
issue is user’s privacy,
which must not be
compromised under any
cost, as per the EU panel.

No matter who you are or
where you are from, no one
should be allowed to fiddle
around with user’s privacy. 

THE CHINESE CONNECTION

Becoming
The Largest
Online
Population

According to latest
news reports, China
now not only boasts

of the largest population,
but also the highest
number of Internet users.
The China Network
Information Centre has
revealed that the number
of Internet users in China
is around 221 million.
However, although this
figure is now greater than
the number of Internet
users in US, the ratio of
Internet users to the total
population is still lower
than the global average.

While the global
average was 19.1 per cent,
the Chinese stood at 16 per

cent.  In the wake of online
censorship and several
other restrictions, these
figures are more of an
indication of the
magnamous Chinese
population, rather than the
IT development. Although,
this might be a moment of
pride, especially from an
Asian point of view, India
definitely is in a much
better state, considering
the online freedom and
liberty that we enjoy as
surfers, despite the lower
Internet penetration in
rural areas.

DIRECTING DISH

News Corp
Alleged To
Have Hired
Hacker

Acomputer hacker has
reportedly testified
that he was hired by

a News Corp unit to
develop pirated software.
The NDS Group, in which
News Corp is the largest

Last Month’s Winner!
V.K.Ramakrishna Chowdary,
Hyderabad 
“Need a drive? Please insert
driver”

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

Puzzles For 
Programmers 
and Pros
by Dennis E. Shasha

Published by

n Technology that measures smiles released in Japan for use in cameras, robots and medicine n Cartoon Network’s MMOG FusionFall delayed
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shareholder, provides
security technology to a
global network that also
includes DirecTV, the
popular satellite TV
services provider.

However, the
controversy erupted with
rival DISH Network filing a
corporate spying lawsuit
against News Corp’s NDS
Group If proven guilty,
NDS could end up paying
hundreds of millions of
dollars in compensation. In
response, NDS has stated

that it was only engaged in
reverse engineering. The
hacker, Christopher
Tarnovsky, has been
referred to as being among
the top two hackers in the
world in the lawsuit.
Tarnovsky said that he
received his first payment
of $20,000 in cash, hidden
in electronic devices from
Canada. He also said that
he has been receiving
payments from Harper
Collins, the publishing arm
of News Corp, for the past 

ten years.
While Tarnovsky claims

all he was doing was
making DirecTV more
secure, DISH claims that
this whole incident is a
major conspiracy and was
in fact intended at hacking
into its network, modifying
its security code and
causing around $900
million in losses.

MORE NETWORKING

MyIndia!

MySpace, the social
networking site
that was hounded

by controversies and
hiccups last year, still
remains one of the
favourites after Orkut, Hi5
and Facebook among social
networking enthusiasts. To
add to this offering, there
are Indian players like
Fropper, Big Adda,
Minglebox, Yaari and others
vying for a piece of the
social networking pie.

Launched with much
fanfare, News Corp’s
announced a series of plans
for the expansion for
MySpace India. Channel V is
already running a campus
talent hunt show “Campus
Star” that is being judged
by celebrities and members
of MySpace. Also, MySpace
will partner with the music
label SaReGaMa for an
initiative that promotes
over 30 bands across the
country. This will be
followed by MySpace Live

concerts that would be
aired on TV. A variety of
content would be delivered
through a range of industry
partnerships and innovative
products according to
Travis Katz, Managing
Director (International)
MySpace.

An event for software
developers (similar to
devJAM) held in other
countries, will be organised
at Bangalore, to help
developers create
applications for MySpace
users. Recently, Orkut
announced applications for
its users, while Facebook
has been providing such
services for quite a while
now. The application
development event at
Bangalore will most likely
increase competition
among the social
networking brands
currently active in India.  

MySpace India’s COO,
Amit Kapur said, “We give
unique tools to the users to
create a colourful
environment on the site”.
Despite the setbacks and
initial hiccups that
MySpace had suffered with
malware and ads, it has a
vast market and growth
potential in a market like
India, which has a sizeable
number of users on Orkut
and Hi5, followed by
Facebook. MySpace,
currently has round 5 lakh
Indian users. 

These days, with the
average browser getting
increasingly aware of bots

It’s all about the mobile
these days, and when you
want to develop a

processor for gadgets that fit in your pocket, you’ve got
to think smart. 

So far, ARM-based processors have been the
powerhouse of choice for smartphones and PDAs, but if
Intel has its way, the universal language of x86 is set to
be spoken in your pocket, too. Intel’s new Atom
processor is built with the world’s smallest transistors,
sports a shiny new design, and has been built
specifically to consume very little power. This, of
course, means that it can power mobile phones, PDAs,
and other “Mobile Internet Devices” (MIDs). 

The numbers, if they are to be believed, are
astounding: a Thermal Design Power (TDP) that

ranges from less than a Watt to a maximum of 2.5
Watts and an idle power consumption of 30
milliwatts. And it’ll be really cheap, too. What’s not
to love?

Support for the Atom has come in abundance—
Acer is expected to show off an Atom-based, ultra-low-
cost laptop (though this might be a relative term)
some time in June this year. Around the same time, it’s
expected that ASUS will release an updated Eee PC,
also based on the Atom.

Japanese handset firm Willcom Inc has already
released the world’s first Atom-based mobile phone—
the D4. What really puts a feather in Intel’s cap is that
this little phone runs—wait for it—Vista! 

Start saving up—it won’t be long before you’ll lay
your eyes on the next generation of smartphones!

According to a
University of
Hertfordshire

survey of 1,158
kids aged 18-24 in

the UK, 95 per
cent of them have

“pirated”
music before. 

Big Champagne,
PC Pitstop and

Digital Music News
joined forces to

analyse
1,661,688 PCs to

track 152 unique
P2P clients

quarterly from
September ‘06 to

September ‘07.

Data from Sophos indicates that
23,300 new spam-related Web

pages were created every day
during the first three months of
2008, which means one spam
site about every three seconds.

Ofcom’s survey of 5,000
adults and 3,000 children

found 49 per cent of those aged
between eight and 17 have a

social networking profile. 

n Pro Chinese hackers threaten to attack CNN because of negative reporting, then cancel plan n Grand Theft Auto IV leaks on to torrent network n

ATOM
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CinemaDNG
What is CinemaDNG?
Adobe Systems announced an
initiative for defining an open-
file format for digital cinema
files and called it CinemaDNG.
DNG (Digital Negative) is aimed
at delivering to the video arena
what RAW did for still imagery. 

Who would be working on it?
The coalition of industry entities
like cinema camera
manufacturers (Panavision,
Silicon Imaging, Dalsa, Weisscam
and ARRI), software vendors
(Iridas and The Foundry) and
codec provider CineFORM would
be working together for defining
and publicly documenting the
open-file format—CinemaDNG.

Why is it necessary?
Digital cinema requires dealing
with a variety of file formats,
which needs to be handled by
different hardware and
applications. With CinemaDNG, a
common platform is possible,
thereby easing most hassles
such as compatibility and
archiving.

When will it be finalised?
No specific time frame has been
announced, since the initiative is
being carried in coalition with
camera manufacturers and
other industry players. 

How will it be beneficial?
Film makers can have a robust
format for archiving with the
highest quality source in open
standards file formats.
Manufacturers on the other
hand, will enjoy the elimination
of developmental costs for
proprietary formats and
conversion tools. 

Which segment will it directly
affect?
As a whole, the major
beneficiaries of this open format
will be the film-making
fraternity. The open file format
will directly affect prominent
film-makers, since the hardware
supporting CinemaDNG would
yield significantly superior video
quality.

and automated mail, the
presence of well-known and
starry profiles no longer
appeal to users.

YOU PROMISED ME A
LAPTOP!

OLPC
Leadership
Parts Ways

The much hyped One
Laptop Per Child
project, which was

aimed at producing a
laptop around the
psychological $100 figure,
is in peril, again. Two of its
key promoters—Nicholas
Negroponte and Walter
Bender—seem to have had
their little battles with
each other, which seems to
be resulting in bigger
battles. Although the
project is the brainchild of
Negroponte, his longtime
MIT colleague Bender took
care of the software
deployment and content
for the XO laptop which
was meant to be an
educational tool.

Bender wants to
continue efforts to develop
its dedicated Sugar
software, and get it to work
in a Linux environment,
while on the other hand,
Negroponte seems to be
anticipating growth for his
project. He is eager to have
a dual boot option in the
XO to accommodate a
scaled down version of
Windows, which
Microsoft has been
targeting for a very long
time.

Sugar uses icons and
other graphical features
as an interface. However,
it avoids Window’s
formats and is not
compatible with its files.
The latest news is that
Bender has quit the OLPC
project. This comes as
disappointment to the
open source proponents
who supported the OLPC
movement in its initial
days. In an official
statement, OLPC

spokesman George Snell
said “Bender will not be
replaced”. He also added
that the position of
President of software and
content has been
eliminated. 

XPENSIVE BUY

Ballmer
Says XP
Could Stay

Microsoft, when they
launched their
latest OS—Vista,

had planned to shelf the
earlier XP from sales on
June 30, 2008. However,
Steve Ballmer, CEO—
Microsoft clarified, that XP
sales could continue, if
customers intended at
using them. He went on to
add that as of now, there
was no such indication
from customers.

Earlier, Microsoft had
set a deadline to remove
Windows XP from its
umbrella of products from
retail sales around June 30.
This was in the wake of
high Vista sales figures. 

It is definitely a subject
of interest why customers
have not hinted at a
demand for XP over Vista,
despite the comparisons,
reviews and reports of XP
and Vista. “XP will hit an
end-of-life. We have
announced one. If
customer feedback varies

we can always wake up
smarter but right now we
have a plan for end-of-life
for new XP shipments,”
Ballmer said in a news
conference.

APPLE ALSO WANTS TO BUY

Objection To
Apple’s
Acquisition

Steve Jobs led Apple
Inc., recently acquired
chipmaker PA Semi.

However, there is now
growing concern over this
move, with a probable
objection from the US
Department of Defense.
The reason—a high
performance, low cost and
power efficient CPU
designed by PA Semi is
used in around 10 defence
systems, with around
70,000 chips to be used
across systems over the
next 10 years.

As Jobs says, Apple
acquired the company for
the talent rather than the
products. Further to the
deal, Jobs also reiterated
that Apple had close
relations with Intel and
that they looked forward to
taking this relationship
further. Nevertheless, in an
industry such as defence, it
is companies like Lockheed
Martin and Raytheon that
would decide the course of
any merger or acquisition

that could probably take
place, because as a direct
consequence of such
deals, procurement of
spare parts and other
materials are affected,
which could hamper
multi-million dollar
deals!

This deal would surely
be under the scanner of
many defence companies,
at least the ones that
used to source their chips
from PA Semi. It all
depends on how Apple
handles the industry
concerns - this time the
department of defence
and not consumers! n

n Yahoo! to “rewire” itself to bring social networking to the forefront n Now edit Google Docs offline with new Google Gears
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The Indian leg of The Imagine Cup, Microsoft’s annual
world-wide, student technology competition is
nearing its climax. The competition, which spans

multiple categories, featured a local competition for the
software design invitational (SDI) category, for which
scores of student teams from across the country worked
on designing solutions in line with the contest’s theme
for the year—“Imagine a world where technology enables a
sustainable environment”.

In India, the SDI category started off with teams
submitting a synopsis of their solution, with all
submitted synopses being evaluated to select the ones
with most potential. This led to a pool of around 30

short-listed teams who had to submit detailed
presentations and documents (including code-snippets),
explaining the core elements of their proposed
solutions. This was then followed by a gruelling round of
telephonic interviews in late March, with judges from
reputed companies in the industry—the focus being not
just on evaluating the technical merit, but also on
gauging the business-case merits of the solutions.

The teams and solutions that have come out of this
searching examination, ready to do battle in the Imagine
Cup National Final in Bangalore on May 9th, 2008, are as
follows. The winning team will represent India in the
Imagine Cup World Finals in Paris, in early July.

Team EcoPals
National Institute of Technology, Kurukshetra
t Arpita Shrivastava t Kshitij Shukla
t Rohit Bhat t U. Karthik

An interactive application to
dynamically guide farmers as to
which crops are best suited to
their soil, water and weather
conditions, which fertilizers,
irrigation schemes, and other
agricultural methods to use. The
application also assesses the effect
of the current crop on the soil

condition and suggests the crop that should be sown next,
which it then iteratively uses to suggest a series of crops to
grow one after the other.

Team GRAS
BITS Pilani, Goa Campus
t Abhishek Kumar
t Gaurav Paruthi
t Shubham Malhotra

A mobile-phone-based application
that uses Web services to share real-
time data with potential buyers of
products at the point-of-purchase.
The data contains information on
the carbon-footprint of each
product and aims to educate
potential buyers into making smart
and ecologically empathetic choices.

Team Green Waves
Delhi University
t Aadhar Mittal t Gagandeep Singh
t Sandeep Bansal t Shobhit Sinha

A citizen-activism-based solution that
exhorts the public to take photographs
of environmental issues in their daily
life, and to send the same via mobile
phone to a centralised agency, which
can then disseminate the information
to appropriate NGOs.

Team Gurus
Chennai Mathematical Institute
Dhirubhai Ambani Institute of Information and
Communication Technology, Gandhi Nagar

s Abhishek Chhajer s Archit Jain
s Sasank Tatineni  s Amit Prakash Ambastha 

Team blAnkSpace
Dhirubhai Ambani Institute of Information and
Communication Technology, Gandhi Nagar.

s Anuj Kumar s Ishan Bishnoi
s Prateek Khurana s Ravi Atluri

A system to connect those who want to dispose of
“garbage / junk” with those who might have
innovative uses for the same. The system also gives
potential users of such items optimal collection-paths
to collect all the items in a locality.

Team Eco Warriors
Vivekananda Educational Society's Institute of
Technology, Mumbai

s Apurva Arvindakshan Nair s Charu Rajkumar Jain
s Ishita Sunity Chakraborty s Mamal Jayendra Karani

An ecological e-Governance mechanism that gathers
information from different service-providers about usage by
citizens, and then calculates corresponding carbon-
emission-levels. Ecological-performance reports are also
generated for individuals, based on which they can be taxed.

A system that accepts inputs from the public on the
preferred locations for civic utilities and resources such as
sewers and dust-bins. The system then uses Vertex Cover
algorithms and K-Means algorithms to determine the most
suitable location for the same, thereby offering an ideal
blend of democratic participation and scientific rationale
in town-planning.

Team Novices@Work
Vivekananda Educational Society's Institute of
Technology, Mumbai

s Krunal Dedhia s Paras Doshi s Saili Dharia s Veenit Mavani

A self-configurable wireless-sensor mesh-network system
that monitors and analyses agricultural-soil parameters
such as moisture-content, nutrient composition,
temperature, pressure and light. This system can be used
by the government or NGOs at a large scale in order to
provide recommendations to farmers on crop-related
decisions.

Team SKAN
Bharti Vidyapeeth College of Engineering, Mumbai
Fr. Conceicao Rodrigues Institute
of Technology, Mumbai
Vivekananda Educational Society's
Institute of Technology, Mumbai

s Amith P George s Karun A. B. s Noel Sequeira
s Sameet Singh Khajuria

A centralised power-management system to monitor an
organisation’s entire computer network and to switch idle
computers into the power-save mode.

For more details about The Imagine Cup, as well as to
participate in the Digital Photography category, please see the
official Imagine Cup Web site at www.imaginecup.com.

Microsoft’s
Imagine Cup
The Finalists
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Ahmed Shaikh

“We’re going to open a can of whoop ass.” Not a line 
you would expect from the CEO of a multi-million 
dollar company, but NVIDIA’s Chief Executive Officer 
Jen-Hsun Huang had those fighting words for its now-
rival, and processor King—Intel.

Intel and NVIDIA have been exchanging words 
lately. Intel has the graphics card industry 
set in sight with its future processor plans. 

NVIDIA, now the only independent graphic 
house post the AMD-ATI merger, is not willing 
to take the threat lying down.

The stakes are high, battle lines have been 
drawn; information warfare through presenta-
tion slides is being fought on an almost daily 
basis. But what is the battle all about? What 
brought these seemingly disparate entities—a 
CPU maker and a GPU maker—to head?

To understand why, we must take a step 
back in time to 1965, when Intel’s Gordon 
E. Moore put down an observation with far-
reaching consequences.

Double The Fun
In the April edition of Electronics Magazine, 
1965, Gordon Moore put forth the germ of what 

would eventually form the Moore’s Law. Moore’s 
original statement read that “The complexity 
for minimum component costs has increased at 
a rate of roughly a factor of two per year…”, this 
kernel of an observation was then elaborated by 
Moore into the statement that is the Law, that  
the number of transistors on a chip will double about 
every two years.

Moore’s Law can be exploited in two ways, 
both of which stem from a common root that 
transistor costs will fall with time. The impli-
cations are (1) increase the clock speed of a 
processor, (2) cram more components onto the 
surface of a chip.

Until the Pentium 4 processor, increasing 
the processor speeds was the option to pick. 
Moore’s Law turned into something of a self-ful-
filling prophecy for the semiconductor industry. 
The Law formed the basis for future roadmaps 
for major silicon companies and thus lent fur-
ther credence to the law—an electronic ourobo-
ros, eating its own tail. Faster and faster the pro-
cessors ran, right up to the point where they hit 
the thermal wall and brought the entire race to 
a standstill. With the Pentium 4, it was pretty 
clear that the thermal output of a fast processor 
took away any positives that a fast chip might 
bring to board.

It was time for a rethink.

A look at Intel’s 
upcoming 
GPU rival—the 
Larrabee 
processor—we 
reveal the why, 
the what, and 
the so-what?

This Means War



Picking up the Red Pill
Option number two is where things are cur-
rently headed. Today, since processor speeds 
have reached something of a plateau, prog-
ress must be made via component integration. 
Sometimes a processor becomes so fast that 
a component that lies outside the processor 
becomes a hindrance, a bottleneck. Integration 
in this case, has a basis in solving a problem: 
access to memory too slow? Bring the pathways 
inside the processor. This was why AMD chose 
to integrate its processor’s memory controller 
within the processor itself.

Integration can also be an option when 
there is no other path to take. As things stand, 
the processors have hit the thermal wall, the 
clockspeed party is bust and the industry is star-
ing at a very fuzzy road ahead.

The fuzziness is reduced a bit when one fol-
lows the money. 

In 2007 a powerpoint presentation made the 
Internet-rounds. It was shared with university 
students by Intel’s Douglas Carmean — Chief 
Architect of their Visual Computing Group (VCG), 
in charge of GPU development at Intel. One of 
the slides in the presentation clearly read:
• CPU profit margins are decreasing
• GPU profit margins are increasing

And this heralded “another significant 
transformation.”

The Road Ahead
The “significant transformation” was already 
in the making. It began with the introduc-
tion of the GPU. More exactly with the intro-
duction of the NV20 chip by NVIDIA in 2001 
which introduced the concept of GPU pro-
grammability. Today the floating point power 
of a consumer GPU card is such that it has tre-
mendous potential to do much more than just 
churn out pixels. 

This thinking was the basis for the so-called 
GPGPU, or the General Purpose GPU. NVIDIA 
further underlined the GP part by introducing 
the ability to program their graphic cards with 
the help of C programming language—via the 
CUDA (Compute Unified Device Architecture) 
architecture and programming model. 

CUDA provides developers access to low-level 
GPU hardware, allowing them to use the floating-
point might of the GPU to solve complex calcula-
tions to simulate smoke, fluids, and also to accel-
erate applications in computational biology. 

Essentially, what CUDA did was bring the 
GPU a bit closer to the CPU. And Intel noticed 
this breach of territory.

If the GPU could become more CPU, then 
what stops the CPU to take on a GPU workload? 
This is Intel’s point of thrust into the lucrative 
GPU market. By creating a processor that can 
handle both floating-point and scalar tasks, 
Intel hopes to capture the entirety of the pro-
cessor market—from low-end processors used in 
cellphones, to high-end supercomputers churn-
ing through high-end physics simulations.

Intel is thus looking at a brave new world 
run on Intel platforms, or more exactly, run on 
Intel’s “systems-on-a-chip”. 

A while back news broke of an initiative 
inside the Intel labs called the Tera-scale project. 
The goal of the project is to explore the possi-
bilities of creating ‘many-core’ processors using 
current technologies as system interconnects to 
render future ideas such as a database-server on 
a chip. One possibility, for example, is that of a 
datacenter that is located entirely on a single 
microprocessor chip consisting of 80-cores—each 
core connected via optical fiber links and talk-
ing with each other using TCP/IP protocols.

This is an extreme example, more practical 
implementations though are already on the 
roadmap, and one such implementation is the 
root cause of the GPU versus CPU battle.

The Larrabee Solution
Larrabee is the code-name for a many-core 
architecture which is due out as engineering 
samples sometime by the end of 2008, and as 
a consumer product by 2009. A many-core pro-
cessor is one that has more than eight cores, 
multi-core being processors with 2-8 cores. 
Little in the form of concrete information is 
known about the Larrabee, and what little was 
revealed by Intel, through a presentation, was 
later retracted when the information went pub-
lic. The details are already out there, however, 
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and even if subject to change, they reveal quite an inter-
esting picture of what forms the face of the Larrabee 
architecture.

The first thing to understand is that ‘Larrabee’ is 
codename for an umbrella of products. Much like Core 
2 Duo and Core 2 Extreme fall under the same multi-
core banner of Intel marketing; Larrabee will consist 
of a series of implementations, sharing a common 
architecture. Differences in the detail will make one 
Larrabee product suitable for notebooks, another for a 
desktop graphic card, and yet another suitable for use 
in a transaction server.

The ‘many-core’ detail of this new architecture will 
be realized by 16-24 cores. Each core will run between 
1.7 and 2.5 GHz depending upon the product that the 
processor will form. The minimum heat signature of 
the implementation will run at least 150W. The num-
ber of cores on each chip, as well as the clock speed, will 
depend on which product the architecture will form 
the basis of: integrated into the motherboard, high-end 
GPU, transactions co-processor, and so on.

Each of the cores will be capable of processing 
four simultaneous threads of execution. Each core 
will also come with an L1 cache as well as a floating 
point unit (FPU) which will implement a subset of the 
x86 instruction set. The x86 set is an important point 
of differentiation between the Larrabee implementa-
tion and current GPU implementations—a graphics 
programmer uses special instruction code to do what 
needs to be done via a GPU. This instruction set is 
hidden behind the more user-friendly API of either 
OpenGL or DirectX layers. While Larrabee will retain 
OGL and DX compatibility, it will also introduce a 
specific instruction set called the Advance Vector 
Extension (AVX) which will help leverage the FPU 
potential of the architecture. 

The AVX set is to be seen in a similar light to SSE 
in current x86 processors—a “256-bit vector extension to 
SSE, for floating-point intensive applications”.

This software soup of x86 instructions and exten-
sions is what Intel is betting on. 

They hope that a more familiar set of code will 
encourage programmers to make better use of the float-
ing point capabilities of the Larrabee architecture. This 
line of thinking could be construed as a bit naïve, con-
sidering the fact that very few games have made use 
of the HyperThreading capabilities of Intel processors; 
and that too, only recently.

Back to the Larrabee architecture—the many-core pro-
cessor will consist of a large L2 cache. This pool of L2 will 
be shared by each core of the processor. Furthermore, 
each core will also be able to lock a part of the L2 cache 
for its own use. Larrabee will also see an on-die memory 
controller (the memory controller is moving on-die for 
a variety of Intel offerings, similar to what AMD already 
has). The final piece of the Larrabee die will determine 
the nature of the final product. This final piece is a fixed-
function unit, dedicated to a single task. A Larabee GPU 
will have a texture sampler for this fixed-function unit 
(a texture sample is essentially one-stage of the DX / OGL 
pipeline), a Larabee server coprocessor will have a hard-
ware encryption unit there, and so on. 

All these components will be connected together 
via a ring bus, similar to what is used by IBM’s Cell.

The End Of An Era?
“Graphics that we have all come to know and love 
today…It’s coming to an end” 
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Intel’s senior vice president Pat Gelsinger 
would like to herald a new era: “Our multi-
decade old 3D graphics rendering architecture 
that’s based on a rasterization approach is no 
longer scalable and suitable for the demands of 
the future”.

That ‘fixed-function unit’, nestled within 
a Larrabee processor will eventually take the 
form of an execution unit dedicated to the task 
of raytracing. This small detail is the source of 
the brewing war between Intel and graphic ven-
dors; as well as a point of disbelief within the 
game developer community.

Raytracing is not just another way to do 
things. It is a completely different way to do 
things. It is a 180-degree turn to an industry 
that has long accepted rasterisation as the 
approach that makes the most sense.

 
So What Is Raytracing?
Imagine this scene before you: you are holding 
and reading this magazine. Now imagine your 
eye as the “camera” in a 3D game—the camera 
is the object that is doing the viewing, while 
the magazine is the scene being viewed. In ray-
tracing an “eye ray” or a “primary ray” is pro-
jected from the viewpoint of the camera. Ray 
tracing uses physics simulations of propaga-
tion of rays to render an object. The algorithm 
first shoots the primary ray from the perspec-
tive of the eye. It then determines which object 
is hit first on the path of the ray. In this exam-
ple, that object would be the magazine. At this 
point the magazine’s material will determine 
the behaviour of the primary ray. If the mate-
rial is transparent, the ray will pass through. If 
it is a mirrored surface, the ray will be reflected 
(angle of reflection, etc. calculated by the ray-
tracing algorithm). If the material is a slightly 
glossy magazine paper—it will reflect some and 
absorb some, and so on. The raytracing algo-
rithm also determines if the object it hits is in 
shadow. To do this, it shoots off a ray from the 
magazine towards the source of light—if this ray 
hits the source, then the magazine can “view” 
the light source and is therefore lit. If the ray is 
obstructed, the magazine is under a shadow.

This is of course, an oversimplification of 
the process. The take-away information is that 
raytracing takes a holistic look at the entire 
scene that is to be rendered, whereas a “raster-
ization” approach basically breaks down the 
entire scene into billions of component trian-
gles. Due to the means used, the cost of raster 
graphics processing is linear with the number 
of pixels to be processed. On the raytracing 
side: the cost of raytracing increases linearly 
with the number of rays shot.

Intel’s research into raytracing showed an 
interesting behaviour. If the scene being ren-
dered is kept static, then there is a point at 
which software-assisted raytracing technique 
is almost as fast as a hardware accelerated ras-
ter technique. Software assisted implies CPU 
driven. Furthermore, the research found that 
if multiple processors are thrown at raytracing, 
the performance scales exponentially. Multiple 
processors became multi-core processors and 
will eventually become many-core processors.

Intel thus envisions a raytracing tech-
nique to render graphics, instead of a raster 
approach. If you consider the architecture of 
the Larrabee processor—16 to 24 cores, each 
running at 1.7GHz at least, along with a dedi-
cated unit to accelerate some raytracing cal-
culations and helped by an extended vector 
instruction set—you can see why raytracing is 
the future for Intel.

A Muddy Path
While Intel would like the entire industry to 
embrace raytracing as the future, ground-real-
ities are different. The largest hurdle is that 
game developers do not see anything wrong 
with the contemporary rasterization approach 
to graphics. Neither do the GPU vendors of 
today. The current ecosystem has embraced 
raster graphics and has evolved to accommo-
date its idiosyncrasies. The ray-trace only path 
proposed by Intel has few backers outside of 
the company. 

Cevat Yerli the CEO of Crytek (FarCry and 
Crysis), doesn’t think that there is a “compelling 
example for using pure classical ray tracing”. 
He opines that “…there are a variety of graph-
ics problems which would suit a hybrid solution 
of rasterization and raytracing, and [that] most 
likely is the way to go.” His view is reflected by 
Intel itself—the initial builds of Larrabee will be 
derived from Intel’s G45 integrated graphics. 
This indicates that the early Larrabee variants 
will not be for high-end graphics processing, but 
will be more of an integrated graphics replace-
ment—perhaps a notebook part. 

The next step would then be a slight raytrac-
ing nudge to produce eye-candy either not pos-
sible or prohibitively costly, using traditional 
rasterization methods: effects such as detailed 
reflections, refractions, and shadows, perhaps. 
Intel’s goal could then be to slowly wean the 
industry on its diet of raytracing extensions, to 
eventually replace raster hardware accelerators 
by its own breed of processors. 

John Carmack of id Software echoes this 
sentiment—“No matter who does what, the next 
generation is going to be really good at raster-
ization—that is a foregone conclusion. Intel is 
spending lots of effort to make sure Larrabee is 
a competitive rasterizer.” 

Carmack also brings up an interesting point 
of ‘show, not tell’, when he says that “while 
everybody thinks [raytracing] is going to be 
great, I have to reiterate that nobody has actu-
ally shown exactly how it’s going to be great. 
The best way to evangelize your technology is 
to show somebody something… to kind of eat 
your own dog food, in terms of working with 
everything.” Intel recently made two impor-
tant purchases—the Havok physics engine, 
and Project Offset game engine. Perhaps these 
purchases are meant to do exactly what John 
Carmack proposes—to show the development 
community exactly why raytracing is the  
way ahead.

Meanwhile, Intel faces off against an entire 
industry. Who will do the actual ass-whooping; 
remains to be seen n 
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Integra DTR 5.8
No, the Integra DTR 5.8 isn’t a launch control panel for
sending manned crafts into space. People with a
thing for home theatre systems, recognise this is an
A/V receiver. The Integra DTR 5.8 delivers 7.1 sound at
around 100 W per channel. It can drive frequencies
from as low as 5 Hz to as high as 100 kHz! The key
words here are High Definition—it supports HD 1080p
streams and a whole variety of standards like DTS-
HD, TrueHD and Dolby. There are connectors of all
shapes and sizes—from HDMIs to optical, to even
proprietary satellite radio connections.

Klipsch Palladium
P-39F
The all new Klipsch Palladium P-39F floorstanders are
made by DesignworksUSA—a studio that has worked
alongside BMW and Rolls Royce. For $15,000 (Rs 6 lakh),
you get a pair of speakers that have been made using
everything they could lay their hands on. There’s the usual
aluminium and then the not-so-usual kevlar and gold. For
those who are wondering if all these exotic metals mean
anything and whether it all translates to what matters the
most—it’s the bass! There’s loads of it from the three 9-inch
woofers in each speaker. They weigh 74.9 kg and they stand
close to a metre and a half in height and the power output
is 400 W with a peak rating of 1000 W.
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Fat-Man iTube 452
Fat Man’s iTube is an audio amplifier meant for iPods. As the name suggests,
the iTube uses vacuum tubes. It utilises valves that drive out 40 W of power
per channel. The ValveDock allows you to have rich quality audio from your
favourite media player—the iPod. The amplifier looks absolutely astonishing
with its large vacuum tubes. Come to think of it, the iTube 452 could sell itself
by looks alone. As a dock for your iPod, you would assume it’s a
featherweight, but at 23 Kg it’s anything but light.

Nokia N810 WiMax
It’s time to wish WiFi goodbye—that’s the
point Nokia is trying to prove and they do
that by releasing an Internet tablet that
earlier supported WiFi, but will soon
support WiMax as well. It’s called the N810
and is not your regular mobile phone with
MP3 playback and a multi-MP camera! The
device has a 4.1-inch screen with a
resolution of 800x480 and doubles as a
touch screen. There’s an inbuilt keyboard as
well, and the whole thing weighs around
226 gms. It has a 640x480 VGA camera, so
you can post images on your blog! Internet
connectivity through Wimax can be yours
for close to $500 (Rs 20,000)—just be
prepared to receive a slightly bulkier
device, courtesy WiMax hardware.
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Pioneer AVC-F500BT
The Pioneer AVC-F500BT’s 5.8-inch screen is one
of the largest you can come across on a device in

its class. It’s much more useful than a GPS device.
For example, you can put up a camera on your car

and use it to help you park in tight situations.
Also there’re features for Bluetooth hands-free
calling as well as controlling your iPod. You can

expand its memory by adding SD cards. There is
no clear indication of price yet, but similar

competitive devices are priced at over $1,000 (Rs
40,000). For that kind of money, if only it could

park your car for you! 
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From the geek’s wildest dream to reality—our fantasy gadgets are almost here!
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Ahmed Shaikh

They say the truth is stranger than fiction. If
that were so, we would already have our
flying cars and servile fembots (without

the machine-gun implants, please). But there are
a few things that have stumbled from the world
of make-believe and into our mundane lives. In
the following pages we explore research work
and prototype devices that have taken the first
small step to bringing science fiction to fact.

Invisibility
The human dream to turn invisible is timeless.
There hasn’t been a medium untouched that
hasn’t explored this fantasy to the fascination
of humans everywhere. TV shows, movies,
books, videogames, radio shows, comic books—
the wish to turn invisible resonates deep within
each of us—be it for mischief, or otherwise.

There are several paths to invisibility—some
more practical than others. In 2006, physicists
in the United Kingdom suggested a mathemati-
cal model of turning object invisible. The
theory was based on the principle of resonance,
more specifically, resonance of light frequen-
cies. The mathematical model suggested a
cloaking material. When this material is placed
next to a speck of dust that reflects light, it
would resonate at the same light frequency and
would in effect cancel out the ray emanating
from the dust speck. This cancellation would
cause the material itself to become invisible.

But light not reflecting off of an object is only
half-way to true invisibility—not only should
the object itself not reflect light but everything
surrounding the invisible object, especially its
background should be visible.

Based on that paper, Purdue researchers
created a prototype device. The device consisted
of an array of needles that radiated outwards
from a central spoke. Based on the mathemati-
cal model of the UK researchers, this spoke
would then bend light around the object that
was to be cloaked. Background objects would be
visible but not the object surrounded by the
cylindrical array of nano-needles.

The design’s limitation is that it can only
cancel out a single light frequency, as it stands
today. The entire gamut of visible light frequen-
cies would need to be cancelled if this method
is to be a true invisibility potion. Of course, to
truly be invisible, it would also need to be not
visible in the ultraviolet and the infrared
frequencies… But we can all agree that even a
partially invisible object is a solid step forward
to fulfilling this age-old dream.

Cloaking Shield
A more mechanical form of invisibility is cloak-
ing technology: A staple diet of aliens every-
where. In 2007, the UK army claimed to have
cloaked a tank using cameras and projectors to
beam images of surrounding countryside on to
the surface of the tank. One can imagine this
method gain traction as nanotechnology shrinks
mirrors and cameras to microscopic dimensions.
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powerful enough to equal the damage inflicted
by a Tomahawk cruise missile, and a range
between 200 and 250 nautical-miles. The US Navy
plans to deploy a 64-megajoule version by 2020.

Body Armour
From the comic book’s Iron Man to the protago-
nist of the video-game Crysis—wearing space-age
armour that looks cool, deflects bullets, and
augments strength and speed has been a staple of
science fiction diet. Today, research into nanome-
ter manufacturing and fabrication has made
some progress to turning that fiction into fact.
Today, materials made up of carbon nanotubes
are considerably stronger than steel, while yet
good conductors of electricity. Such materials,
while in the research stage now, could eventually
lead to lighter bulletproof clothing and personal
armour. In May of 2007, a start-up called
Nanocomp, based in New Hampshire, US,  devel-
oped nanotubes of length greater than usual.
Such longer “fibers” allow the carbon tubes to
bind together more effectively resulting in a form
of unwoven matting. This matting is then treated
chemically to cause the tubes to align, imparting
the material with further strength in the direc-
tion of alignment. The tubes are made through
chemical vapour deposition which involves
condensing carbon out of a gas and into the
matting. Sheets roughly one metre by three were
created using this method. The resulting textile is
claimed to be seven times stronger than steel of
the same weight.

While armour is used for defense what about
a body suit to augment strength? The HAL-5
Exoskeleton (HAL for hybrid assistive limb) is
being developed by Professor Yoshiyuki Sankai at
Tsukuba University and will likely go into
commercial production in this year itself! The
suit is essentially a motor-driven metal exoskele-
ton that you strap onto your body to assist and
augment the wearer’s motions. So, what’s so
great about the HAL-5 suit? It augments the
wearer’s strength, allowing the user to double his
lifting abilities. The HAL-5 operates by sensing
weak electrical impulses from the user’s muscles
via electrodes on operator’s skin. These impulses
are then routed to an onboard computer which
analyses the signals for muscle of origin and acti-
vates corresponding servos in the HAL-5 suit. It
thus mimics and magnifies the wearer’s motions.

Wireless Electricity
Researches at Massachusetts Institute of
Technology recently demonstrated a technology
that can wirelessly transfer electricity across a
room. The team at MIT showcased the technol-
ogy which they call WiTricity to power a 60
Watt light bulb from a power source two meters
away. The science behind the magic is based on
the fact that two objects at the same resonant
frequency can effectively exchange energy. The
WiTricicy setup consisted of two copper coils,
oscillating at the same frequency and trading
energy across the two meter divide via their
electromagnetic field. While one of the coils
was attached to a power supply, acting as the
transmitter, the other one was connected to the
bulb and acted as the receiver. The range for the

WiTricity, however, would probably not extend
much beyond a room, a claim we hope the
researchers are mistaken in making. 

Immortality
The ultimate human dream—to live forever.
Immortality could, in theory, be achieved if the
cells that comprise our body do not age or destroy
themselves. One possible step to this brave new
world would be to create a nano-machine which
would constantly monitor and regulate cellular
behaviour—a guard-dog for each of our cells.

Researchers at Harvard and Princeton
University took the first small step towards this
goal. They have created implantable devices that
can monitor the activities and characteristics of
human cells. These machines are constructed of
the same material our cells are made up of:
DNA, RNA, and proteins. The machines could
eventually revolutionise our way of living by
directly treating only diseased cells or tissues.

The coolest aspect of this technology is that
our body itself can be the producer of these
guardians. Harvard’s Yaakov Benenson, a Bauer
Fellow in the Faculty of Arts and Sciences’
Center for Systems Biology says of the research
that, “[all that needs to be] provided is a genetic
blueprint of the machine and our own biology
will do the rest. Your cells will literally build
these biocomputers for you.”

These nanocomputers will use programmed
logarithms to detect anything from the presence
of a mutated gene to the activity of genes within
the cell. Such machines could, in time, allow
doctors to target only cancerous cells, leaving
healthy cells completely unaffected.

The Orgasmatron
In Philip K. Dick’s highly-influential Do Androids
Dream of Electric Sheep—the author introduces a
device that allows people to literally “dial-in” a
mood to change the way they feel. While such a
switch would be an extremely welcome addition
next to the ceiling fan’s knob—the best we have
come to achieve is an accident that mimics the
Orgasmatron from Woody Allen’s movie Sleeper.

When anesthesiologist Dr. Stuart Meloy was
working on a device for treating chronic pain, he
discovered a technique that successfully
produced orgasms in women instead. The acci-
dental discovery was made as the doctor powered
up an electrode that had been placed into the
spine of a woman with chronic back pain. 

Based on this discovery, Dr. Meloy hopes to
create a device which would allow women to
dial-an-orgasm at the touch of a button. The
device will have to be surgically implanted at
the base of the spine, however.
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Beam Weapons
While the tractor beam is generally associated
with Star Trek, beam weapons are a common
feature of almost all sci-fi movies and shows.
From hand-held phaser weapons to giant planet
destroying death stars, a beam weapon has
boldly ventured into everyone’s imagination. In

1890, Nikola Tesla showcased a machine that
was pretty much a man-made lightning creator;
transmitting energy without wires, as a high-
voltage discharge. This kind of a discharge is
chaotic though, since it can travel to pretty
much any surface that has a lower voltage
charge. In 2007 though, a US company called
Ionatron announced that it had won an almost
$10 million contract from the United States
Army to create a modern version of that Tesla
concept. According to Ionatron, its machine is a
far more effective weapon that can disable both
people and vehicles—available in both lethal
and non-lethal versions, much like setting a
phaser to stun or kill. Ionatron’s improvement
on the Tesla concept was centered on the addi-
tion of a special laser. This laser acts as a guide
to the electrical discharge—serving to both
speed up the discharge and to precisely control
where the man-made lighting goes.

In some ways, the design echoes a similar
creation by the US Air Force. The Air Force gun
however, uses a laser to temporarily blind the
enemy. The gun, developed by the force’s
Research Laboratory’s Directed Energy
Directorate and about the size and weight of an
M60 machine gun, is called the Personnel
Halting and Stimulation Response, (PHaSR). The
PHaSR shoots a low-power beam of laser light to
temporarily blind an individual.

Tractor Beam
Made famous by Star Trek—tractor beams are
electromagnetic rays that hold an object in space
and can also be used to pull objects towards the
source of the beam. Such technology is already
in use but at a microscopic scale. In 2007, MIT
researchers demonstrated such a beam to
pickup, hold, and move around individual cells
and objects on the surface of a microchip. The
beam itself consisted was a laser ray which could
be used to push and pull, in a manner similar to
how one might use a pair of tweezers.

Tricorder
Here’s a common childhood indulgence, influ-
enced by the seminal Star Trek. While we spent
afternoons communicating with our ‘away
team’ firing make-believe lasers, another

device, perhaps a little less popular than the
communicator or the phaser gun, was the
tricorder. Dr. McCoy or science office Spock
would frequently use this strange black box to
perform tasks ranging from health diagnosis to
analysis of alien soil and air. 

While the tricorder as it was presented in
Star Trek is still largely fiction, research towards
that has already produced a device that looks
like an early prototype to the tricorder.
Researchers of Purdue University have created
a portable system that can be used to analyze
chemical components. Called the Mini 10, this
prototype is essentially a portable mass spec-
trometer, roughly the size of a shoebox; weigh-
ing in at 10 kilograms. Running on battery
power, the unit weighs 30 times less than a
conventional mass spectrometer has applica-
tions in everything from airport security to
medical diagnostics. 

The instrument was developed by a team of
researchers led by R. Graham Cooks, the
Professor of Analytical Chemistry in Purdue’s
College of Science. The Mini 10 sniffs for
compounds that serve as signatures to the pres-
ence of substances such as explosives or cocaine.
If these residue indicators are found, the Mini 10
performs a more in-depth analysis to verify the
presence of the substance being scanned for. 

Another construct from the medical labs of
sci-fi shows is the wand that seals wounds and
heals without touching the surface of the body.
Something similar is tested by the engineers at
the University of Washington, employing ultra-
sound. This technique uses several lenses to
focus ultrasound rays to a particular spot—simi-
lar to focusing sun rays using a magnifying
glass. Such a focused beam of sound can create
an extremely hot surface area which would
heat up the cells forming the surface of a
wound, causing them to seal and cauterise.

Railgun
Made famous by the id Software classic Quake,
the US Navy has revealed that it’s working on a
similar device. An 8-megajoule railgun was both
created and fired by the Navy in 2007. The gun
was also showcased at the Naval Surface Warfare
Center, Virginia. The 8-megajoule, electricity
guzzling monster-gun can propel non-explosive
projectiles at incredible speeds. The weapon is
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Day 2:
I can’t get over how thin and light the Air is—in myhand, it feels as thick as one of our anniversary issues,and just a tad heavier. I can carry it around with mefor hours and not feel the weight! The brushedaluminium is beautiful, the glossy screen is beautiful,the touchpad is the size of a football field and theMacBook-like keyboard is a dream to type on. I’m justgushing all over.

Day 7:
I’ve spent all this time playing with the multi-touchtrackpad, which, incidentally, is the largest I’ve seen onany laptop. Ever. With older MacBooks and MacBookPros, using two fingers to scroll was a dream—on theAir, I can now use two fingers to zoom and rotate aswell! Swiping the touchpad with three fingers lets mego to the next or previous item—be it a photo ordocument. This isn’t, however, as snappy as the iPhoneor the iPod touch.

The mono speaker under the keyboard is tinny, soft,and, well, mono—but at least it’s clear.

Day 14:
After playing with OS X Leopard for so long, I’ve finallystarted to get some bits of work done. The 1.8-inch 80GB, 4200 rpm PATA hard disk that our model camewith is plain awful. You can actually tell the differencebetween it and other laptop drives even for the smallestamount of data. I wanted to hook up my external harddisk to it, but that meant I had to disconnect my USBmouse—the single USB port begets multiple profanities.My normal-sized headphone jack fits into the recessedconnector rather uncomfortably too.

Day 20:
The model I’m holding has clearly been used before—therewas a host of software installed when we got it, and I’veinstalled more—I suspect that this is contributing to itsrecent unnatural slowness. Perhaps if I were to formatthe disk and re-install the OS... Cue in the painfulrealisation that this blasted device has no DVD drive.So I install the DVD drive sharing software (no, justsharing the drive using Windows doesn’t work) fromApple’s installation disks on to my Windows PC, turn onDHCP on my wireless router (I hate doing that) and startthe over-the-air installation procedure. Not much clickingrequired, but this I didn’t take too kindly to—“Estimatedtime: about 4 hours”. Good heavens.Thankfully, after an hour, the estimated time falls toan hour and a half. Or so I thought. The installationfreezes midway, and I have to start it all over again!Finally, it’s 3 a.m., and I’m working on a clean install ofLeopard—definitely more responsive than before, butthere’s really no escaping that slow hard disk.

Day 30:
It all boils down to one question—if I had the money,would I spend it on the Air? Of course not. It’swonderfully slim and light, but that’s only because it’swonderfully empty—no wired Ethernet, only one USBport, that pathetic hard drive—where do I begin? Even if Ihad a lakh to throw away, I’d probably throw it at theMacBook (and have some left over, too)—it’ll give me allthe OS X goodness I desire, and qualifies as a realcomputer as well.

nimish.chandiramani@thinkdigit.com

Nimish Chandiramani
“Yes, it’s a MacBook Air,” I explain to people who’ve heard of it, and “No, it’s a notebook computer, not a paper notebook,” I am

forced to tell the Ageing Parent. I could sit and stare at this thing for hours, so I don’t have any objections to spending the month

with it...

The MacBook Air
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Digital Passion l Open Source Matters

Aasis Vinayak

F
or us hackers, there is only one word
that we mention in every alternate
sentence—Freedom. Our Linux distro
preferences may speak volumes about
our inner selves—some may go all the

way with Gnewsense, Ututo or Blag, and some
others like me may go for popular distros like
Debian with vrms (virtual rms) installed. But the
bottom line is the same—we stand for freedom!

For this reason, many of my friends were
unhappy at not being able to play their
favourite videos on YouTube. Our ideology
never allowed us to play files using proprietary
software (of course there were free Flash play-
ers, but none support anything beyond SWF
v4). We had similar problems while accessing
the video content of other sites like Google
Video, Lulu.tv, AOL video and CNN video. Thus,
a large segment of information remained inac-
cessible. But today, we don’t face such prob-
lems. Swfdec (compatible with Linux and
FreeBSD and chosen as the Flash player for
Fedora and been ported to DirectFB for embed-
ded applications alongside its X11 and GTK+
bindings) and GameSWF have helped us solve
the issues to a considerable extent. However,
Swfdec did not have ActionScript support. Now
we have Gnash more or less in our hands. Yes,
Gnash is our own GNU Flash movie player.
Moreover, we have swfmill, a free software
command line tool, to generate SWF files. 

But one may ask, when Flash is available at
no cost through a Software Development Kit
(SDK) why should we need to go for a change? It
is incorrect to describe Flash as “open” or
“free”, as the SDK is made available under a
license that unambiguously prohibits the
development of an alternative Flash player.
This curbs Freedom! 

Gnash (along with free BIOS, drivers for ATI
video cards, and the GCJ Java compiler) is one
of the FSF’s high-priority projects. Gnash has
many unique features. It can run standalone,
has browser plugin, is SWF v7+ compliant,
supports streaming video content and XML
Message server, gives high quality output,
offers better security, is extensible (you can
extend ActionScript by creating your own) and
most importantly, it’s free! It is based on
GameSWF, and as mentioned above, it supports
many SWF v7 features.

If you are a novice in programming, here is
a tool for you—http://getgnash.org, offers packages
that will allow people to try out Gnash without
the need to compile the source code. Currently
they support Fedora, Red Hat Enterprise Linux,
and Ubuntu 7. You can get more information
from the official group http://savannah.gnu.org/
cvs/?group=gnash and keep yourself updated by
subscribing to their mailing list at http://lists.
gnu.org/archive/html/gnash/.

We faced similar problems while building
alternatives for programs that run on the .NET
platform. Then we launched DotGNU. Free
Software Foundation makes it clear that “the
DotGNU project was started in reaction to
Microsoft’s .NET strategy”. 

DotGNU will be a total replacement for .NET
(and not just a Free Software implementation).
The Portable .NET class library is set to endow
with facilities for application development.
These are primarily written in C#. But because
of the Common Language Specification (CLS)
they can be used by any .NET language. And
similar to .NET, the class library is structured
into Namespaces and Assemblies. 

The three main development projects under
DotGNU are—DotGNU Portable.NET (an imple-
mentation of the Common Language
Infrastructure to run C# and C applications),
phpGroupWare (a multi-user Web-based
GroupWare suite intending to provide an excel-
lent collection of Web service components that
can be accessed through XML-RPC) and DotGNU
Execution Environment (Web service server).
You can give it a try too! Just point your browser
to http://download.savannah.gnu.org/releases/dotgnu-
pnet/ and get the source tarballs (Portable
.NET x86 JIT).

It’s not just the programming world that
GNU is helping—it’s universal. One of our
latest projects—FreeLectureNotes.org—falls
under this regime. Being the founder and
maintainer of this project, it’s my pleasure to
introduce this project in this space. “Creating
the beginning of a world of free educational
materials” is what Prof. Richard Stallman,
Founder GNU / LINUX, commented about the
venture. You may read more about the venture
from the welcome note by Prof. Stallman at
http://freelecturenotes.org/welcome.htm. Further,
you may find one thing in common—even in
this. All the ventures are guided by the same
spirit—The spirit of Freedom! 

readersletters@thinkdigit.com
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Bhaskar Sarma

“One can do anything, anything at all…if provided with
a passionate and gifted teacher”—Pat Conroy

The Internet is chock-full of learning
resources, but all of it is disorganised, and
not something you will find easily—yes,

even with the power of Google at your fingertips.
The problem is that there are thousands of
guides, tutorials, wikis and blogs online, but can
you really tell casual information or personal
thoughts from educational information? If you
want to learn something more formally, with
paced lessons and grades, you could sign up for
an online course offered by various universities.

These online courses, which have seen a big
boom in recent years, are taught by professors
who are often legendary in their respective fields,
and you get access to lectures that are usually
delivered to packed auditoriums. Anything from
Engineering, Liberal Arts, Science, Management

and Health is available, and at various levels—
from a certificate grade to Masters. Obviously,
these are paid services.

However, recently we’ve seen big names in
education offering their course material for
free online. This means that anyone—students,
educators, housewives or grandfathers—can
sign-up for them. There is no educational
requirement and no schedule—you can learn at
your own pace and at your convenience. The
only pre-requisites are the willingness to learn
and access to the Internet. In this article, we
will look at a few top-notch universities and
institutions that are offering such courses. 

MIT OpenCourseWare
(http://ocw.mit.edu)
Do we really need to introduce Massachusetts
Institute of Technology? For quite a while now,
MIT has put up select courses online. All of them
are actual courses that were taught in classrooms
in MIT, and you can effectively get the same high
quality education that students pay premium for. 
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that range from archaeology to the Internet. It
also features news about conferences and
workshops on different facets of education
and technology.

iTunesU
(http://www.apple.com/education/itunesu_mobile-
learning/itunesu.html)
All you iPod owners out there who happen to
be college students, there is something good
coming up. In fact, anyone with an Apple
product and with a love for learning would
find Apple’s iTunesU initiative combining the
best of both worlds—personal technology
with education.

iTunesU uses Apple’s iTunes music store to
distribute free content any time of the day, any
time of the year. This service is used by hundreds
of universities and schools in North America to
distribute their educational content which can
be then viewed over iPods, iPhones, iPod Touches
and computers. In total, there are more than
30,000 audio and video files from different topics
to choose from. You can even burn optical media
and listen to it later at your convenience.
However, you need the freely downloadable
iTunes to access media from iTunesU.

The educational institutions that are
featured on the iTunesU include Stanford, MIT,
Duke, Carnegie Mellon, Lehigh, UC Berkeley and
Yale, among others. It also has educational
contents from other non-educational institu-
tions like the Smithsonian Institute, The
Museum of Modern Art and The New York Public
Library. The content offered by these institutions
vary widely in scope and depth: from a UC
Berkeley philosophy course “Existentialism in
Literature and Film” to “Electricity and
Magnetism” by rock star Professor Walter Lewin
from MIT, iTunesU has them all. They even have
a series of videos on dental anatomy from
University of Michigan which were recorded
back in the 70s and 80s. 

The USP of iTunesU is undoubtedly the
ease of delivery. You can download the desired
audio or video on your iPod, and listen to it
whenever you want to, thus getting educated
the cool way. Besides, there are no cost restric-
tions and you can play the media on multiple
devices. In case you don’t want to keep look-
ing at iTunes every time you look for a good
pod cast, you can always go to sites like
Openculture (www.oculture.com/2007/07/freeon-

linecourses.html), where a list of such resources
are regularly maintained.

NPTEL
(http://www.nptel.iitm.ac.in/)
National Programme on Technology Enhanced
Learning (NPTEL) is a Government of India
funded programme aimed at improving the
quality of engineering college education in
India. Six IITs and IISc have contributed the
core material for these courses, which
currently cover Civil, Computer, Electrical,
Electronics and Communication and
Mechanical Engineering disciplines.
Information Technology and Computer
Applications students and teachers would also
find useful material in these video lectures.
This is only the first phase of the project, with
later phases aiming at including more insti-
tutes in content creation. There is content
common to engineering courses like physics,
chemistry, maths, management and languages.

The value of such courses is immediately
apparent, when we consider the thousands of
private engineering colleges that dot the length
and breadth of India. Quality curriculum
content development does not proceed on shoe-
string budgets and needs qualified personnel,
time and money. Most of these colleges can’t
afford these luxuries, and hence end up with
prescribing books that are suggested as part of
the course by the AICTE. Students mug stuff up,
pass out of the college and join the army of
unemployable engineers. However, using these
courses the teaching experience at IITs can be
replicated to a large extent. Since these are all
video courses, both students and professors can
benefit from them. And they are freely avail-
able, which means no funds outlay for getting
such high quality content.

Currently, the content is available in video
form, with each course divided into 40 video
lectures of one-hour duration each. There are a
total of 129 courses with more courses being
added regularly. While the inspiration behind
these series of lectures is MIT’s OCW, the goals of
this programme is curriculum development
with focus on specific courses, unlike MIT’s
primary goal of sharing content. All the lectures
are put up on YouTube from where they can be
downloaded and viewed later offline.    

Summing Up
These are only a few of the many similar
resources available on the World Wide Web. For
instance, other universities have their own
OCW sites which are similar to the MIT’s site
mentioned here. Then again, critics point out
that most of these courses are not credit earn-
ing, as you can’t get a degree after passing the
tests after each course. So theoretically, you
could be wasting money on Internet bills and
plenty of time if you studied these courses
instead of mugging up for your semester exams.
On the other hand, you will probably do worse
if you were to spend that time and money hang-
ing in game parlours or restaurants, so why not
give these sites a shot? You can learn plenty.

bhaskar.sarma@thinkdigit.com
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This site has a total of 1,800 courses on offer
from a diverse range of disciplines. Are you a
student of Aeronautical Engineering who
missed the lecture on Gusts and Winds? Were
you too bored to attend that talk on Modal
Metaphysics but need an idea of what on earth
that meant? Just head over to the MIT Web site
and do a search on the topic. All the courses are
categorised into several broad areas like
science, engineering, management. 

Once you have got the course you were look-
ing for, you can download the course materials
as a zipped file. In most cases, the downloadable
package will consist of text files. There are
lecture notes, assignments, quizzes (along with
answers), tutorials and details about reference
books. The material is arranged in the form of a
calendar, which gives you an idea of how the
topics are arranged. Some modules also offer
video or audio lectures to supplement the text.
In fact, there are complete courses delivered in
audio or video format. Such courses need soft-
ware like QuickTime player for streaming video
or Real Player for the downloadable files.   

Apart from the classroom courses, the OCW
Web site has other resources for maximising the
impact of the material. These include training
videos, instructors’ manuals, textbooks and
online publications. For administrators and
syllabus drafters, the MIT Curriculum Guide
provides a glimpse of how MIT structures its
courses, what are its requirements and what
reference books are usually prescribed. 

To ensure that the supply of quality students
do not dry up, MIT has a section called
“Highlights for High School” where students and
teachers from the school level can find study
material suitable for their level. There are videos
of lab experiments, science projects, demonstra-
tions and even courses on how to write better.
The material is taken from MIT’s introductory
courses and feature 11 subjects—from Computers
and Electronics to Physical Education. High
school courses developed by Educational Studies
Program, a MIT student group established 50
years ago, are also listed on the site.

OCW has a forum as well, where users gather
to discuss course materials. Since the Web site is
updated regularly, users can subscribe to the
sectional RSS feeds and also join the mailing list
for accessing a regular newsletter. Links to
archived courses, no longer available on the
OCW site are also provided. All these courses are
covered under a Creative Commons license, and
hence can be used for free. 

CMU’s Open Learning Initiative
(http://www.cmu.edu/oli/)
Carnegie Mellon University is another heavy-
weight, which has an extensive and free e-learn-
ing program. You don’t even have to register to
access the courses. However, these courses are
used by some institutes to award credits and
grades to their institutes. This means that the
student will have to register for that particular
course, and their performance statistics will be
logged for supervision and oversight by their
instructors. OLI courses are also used by
students of CMU as part of their coursework.

Similar to OCW, the courses as part of OLI
also cover a wide range of subjects, though the
selection is not as comprehensive. Currently, the
site has courses in subjects like Engineering,
Statistics, Chemistry, Logic and Proofs and
Physics. Each course is divided into different
modules, which usually comprise detailed
lessons and courseware arranged topic-wise. 

While a student can take courses without
registration, he or she, can create a tracker,
which will keep track of the course progress.
Instructors who want to teach the OLI course
have to register for an instructor account. After
CMU completes a verification process, the
instructor will receive additional privileges like
access to student performance monitoring tools,
expository text, case studies, simulations and
other instructor support material. 

CMU also conducts periodic evaluation stud-
ies to gauge the effectiveness of courses and
keeps tweaking them. At the time of writing, the
Web site was undergoing a major redesign after
which the number of courses offered would
increase and also become more extensive. It also
conducts regular workshops and conferences for
course development and evaluation in the
university premises, which are open to all and
can be joined for free. You would have to,
however, pay for your own travel and stay. 

OER Commons
(http://www.oercommons.org/)
This site is not affiliated to any university like the
two above, but it features courses from various
universities, colleges and training institutes.
These courses are in different subjects and are
available in different levels, from primary to post
secondary. The broad areas covered are arts,
humanities, business, mathematics and statis-
tics, science and technology and social sciences.
By its sheer volume, this Web site may be one of
the largest of its kind on the Internet. 

OER is different from the other e-learning
resources in that users can share their own
courses on the network, and also access courses
that are already present. Submitted material
has to go through a complex process of vetting
and review before they are featured. So you
could, in theory, find the physics lessons of
your grade ten teacher who taught you that
science was much more than mugging up
formulae and boring facts. The resources on
this site include lectures, demonstrations, full
courses, modules, case studies, simulations,
etc., in different media like video, podcasts,
Flash movies and plain text files. 

Despite the varied sources and diverse types
of media on this site there is one commonality—
everything is free and licensed under Creative
Commons. That means users can download, use
and modify any of these resources without the
fear of getting sued for copyright infringement.   

Users who want to contribute content to
the community can create an account and log
in to their portfolio. The community consists
of a forum, blogs and wikis where people from
different professions and different places
write, discuss and contribute to eclectic topics

An example of how MIT
OpenCourseWare
organises its courses

One of the many courses available on iTunesU
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XFX GeForce 8600GT 
250 GB Western Digital hard drive
Windows XP SP2

I believe almost all the components are over-
clockable. However, I am a complete newbie to
overclocking, and have heard that improper over-
clocking can damage one’s system. I would like to
overclock my CPU, Graphics Card, RAM as well as
the motherboard to the highest safe values. How do
I go about it? I would greatly appreciate it if u could
guide me towards any information regarding this. 

I am a regular reader of your magazine and I
owe it to you guys at Digit for helping me get to
know my computer better. Congratulations on a job
well done! Hoping to get a reply from you.

Shiraz Hansen
You are right, pretty much every compo-
nent can be overclocked and you are also

right about components getting damaged.
Some components are relatively easier to over-

clock than the others. Overclocking requires
patience and care or you can seriously damage
some of the components. Do it at your own
risk! Adding tiny increments to your FSB from
the BIOS is the simplest way to overclock the
processor. The processor’s multiplier can also
be increased from there. Constant reboots are
required to check for stability. Keep a close
watch on the temperatures as well. The proces-
sor you are using—the Intel Core 2 Quad Q6600
is known to touch 3 GHz. If you are using value
RAM, then that could hamper your progress as
well. Your thread on the Think Digit forums
(http://www.thinkdigit.com/forum/showthread.php?p=
807118) should get you help from fellow over-
clockers there.

Graphic Card Overheating Issues
I recently bought an AGP GeForce 6200 card
and a 450 W PSU. Since then, my PC has

started overheating. My processor temperature is
60 degrees, motherboard 57 degrees and the
graphics card well over 75 degrees. These are the
temperatures while the PC is idle and running stan-
dard desktop applications. Things get even worse
when I start playing games.

Is there any problem with my power supply and
should I change it? My PC was running well on my
old Intex 300 W PSU and it wasn’t overheating at
all. Should I use that power supply with my graph-
ics card? Will there be any problem with the GPU if
I use a lower rated power supply? Please help!
My system configuration is
AMD Athlon 64 3000+
MSI K8M800 (VIA chipset)
768 MB RAM
DVD-Writer
256 MB nVidia GeForce 6200 AGP card
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What Is A 1394 Adapter?
I have been using a Compaq Presario V6211 AU
laptop for almost a year, and I had no problems

with Vista running on it except it was painfully slow.
The machine is running on a 1.6-GHz AMD Turion 64
x 2 processor with 1.5 GB of RAM. Recently, I decided
to downgrade it to Windows XP SP2. Everything runs
fine now but there is a problem that still persists.
There is no driver for the network adapter (1394 Net
Adapter) which doesn’t allow me to connect to my
broadband connection. I tried looking online but I
could find nothing. I have attached a screenshot as
well. Can u help me please?

Uzair

Uzair, the 1394 adaptor is in fact Firewire,
which is used to connect devices like handy-

cams and mass storage devices like hard drives.
It can also be used to connect another machine
using Firewire, but that seems highly unlikely
in your case. Disable the 1394 network adapter
by right clicking on it in the Device Manager
Window and clicking Disable. If at all you want
the adapter to work, you can try uninstalling by
right clicking on it and clicking Uninstall.
Reboot and Windows XP should try and redetect
the device and hopefully find the driver for it. 

If it doesn’t, look for the driver on Compaq’s
site or the disc provided with the laptop. Right
click on the device, click Update Driver. Choose to
install from a specific location, and point out to
the folder or file where the drivers exist. Looking
at the screen you’ve sent, your primary network
adapter is the nForce onboard network adapter
and that seems to be installed perfectly fine.
Check the network settings for it. This could be
the reason your connection isn’t working.

Multiple Scanning Error Message
My name is Sreeraj and I use an HP Scanjet
2400 scanner. When I press scanning button,

an error message is shown – “The application is

currently in use or
unavailable. Close
any open programs
and try again”, even
though the scanning
done properly. What
does this error mean?
Sometimes, this error
appears once and ten
times at some other
times.

KK Sreeraj

The error
should occur

only in case you give
multiple scan
orders when one is
currently running.
If you are using the
scan button on the printer to scan, then you
should try using the software interface. If that
still doesn’t work, try installing a third-party
application such as IrfanView and try import-
ing images from there. Also, make sure there
are no other applications that maybe accessing
the scanner at the same time. If there are, turn
them off or stop them from running by remov-
ing them from msconfig. Click on Start > Run
and type “msconfig”. Click on Startup and
uncheck the programs there.

How Do I Add More Memory To My
Onboard Graphics Solution?

My computer has an Intel Celeron processor,
256 MB of RAM, a 40 GB HDD. How can I

increase my video graphics memory for my
onboard graphics memory? It is currently set to 64
MB. Is there any software to do this? 

Abilash Rajendran

You won’t experience real performance
advantage by simply increasing the

memory. 64 MB is still a lot for your system
configuration. If you want to increase it
anyway, enter your BIOS by pressing the [Delete]
key when the computer boots. Try entering
Advanced Chipset settings and look for an entry
for the onboard graphics frame buffer size.
Increase the amount of memory, save the
settings and reboot.

How Do I Overclock?
My desktop configuration is given below
Intel Core 2 Quad Q6600 2.4 GHz

ASUS P5N-E SLi
2 x 2 GB Zion RAM 

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@tthhiinnkkddiiggiitt..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Stability While Gaming And
Free Disk Space Issues

I have a Dell Inspiron 1520 laptop
with a Core 2 Duo 1.66 GHz, 2 GB of

RAM, and Windows
Vista running on it. My problem is

that even after installing NVIDIA 8600M
GT, Need For Speed: Most Wanted and
Counter-Strike:Condition Zero  crash
after some time (any time) when I run it
on full details saying that a specific
driver file has stopped working.

Another problem I’ve been facing is
that my C drive has about 10 GB free.
Ever since I cancelled the installation of
Visual express after installing .Net
framework, the drive shows fluctuating
free space indications ranging from 8 GB
to 13 GB. Help me!

Udit Roy

The crashes are to do with NVIDIA
drivers for Vista. For the instability issue, try unin-

stalling and updating to the latest drivers for your graph-
ics card from NVIDIA’s site. If you have an installation of
XP running side by side, you might want to try installing
NFS and Condition Zero there to look for the same errors.

For the problem with the free
disk space indication, you could
try clearing out your Windows
Temp folder. Click on Start and
enter “%TEMP%” in the run text
bar. Press [Enter]. Make sure you

have all the programs shut. Delete all
the files in this folder. If that still does-
n’t fix the free space problem, you
might want to try installing the Visual
Express application and uninstalling
it. It could also be to do with the
Windows Page file. Open the
Advanced System Properties by press-
ing [Windows] + [Pause/Break] and
then clicking on the Advanced tab.
Click on Settings for Performance and
then on the Advanced tab. Here you
can try and set the page file to 0,

reboot and then set it back to the initial
value. That way the pagefile should be
emptied or deleted and recreated. You

might want to see if the space problem can be fixed by
turning off SuperFetch by shutting the service. Start
Administrative Tools from the Control Panel and then go
to Services. Double-click on Superfetch to open the
window to disable and stop the service.

All your computing niggles and nags
are dealt with here!

Your Questions, Our Answers

Question 

of the

Month

Msconfig can be used to shut down unnecessary startup
applications and services

Programs like Irfanview can
be used to scan as well

Changes to the FSB and multiplier are required to over-
clock a processor

Virtual Memory can also consume large
amounts of space on the hard drive
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450 W Power Supply
Operating system - Windows XP SP2

Prashant More 

The problem could lie anywhere and a
power supply change shouldn’t normally

cause your hardware to heat up. There’s a
chance that the new power supply is radiating
a lot of heat and that hot air trapped in the
cabinet could be increasing the temperatures
for all the components. Try running the PC
with the side panels removed and look for any
drastic temperature drop. Shut down the PC
and clean up the heatsinks and fans on the
processor and check again. The temperature
for the processor and the motherboard chipset
is a little higher than most cases but nothing
seriously alarming. The 75 degrees for the
GeForce 6200TC is pretty high though. Your
card most likely doesn’t have a fan in which
case you can try attaching one which will bring
the temperatures down a fair bit. If you want,
you might want to ask for a replacement.

Motorola W230 And Windows Vista
Ultimate Issues

I will be buying a Motorola W230 mobile
phone. I have no GPRS connection so how do

I install Java games on it from my computer. 
My other problem is that I run Windows Vista

Ultimate Edition. My system configuration is Intel
Pentium 4, Intel D101GGC motherboard, ATI
Radeon Xpress 200 series, 768 MB of RAM. When I
run the game Chess Titans, it displays some error
messages -
“Could not find texture
[Media\BoardWoods.dds]”
“The D3D device has a non-zero reference count,
meaning some objects were not released.”
“Failed to creating Direct3D device objects.”

Jibon Jyoti Changmai

Your phone might come with a data cable
that will allow you to connect the phone

to the computer. The software and drivers
might be supplied with the phone itself or can
be downloaded from Motorola’s site under the
Support section.

Start Windows Explorer and enable show-
ing of hidden files and folders by clicking
under Folder Options. Then browse to
C:\Users\<Your_Username>\AppData\Loca
l\Microsoft Games\Chess Titans. Open a
text editor such as Wordpad and open the file
ChessTitans.xml and change the number
between the tags—
<Rendering>__</Rendering> to “0”. Restart
Chess Titans. Also, it’s worth trying to rename
or moving the file to some other location so
that a new file is generated.

Irritating Check Disk!
I have a PC with Windows XP SP2 installed on
it. One day, I scheduled a disk check for my C

partition and completed disk checking after the
next reboot. The problem is that since then, when-
ever I switch on my PC the scheduled disk check
starts checking the disk. This is getting very irri-
tating. Can you please suggest a way to stop it?

Chikku George Thomas

If Windows detects that a partition has
errors that need to be checked, it tags that

drive. This is what makes Windows check your
disk. This can be disabled using a simple
command typed in a command prompt
window: “chkdsk /x c:” to exclude the C:
partition. The same command can be used for
any other partition. 

Another way to fix it is to start the Registry
Editor by clicking on Start > Run and entering
regedit. Browse to HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Control\Ses
sion Manager. Double click on the
BootExecute key and change the value to
autocheck autochk *

Question Regarding SLI
My question is that can an XFX GeForce 8500
GT and XFX GeForce 8600 GT or 2 XFX Geforce

8500 GT’s be connected together in SLI mode?
Anish Gaur

SLI works by usually putting two identical
cards together. Two GeForce 8500GT’s can

be connected together in SLi but the perform-
ance from them might not be all that impres-
sive. If it’s a buying decision, it would be prefer-
able to buy a single 9600GT card.

Which Point And Shoot Camera?
Please suggest which camera of the three
should I buy—Canon A590 IS, Canon A720 IS

or the Canon SX 100 IS?
rak007 on Digit Forum

The Digit Test Centre
tested the Canon

SX100 IS and we highly
recommend it. It comes
with a 10x optical zoom as
compared to a 4x on the
A590 IS and 6x on the
A720 IS. The SX100 IS
makes it easy to macro
shoot as well. All the three
are 8 Mega Pixel cameras
and are similarly
priced.

Auto checking of disks can be disabled through the
registry

Canon PowerShot SX100
is a very good 8MP
camera with a large 10X
optical zoom
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Rossi Fernandes

Several readers have made the
jump to Linux, but they haven’t
got their Internet connections

running. In our country, broadband is
accessed in many different ways—
ADSL, wired networks, WiMAX, etc.
We connect using different diallers
and authentication techniques, so
unfortunately, we can’t depend on
one single universal dialler when
running Linux. In this short How To,
we’ll try and explain the most
common type of connections.

Connecting Using A USB Data Card
One of the easiest ways to get online
these days is to use a data card.
They’re not fast but they’re flexible
and you can connect within minutes
by plugging in the USB dongle. While
on Windows, it’s simple. While on
Linux, there are formalities, so to
speak, that need to be completed
before you can start dialling.

First we need to make sure that
the USB data card has been detected
by your distribution. Connect your
USB data card first. Then, we need to
first login into root, then type the
following.

cat/proc/bus/usb/devices
A list of connected devices will be

displayed, and you should find your
data card from the list. Look for a line
with the vendor mentioned as
Vendor=_______, and a Product ID
as ProdID=______.

Next, we need to run modprobe.
Type modprobe usbserial
vendor=________ prod-
uct=________ using the same infor-
mation that we got from the device
list. Once that’s done, type dmesg. 

Edit the /etc/wvdial.conf using
a text editor such as vi. You will find a

new connection called
[Dialer cdma]. Enter the
necessary information
there, and save the file.
Finally, type in the
command wvdial cdma to
dial the connection. You can
also use try using sudo
wvdialconf to configure
your connection. Once the
connection has been setup,
you might want to go check
whether the newly created
connection is being used in
Ubuntu under Administration >
Network.

Connecting Using PPPoE (PPP Over
Ethernet)
These days, PPPoE is one of the most
popular ways of connecting to the
Internet. It’s used a lot on ISPs that
use wired networks and cable modem
connections. On Windows, a PPPoE
dialling connection can be setup
using a Network connection wizard,
but on Linux, we need to use a
program called pppoeconf. Run this
program as a root from a console. 

The first thing that happens is
that the device will look for all

network cards installed on
your machine. Make sure
your LAN cable is plugged
in and then proceed. The
application will then scan
for a PPPoE server on your
ISP end. When it does, you
will be asked to use the
connection as your Internet
connection. Proceed and
you will be asked to enter
the username and password
for the connection. You can
leave the rest of the settings
as they are. Usually, the ISP
provides you with the DNS
server information automat-
ically when you dial, so you

need not enter any name servers
either. At the end, you can choose to
have the connection dialled. You can
also dial the connection using the
command pon to turn on the connec-
tion, and poff to turn off the connec-
tion. 

Connecting With cURL To A Web-based
Login
Although PPPoE is the simplest and
the most flexible way anyone can
connect to an ISP, there are many ISPs

that require users to login
using their Web interface.
For that, there’s hardly any
automation that can be
done except using a little
known program called cURL.
cURL is available for Linux,
Windows and a whole lot of
other OSes. You can down-
load it from http://curl.haxx.se.
It is used to access sites
using username and pass-
words, so it can be used to
enter a user and password

on your ISP’s login page.
Unzip cURL in a suitable folder,

and then open a command prompt
window and browse to that location.
You can use enter a command in a
text file in Notepad and save it as a
BAT file. All you need to know is the
URL for your ISPs login page and obvi-
ously your username and password.

Create an entry – curl –d
“username=_________&pass-
word=___________”
http://<url_for_login>. Save the
file and exit. The same entry can be
entered in the command prompt. The
BAT file can be run to login, or a
batch file can be scheduled to start on
startup, so you can have your connec-
tion turned on when the computer
boots.

rossi.fernandes@thinkdigit.com

Connect To The Internet Using Your
Broadband Connection On A Linux System
Connect To The Internet Using Your
Broadband Connection On A Linux System

Linux installed? Now let's go online…

Check for network

All network cards are first scanned

The final step dials the connection itself
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U3, Me One
I want to buy a pendrive based on the U3 plat-
form. Which size and model should I look at?

Anant Khilnani

Kingston and SanDisk are two very reliable
brands that have U3-based products—I’d

say look for a 4 GB drive. It should cost around 850
bucks. I’d give SanDisk preference over Kingston.
A 2 GB drive will cost around 500 bucks, but 4 GB
offers the best value for money right now.

More Power! 
I want to know whether my newly assembled PC
requires a new power supply My configuration is:

Intel Core 2 Quad Q6600 Processor
WD Caviar SE16 SATA 250 GB HDD
XFX GeForce 8800GT 512 MB Graphic Card
ASUS P5K Premium WiFi AP Motherboard
2 GB DDR2 RAM Transcend Jet RAM

I have two small 5 cm fans which came with the
motherboard. I use USB very frequently to connect
phones, iPod and PSP. I use Windows Vista Ultimate
SP1. My present PSU is a 400-W.

Saraansh Tandon

For this configuration, I doubt if even a
regular 500 watt power supply would

handle the job. You need something beefy that
actually delivers its rated wattage. I recommend
Corsair HX 520 Watts, which will cost around 
Rs 5,800. Or you could go for a CoolerMaster
Extreme Power 650 Watts, which will cost
Rs 3,800. Out of the two the Corsair will be
overkill for your PC, but I feel it’s better to have
power in reserve than to have less power.

Amnesia 
I bought an HP Pavilion tx1000 series notebook
PC (TX 1301AU to be precise), with AMD Turion

64 x2 Mobile Technology TL-58 1.90 GHz, with 958 MB
Memory(RAM), and 32-bit OS (Vista Home Premium)
with Tablet PC functionality, on being reviewed in July
edition of Digit. Now my problem with it is that its
RAM is very low—the NVIDIA Graphics card is also
sharing onboard memory and thus Vista hangs now
and then. I need to buy at least 1 GB more memory.
Which brands you suggest and recommend? My
budget is up to Rs 2,000

Navrooz

Regardless of 1 GB of RAM, Vista
shouldn’t hang, could an outdated

graphics card driver be the culprit? I suggest you
update your drivers to the latest version and then
check. Call HP’s customer support and tell them
the exact nature of the problem. You could also
have an issue with a loose heatsink, but this is
speculation unless we see the laptop for our-
selves. That aside for upgrading your memory, I
suggest you contact HP’s customer support, as
any kind of third party tampering will void any
warranties. 1 GB of memory should cost you
exactly Rs 2,000. An upgrade will bring about a
moderate performance hike, but get those
drivers updated pronto.

Want a tech product, but
don’t know how to go

about buying it? E-mail
agent001@thinkdigit.com

with your complete 
contact details, and he

might answer them here!
Please note that

Agent001 only answers
purchase-related

questions in this space.

Ask Away!

Ask Agent 001

Visual Appeal 
I want to buy a motherboard with inbuilt
graphics processor. I have budget of Rs 7,500.

Can these motherboards perform at par with the mid-
range graphics card when playing games at medium
resolutions? Also, I would like to know at what price
Intel E6600 is retailing for now and I want to buy a
19-inch LCD monitor for my PC. Which one?

Aditya Narayan Ray

No onboard graphics solution will ever
compete with even a low end graphics

card of the same generation. I suggest a mother-
board with no graphics solution and a cheap
graphics card, preferably based on an entry level
chipset like NVIDIA’s GeForce 8400GS. Look at
motherboards based on Intel’s G35 graphics solu-
tion for around Rs 5000. Look at an Abit IP35 E for
Rs 5,500 and a GeForce 8400GS for Rs 3,000, just
overshooting your budget by a thousand—you’ll
get very good performance for even viewing HD
movies, not to mention other multimedia
options. The E6600 is phased out. The closest you
can get to that is the new Penryn E8400 (3.0 GHz),
which costs around Rs 10,000, or you could look
at the cheaper and older E6750 (2.66 GHz) which
should cost around Rs 8,000 bucks. As for your
LCD monitor, flip over to our test.

Heading 
I have a 3 GHz (HT) Pentium 4 on an ASUS Intel
865G chipset motherboard with 256 MB (2 x 128)

PC3200 DDR RAM, a combo drive and 40 GB IDE HDD.
I have decided to upgrade to 250 GB HDD, 1 GB DDR
RAM and a DVD writer. My motherboard has no SATA
ports. I’ve a budget of Rs 5,000. Please suggest the
brands and their prices to look for. Also, tell me how
to find out a hardware brand is genuine like a guar-
antee card. My vendor gives me a written bill with
the guarantee period written by hand. Is he selling
me original hardware or serviced stuff?

Manicka Raj

Let’s take the last question first please—
your vendor is giving you original stuff. In

fact, most vendors like to mention the warranty
period as stuff like hard drives come with varying
warranties i.e. 3 years, 5 years and so on. It’s very
rare to find an 865G board with no SATA ports (if
memory serves they used to have two slots), you
must have been unlucky to get one of the rare
models that didn’t have a SATA port. However, if
you meant Rs 5,000 for all the components
including motherboard then you’re out of luck.
Your best bet would be to sell off your existing
system, thereby getting a slightly larger budget to
work with an investing in an LGA 775 based moth-
erboard—an Intel G31 chipset-based board would
be fine. For a processor, I recommend an E2160, a
very cool processor that will cost you around 3,000
bucks. 1 GB of DDR2 667 MHz memory will cost
around Rs 1,000. A blazing fast Seagate 7200.10
series single platter 250-GB SATA hard drive will
cost you around 2,800 bucks. If you must stick with
your existing socket 478 setup then look for
another 865G based board with two SATA ports. 1
GB of DDR RAM will cost you around Rs 3,000.
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For me, an avid gamer, one of the biggest hoaxes has been
the supposed deliverance that the DX10 was to bring
about. For the first time, the industry saw hardware that

was ahead of its time with a badly lagging software compo-
nent. With rumours of DX10.1 and even DX11, it’s hard to sort
out what’s fact and what’s fiction. With gaming hardware, it’s
a lot easier—both NVIDIA and ATI have behaved themselves
and wooed us consumers with some very good offerings. As
always, the horizon looks greener still, with the likes of
NVIDIA’s unborn G100 and GT200 GPUs and ATIs RV770,
which will sport next generation architectures. NVIDIA has
two new launches that aren’t available in the market at the
time of writing this—the GeForce 9800GTX and the 9800GX2
the latter being a dual-PCB solution similar to the 7900GX2.
From reports on the Web, the 9800GTX isn’t the new high-end
king by much, and its 256-bit memory interface seems a
detraction from the 384-bit interface on the 8800GTX / Ultra.
The only saving grace seems to be the 65 nm core running at
675 MHz; an overclocked 8800GT comes close to shaming it.

I was looking for three very different graphics card solu-
tions—a budget solution, a good gaming solution and a dual
GPU (SLI / Crossfire) solution. The dual-GPU solution was for

our office—we needed something fast for benchmarking.
With no new releases expected from either vendor (NVIDIA
and ATI) over the next few months and newer architectures
expected after another six months, this is prime time for any-
one looking for a good graphics solution. Waiting for newer
stuff may seem sensible, but there’s always going to be better
hardware available in the future, so it’s futile, really.

I needed a decent card for an HTPC. My budget for this
card was Rs 4,000. My options were very limited—ATI’s
HD2400 Pro and NVIDIA’s 8400GS seemed like the only two
options for the price, both cards are available from a variety
of brands. The prices are similar and range from Rs 2,700 to
Rs 4,500. Also on offer was the GeForce 8500GT chipset based
cards. ATI doesn’t have any competing offering as its HD2600
Pro / XT is costlier, and competes with the GeForce 8600GT,
both of these options exceed my budget. I decided on the
8400GS chipset, and the brand options were XFX, ASUS, MSI,
Gigabyte, Sparkle, Leadtek, Galaxy and Palit. I ended up with
a 256-MB version of Sparkle’s 8400GS for just Rs 2,950 after
haggling over the dealer-quoted price of Rs 3,050. Such a card
takes a huge load off your CPU and system RAM while tack-
ling video and HD video playback, and is worth the money
considering that onboard solutions hog system memory.

For a single-card gaming solution, everyone seems to
point towards the GeForce 8800GT or 9600GT. ATI’s equiva-
lent Radeon HD3870 is a little costly (Rs 12,000 at least) for
the performance it gives, and the 8800GT is priced better
and outperforms it. NVIDIA’s 9600GT seems a real winner—
it’s twice as fast as the 8600GT with 64 shader units, and is
priced in the range of Rs 9,000 to 10,000. It even outper-
forms the 8800GT (112 shader units) in some games at
lower resolutions. The older 8800GTX / Ultra and
HD2900XT aren’t good buys, especially since the 8800GT
comes within 15 per cent of their performance (at worst) at

less than half the price. ATI’s HD 3850-based offerings are
all priced around the Rs 10,000 mark, making the 8800GT
seem even better since it’s priced at only Rs 3,000 to 5,000
more. From amongst the other brands Gigabyte’s 8800GT
OC Edition caught my attention from amongst the crowd.
This card features a copper heatpipe Zalman cooler that
cools the core by an incredible 12 to 15 degrees Celsius
below the stock cooler. With a core factory overclocked to
700 MHz (default being 600 MHz) and a price tag of Rs
12,000 only (my haggling skills failed miserably here), I’d
have been a fool to look elsewhere.

For my dual-GPU solution, I was confused. SLI and
CrossFire are restricting in the choice of motherboard. SLI
seems better with a great core like an 8800GT to build on, but
CrossFire has the advantage of greater efficiency for the sec-
ond card, and two Radeon HD3870 cards in CF offer nearly
100 per cent more performance than a single card. But I did-
n’t want to restrict myself to using only an SLI or CF board.
Then I came across the 3870 X2 card (basically two HD3870
GPUs on a single PCB) and my wish was answered. A basic
check showed this card to be faster than a GeForce 8800 Ultra
by some 20 to 30 per cent. It’s a power hungry monster too,
and consumes nearly 240 watts on load. It’s the most hassle
free dual-GPU solution you’ll find out there. There were only
three brands available—ASUS, Sapphire and GeCube, and
although MSI, Gigabyte and Powercolor also do ATI based
cards they didn’t have any of these mighty solutions. I picked
up the Sapphire HD3870 X2 for 28,000 bucks and had the dis-
tinct pleasure of watching everyone staring agape at the big
spender…office money, but then that’s our secret… 

agent001@thinkdigit.com

DIGIT MAY 2008

Digital Tools l Agent 001Agent 001

Agent goes on some serious graphic card shopping…

Shopping For
More Action!
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You can also have the text on the
title bar changed. Enter the command
TITLE in the command prompt, fol-
lowed by the text you want to display on
the title bar. For example, title
%username% %date% %time% will dis-
play the currently logged in user name
followed by the current date and time.

If all this seems unnecessary, and
you want a change of colour, the sim-
plest way out is to right-click on the
command prompt title bar and click on
Properties. The fonts, colours and
layout can be changed from here.

Open Command Prompt In A
Specified Directory

The command prompt, when initialised,
starts in the logged in users default
directory—
C:\Documents and
Settings\Username.
From there, you have to
navigate using DOS com-
mands to the respective
directory, if you have to
run an application or
work on some files. If you
want to launch the com-
mand line at a different
location, first create a
shortcut on your Desktop
or your Quicklaunch
folder by right clicking
on it and clicking New >
Shortcut. Enter the
location of the item as
C:\windows\system32
\cmd.exe. Give a name to the shortcut
and click Finish create it. Right-click
on the created shortcut and choose
Properties. Click the Shortcut tab
and enter the path where you want the
command prompt to start. For example,
C:\. Click OK. Double click the shortcut
to run it.

EASTER EGGS

Easter eggs are there to lighten up
the mood and they do so by
shocking us or making us laugh.

Here are a selecte few Easter eggs from
some of the most popular software.

Adobe Photoshop CS3
Photoshop has quite a few Easter

eggs, but one of the coolest ones is the
red pill. Hold down [Ctrl] and [Alt]
and go to Help > About Photoshop.
Instead of the default About information
screen, you will now see one with a red
pill on the left and text on the right
saying Adobe Red Pill. 

Merlin the wizard is one known char-
acter on many Photoshop releases, and
in CS3, you can find him by first
enabling the Layers window. Hold

down the [Alt] key and click on the
down arrow for that window, choose
Palette Options and a small window
pops up, with a picture of the wizard
and “Merlin Lives!”.

Windows XP
A typical Windows XP

installation contains a music
theme that’s hidden away in a
folder
C:\WINDOWS\system32\
oobe\images. Enter this loca-
tion in the address bar on
Windows Explorer as it’s a
hidden folder. The track is
called title.wma. Double
click on it to run it and enjoy
the Windows Welcome music.

Create Files With No
Name

If you have ever tried to create
a file or folder with just a

space on it, Windows will show an alert
and it not allow you to create it just like
with the name CON. If you try holding
down the [Alt] key and enter 255, an
empty space will be created. Press
[Enter] and the file or folder will be
created with no name.

uTorrent
uTorrent has an interesting little

Easter egg in it. Start uTorrent and click
on Help > About uTorrent. Click on
the logo on the left top, and a sound will

be played—something like the one used
in THX trailers. An even more surprising
Easter egg can be found in the same
window. Press [Ctrl] + [T] and you
will find a small tetris game running.
Use the arrow keys to rotate and to move
the blocks into place.

Notepad
Notepad is a text editor and not

many believe there is an Easter egg in it.
Create a new Notepad text file and type
in bush hid the facts. Save the file
and close it. Re-open the file to see what
you find. Even if you type this app
can break, you will get the same
results—garbled text. This is not techni-
cally an Easter egg, but an issue.

WinRAR
Although WinRAR’s just another

compression utility, it also has a few
hidden eggs. These can be found in the
About window. First, make sure you are
using the default WinRAR theme. Click
on Help > About WinRAR. Click on
the pile of
books on the
left, and you’ll
see them slide
down. Instead,
if you hold
down [Ctrl]
+ [Shift]
and click on
the WinRAR
logo with the
background
of the
seashore,
you’ll see the waves beginning to pour in
and out.

Firefox
Firefox has a silly Easter egg, which

can be viewed by entering about
kitchensink in the location bar (note
that there’s no colon). A kitchen sink
made up of ASCII characters will open
up with water flowing down it. You need
to be connected to the Internet for this.
You can also get the same result in other
browsers by entering the keywords about
kitchensink in Google and selecting I’m
Feeling Lucky.

Counter-Strike CT-Spawn 
It’s not just software that come with

Easter eggs, there are games as well. One
of the most widely played games—Counter-
Strike—has many Easter eggs built into it.
One of them is in the map de_dust2. First,
join the Counter-Terrorist team and type
kill in the console. When you join into
free fly mode, move into the walls facing
the terrorist team and you will the see the
credits for the map. You might have to
host your own server for this with free fly
enabled for the map.
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WINDOWS
COMMAND PROMPT 

With Windows 2000 and then Windows
XP, the use of the Windows Command
prompt has been on the decline. Almost
everything today is dependent on the
user interface of Windows. There are still
many tasks that can be done just from a
Windows Command prompt and it can
be handy for things like removing
viruses or stubborn files that Windows
Explorer can’t do anything about. The
command prompt can be started by
going to Start > Run, entering cmd
and hitting [Enter].

Command Prompt History
In the DOS days when everything

ran on command prompt, there was
something called Doskey, which would
keep a history of all the commands
entered, which could be recalled as and
when required. Windows has a better
and easier way to display previously
entered commands. Simply press [F7]
and use the up and down arrow keys to
select the command from the list you
want to run again. You can also use the
up and down arrows without the list, to

cycle through the commands. To enter
the previous command, type [F3]. If
you want to enter a command line
number from the list, press [F9] and
enter it.

Command Prompt After
Running Application

Many a times, a DOS or command line
based program is run through the usual
Start > Run method—say something
like chkdsk or a network tracert com-
mand. The program executes and then
shuts the command line window with it.
Ideally, we want to see what happens
during the execution of an application.
To do this, type the name of the applica-
tion or the command after cmd /k. For
example, cmd /k chkdsk d: will scan
the disk, display the results and leave
the command prompt window open.

Copy And Paste 
Most of us have, at some point or

the other, tried to copy something from
and into the command prompt window
but the shortcuts [Ctrl] + [C] and
[Ctrl] + [V] just
wouldn’t work. To copy text
from the command
prompt, you need to first

right-click on
the title bar of
the window
and click on
Mark. Now
drag a box
around the text
you want to
copy. Right-
click again and
the text will be
copied into the

clipboard. To paste any text into the
command prompt window, right click in
the window itself and click Paste.

If you want to copy and paste stuff
quickly, you can enable it by right
clicking on the title bar for the window
and then on Properties. Check the box
for QuickEdit Mode. Click OK. You can
choose to enable this for a single
window or for all command prompt win-
dows. Now simply drag and select the
text to be copied. A single right-click will
paste the contents of the clipboard to
the window.

Using AutoComplete
Like the Linux console, Windows’s

command prompt too has an auto com-
plete feature, which allows you to com-
plete file names without typing the
entire name. Type the first few charac-
ters of the filename or folder and press
[Tab]. If there is more than one
result, you can use [Tab] to cycle
through all the possibilities. 

Full Screen Mode
If you try and run a console or

DOS application that looks right when
run on full screen, you can do it by
pressing [Alt] + [Enter]. Use the
same shortcut again to get back to the
window mode. 

Customising The Command
Prompt

The typical grey-on-black theme can get
boring. There are a few changes that can
be made to the command prompt to
look a little friendlier. The prompt itself
can be customised, which by default dis-
plays C:\ or the path you’re currently on.

The prompt can be changed
by typing PROMPT followed
by the parameters. PROMPT
$P$G will restore the
prompt to the default one.
Some of the parameters
that can be used are as fol-
lows—
$D—Current date
$T—Current time
$P—Path 
$G—>
$V—Windows Version
$M—Network path for
mapped drives
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All previous commands can be access by a simple shortcut

the PROMPT command allows changes to be
made to the command prompt

Do you take the blue pill or the red?

Pass your time playing Tetris while your tor-
rents download

WinRAR easter egg has a pile
of books sliding about 

By specifying a startup loca-
tion, the command prompt
can start at that location

Basic changes can also be done
through the Properties window 
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Phun
Phunny Physics

Rossi Fernandes

Phun! If you think we are not in
our senses and that it’s a weird

way to say fun, then here goes—it’s a
free 2D physics simulation we gave
out on the April ‘08 DVD. In short,
you draw objects like you would on
paper and all the drawings react with
each other as though they are real.
There’s a lot to play around with, but
where do you begin? 

Understanding The
Phundamental Operations
Before we start, here’s a very basic
introduction on how you handle
objects and the workspace in Phun.
You can create objects by clicking on
the shapes in the toolbar on the left,
and then clicking and dragging the
scene. To draw your own custom
shapes, choose the Brush tool and
draw a shape but make sure you com-
plete the loop. To rotate an object,
right-click on the object and move it.

In typical empty scenes, there is
no ground. Use the plane tool to
draw a plane or all your objects will
fall through empty space. If you want
objects to be attached in the space,
then click on the Fixate tool and
click on the object created. When you
have all the objects in place, you can
press the Play button under
Control. Everything now in the
scene will react in real-time. To move
objects around, you need to click the
Drag tool. To navigate around the
workspace, right-click and drag the
scene. The mouse scroll can be used
to zoom in and out.

Adding Hinge
Hinges allow you to fix objects and
allow other objects to latch on to
them and at the same time be

allowed some movement. Adding
hinges in Phun can be done by simply
creating the object that you want to
fixate. Use the Hinge tool, and then
click on a suitable location such as
one end of the extremities of the
object to allow a free movement.
Click the Play button to have the
object start rotating by gravity. The
same hinge can also be converted to a
motor. Right-click on the hinge and
click on Hinges > Motor. Click
the Motor checkbox to enable it. You
can also choose the speed and power
of the motor. To be able to manually
control the motor, click on Control
with arrow keys. Use the left and
right arrow keys to control the speed
of the motor.

Adding Springs And Chains
Springs are yet another component in
Phun which allow two objects to
interact. In springs, you can add 
tension between two objects just like
any other spring. Similar to hinges,
first create the object you to attach
the strings to. Click the Spring tool
and drag a spring from the blank
space or one object to another. Spring
properties such as strength and damp-
ening can be changed by right-clicking
on the spring and then choose Spring
in the menu that pops up.

Chains are also attached in the
same manner as springs by dragging
lines between two points after
selecting the Chain tool. Unlike
springs, chains can be created
without being attached to other
objects. Chains can also be set up as
motors like hinges by right-clicking
on it and clicking on Chain again.

Creating And Grouping Objects
Keeping track of little objects can be
a headache. If you’re someone who is
used to playing RTS games such as
Warcraft III, then the same technique
is used to create groups here. First,
select the objects you want in your
groups by drawing an enclosure
using the brush tool. Press [Ctrl]
+ [number] to add all the selected
objects to that group. To select the
group, press that number again. 

Liquid Simulation
Phun can do liquid simulations too.
Liquids can’t be created directly so
you need to create shapes and then

convert them to liquids. So first draw
the shapes like you normally would,
then right click on the object and
then click on Geometry settings
> Liquify selected.

Tweaking Phun for Quality or
Performance
Phun simulates everything in real-
time so all the physics processing
needs to be done in real-time by your
processor. It’s a heavy and strenuous
task for the machine so a few settings
can be altered when your scene
becomes too complex to render
smoothly. Click on Options under
File and uncheck the box for
Enable shaders and Draw
clouds and check the one for
Simple water rendering. If
your machine handles Phun perfectly
fine, then by all means leave shaders
and clouds on and turn off simple
water rendering.

If you’re still left baffled by the
things you can do with Phun, just
load some ready made scenarios by
clicking on File > Load Scene.
You can then modify them or learn
some new tricks from them. n

rossi.fernandes@thinkdigit.com

Hinges can be set up to act as motors

Solid objects need to be converted to create
liquids

Some performance tweaks are necessary in
CPU intensive simulations such as fluids
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on either side. Now load up a song and
play and watch the llamas’ head bob in
rhythm with the music.

FRINIKA

Professional audio sequencing soft-
ware is costly, but they are also in
plenty. For casual users, there are

alternatives such as Frinika, an open
source audio sequencer that runs on
Java. Frinika (http://frinika.
sourceforge.net) is available for Linux
and Mac OS. The Windows version is on
this month’s DVD. 

The Basics
Frinika will undoubtedly be a con-

fusing experience to anyone who hasn’t
used a music sequencer before. When it
starts the first thing to do, is select the
output and input device. Choose to

create a new project.
First, click on New > MIDI Out

Device and select one of the synthe-
sisers used to generate the sound. Next,
select the instruments you want to use,
by clicking on the MIDI Mixer tab. Set
the volume for each instrument. Click
on Null on the Lane Properties and

choose the synthesiser that
you created earlier. Now
that the instruments are in
place, you can use the
Piano roll to draw bars on
the chart. Click on the
Write tool to add bars and
right-click on the existing
bars to delete them. To pre-
view the tracks, click the
Play button on the top of

the window. Additional effects can be
added using the down arrow icon on the
left bottom of the Piano Roll pane.
Again, use the Write tool to drag and
draw the pattern.

Changing The Type Of View
Frinika has a rather cluttered inter-

face, with features and tool put into
every empty crevice! To makes things a
little simpler, there are three different

presets of customised views present—
Default, Master and Minimal. The
master has all the features required,
whereas the minimal perspective is to
have ample working space while
working on one feature of the program.
These views can be accessed by clicking
on the perspective menus or by the
shortcuts [Ctrl] + [F1] / [F2] /
[F3].

Performance Tweaks
Frinika runs on the Java environ-

ment, and along with other applications
consume large amounts of memory. On
Windows, Frinika runs as an executable,

but it can also be launched through com-
mand line, a batch file or a shortcut. We
can then use parameters to increase or
decrease the amount of memory con-
sumed by Frinika. First, open Notepad and
enter the following:

java -XX:ThreadPriority
Policy=1 -jar “c:\Program
Files\Frinika\frinika.jar”.
Replace the c:\Program
Files\Frinika\frinika.jar with
the location of your Frinika installa-
tion. Go to File > Save and save the
file as “Frinika.bat” (use the quotes
in the save dialog). Double-click this
batch file to run Frinika with those
parameters. The additional parameters
makes Windows run the application in
real-time as much as possible.

3DRealms Error 404 page
3DRealms is now best known for

delaying Duke Nukem Forever…forever.
Even they have a little Easter egg of
their own. Enter a wrong URL to their
site, say www.3drealms.com/blahblahblah.
You will find a page with altered pic-

tures of the people at 3drealms with
random comments.

Winamp
Winamp has a challenging Easter

egg in older versions of Winamp, which
can make you lose your mouse click if
you try hard. Get to Winamp’s
Preferences window by right clicking on
Winamp, then on Options >
Preferences. Go to Plug-ins >
Input. Click on the Nullsoft
Vorbis Decoder plugin, and click on
the About button. A fish logo will
appear on the left with the credits. Click
on the fish and you will see it spin.
Click a number of times, and a small
meter measuring the rotations per
minute will appear. Left-clicking on it
rotates the fish to the left, and a right-
click rotates it to the right. Digit is not

responsible for the loss or damage done
to any mouse buttons!

Winamp has another trick that
works with Winamp 5.0 and higher.
First make sure you have the Modern
skin selected and stretch the main
window to the right using the right
bottom edge till you find a Beat
analyser at the centre. Hold down the
[Ctrl] + [Alt] + [Shift] and
click the centre till you get two llamas

The people at 3drealms greet you when you
type a wrong URL

Adding a synthesizer is the first step towards
making a complete track

A choice of customized views are available for
every task

By default, the Piano roll pane has very little
empty workspace

Head banging with the llamas
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Adobe Photoshop Express
Photoshop, now in a browser

Rossi Fernandes

Adobe’s domination over computer
graphics just went online. Adobe

Photoshop Express (https://www.pho-
toshop.com/express/) is a free online
image editing service that allows you
to use some of Photoshop’s note-
worthy features. Not only that, you
can also get 2 GB of free online space
and an easy to remember
http://<your-choice>.photoshop.com
domain to go with it!

Uploading And Importing Photos
Being an online service, all the photos
that you want to edit need to be
uploaded to the service. Photoshop
Express has a nice way of doing this.
Click on the Upload Photos link,
and then browse to the folder where
you have stored the photos. Hold down
[Ctrl] and select the multiple
images that you want to upload, then
click Open. In the new window, choose
whether you want to upload the
photos into a new album or an
existing one. If it’s an existing one, use
the dropdown menu and select it.
Click Upload. The uploading process
will take place, and a status display
will be shown as well.

Photos can also be imported from
other photo hosting sites such as
Photobucket, Picasa and the popular
social networking site—Facebook. Click
on Login for the corresponding
external service and login to your
account. To see all the photos, click on
Library > All Photos link.

Browsing Galleries 
The other notable feature of
Photoshop Express is its community.
All albums that are shared can be
viewed by other users of Photoshop
Express. Slideshows are a small part

of the features offered by Adobe. Click
on Browse to browse through the list
of users and galleries. Click on the
smaller thumbnails under each user
to visit that particular gallery. To set
the duration for each slide in the
gallery, use the bar on the right top.
Enabling captions can be done by
clicking the checkbox. If you click the
Settings button on the right
bottom of the screen, you can set the
type of transition effect for the
slideshow. Galleries can be linked as
well and set as favourite using the
links below each album.

Creating Albums
Albums are an easy way to categorise
images as well as share them with
other users. Creating albums can be
done by clicking on the + icon next
to Albums under My Photos and
enter a name for the album. To delete
an album at anytime, click on
Albums. Then, click on the album
and press the Del key or click on
Remove Album.

Adding Ratings And Captions 
Photos in your albums can be rated,
and you can give them captions too.
The captions are also displayed when
other users browse through your
albums. Click on My Photos to
access your photos. Click on the
image you want to rate and add cap-
tions to. Enter a caption in the text
field under each image. Click on the
dulled out stars to set a rating for
that photo.

Full Screen 
Photoshop Express runs in a browser,
and so one of the most obvious draw-
backs is the workspace wasted by the
browser’s menus and toolbars.
Fortunately, Photoshop Express can
run in a full screen mode without

any obstructions. The small icon on
the right top of the screen can be
clicked to go into full screen mode.
Press that icon again to return to
window mode.

The Tools And Effects Of
Photoshop Express
Photoshop Express’s features don’t
come close to matching the number of
features on the desktop version, but
there are still some impressive ones.
Double-click on any of your photos to

go into the editing mode. All the tools
are visible on the left side of the
photo. Presets for each of the features
are available on the top pane. The up
arrow icon at the bottom of the screen
shows a preview of all the changes
made from the original photo. One of
the interesting features of Photoshop
Express is Pop Color. This tool can
replace a particular colour with
another. In photos where most of the
area is of a particular colour, it works
very effectively. 

Exporting Photos
When all the editing and colour cor-
rections to the photos are done, you
might want to get the images back
on your local machine. Click on My
Photos to access all your photos.
Move the mouse pointer to the bottom
of the photo and click on the drop-
down for Photo Options and click
Download. Select a resolution and
click Download. Select a location,
enter a name for the file and
click Save.

You can use the free Photoshop
Express space to host images as well.
Click on the same dropdown and click
on Link. The link can be used on
your personal blog, forums or even
Web sites! n
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Clicking on an album starts a slideshow of
that album

Users can rate their photographs and set
captions for them

Photoshop Express stores an interactive 
history of steps
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Practice Scripting In Frinika
With scripting support in Frinika,

you can just about script anything with
Java on it. It’s like having your very
own little IDE for Java scripting with
multiple windows within one parent

window. There are samples you can try
too, by clicking on the Presets menu.
Run the Play button or click on Run >
Execute to run the code.

Increasing Piano Roll View
Area

The Piano roll feature is located at the
bottom of the screen and has a very
small working area. There are a few
ways to get more work space into it.
One of them is to click and drag the
upper extremity of the pane, till you
get sufficient space. By default, the
view is zoomed into a small section of
the timeline. Click the [-] button,
right next to the scrollbar to zoom out
and the [+] to zoom in. There is a
zoom button on the top section of the
Piano roll pane. Ultimately, you can
also make the Piano pane much larger,
by pressing the maximise button—the
same button will do the trick for all
other panes.

Importing And Exporting
When all the work is done, it is

time to export the tracks to your
favourite format. If click on File >
Export Audio, you’ll notice that
there is no MP3 format in the drop-
down menu for formats. You can
choose to save as WAV but that could
be space consuming, so it’s a better
option to save the file in the OGG
format.

When it comes to importing for-
mats, Frinika can import all kinds of
sequenced modules such as MOD, S3M,
XM, STM and IT. You can do it by going
to File > Import Module. You can
also import MIDI files by clicking
Import MIDIs.

GIMPSHOP

Although GIMP has been popularly
known as a free, open source
replacement for Photoshop meant

for Linux, its workflow has never exactly
resembled Photoshop. GIMP has been
ported to Windows and so has
GIMPshop—its software that developers
got to finally work under one big
window and make it a lot like
Photoshop. The features of GIMP are all
still there, they are just a little easier to
access for people who’ve been using
Photoshop so far.

Keyboard Shortcuts
One of the biggest differences

with Photoshop and any other image
editing software for that matter is the
use of keyboard shortcuts. Most
advanced users will not run around
searching for features in menus, they
remember them by shortcuts. You can
have Photoshop shortcuts set for
GIMPshop by clicking on Start >
All Programs > GIMPshop >
Enable Photoshop Shortcuts.
Restart GIMPshop. If that doesn’t work
for you, you can still go to File >
Preferences. Click on Interface
on the left, and then Configure
Keyboard Shortcuts. Here, all the
shortcuts can be customised as per
your choice. Some other configuration
changes to the behaviour of the mouse
and keyboard can also be done by
clicking on File > Preferences >
Input Devices > Input
Controllers.

Making Docks
GIMPshop allows the menus on

the interface to be undocked, which
allows quick access to the tools within
them. Say you want to use the Xtns
menu and some of the scripts in it.
Click the Xtns menu and click the
dotted line on top of the menu. The
menu will then undock from the
menu. You can move it to the side and
access all the features directly from
there. If you right click on the image
you’re working on, a separate menu
with all the items in the standard
menu on top will be displayed, which
can also be undocked.

Customising GIMPshop
One of the significant changes

with GIMPShop is the big window, which

holds all the GIMP tools together. The
background colour for this window can
be to be a little pleasing on the eyes.
Click on Edit > Background Color.
Choose a colour and click OK. You can
also have all the toolbars and windows
snap to the edges if you click on Edit >
Snap GIMP Windows.

Using Photoshop Plugins
Even though GIMP can do a lot of

what Photoshop can do, there are some
plugins that add additional features to
Photoshop. Photoshop plugins can be
used in GIMP as well but for that an
additional plugin for GIMP or
GIMPshop needs to be downloaded. It’s
called PSPI and is available for down-
load for different operating systems at
http://www.gimp.org/~tml/gimp/win32/psp
i.html. Unzip the file into the GIMPshop
folder. Now start GIMPshop, and click
on Xtns and then on Photoshop
Plug-in Settings. Click the New
button and then the … button to browse
for the plugins. Click OK when done.

Use Script-Fu To Generate
Designs And Patterns

Scripting is a way to have complex
designs and patterns made by
GIMPshop. Scripting support is some-
thing that is standard in most of
today’s well-known image editing and
3D-modelling software. Readymade
Script-Fu scripts are available in
GIMPshop, under the Xtns menu or by

Photoshop shortcuts can be enabled by run-
ning a shortcut in the Windows Start menu

Photoshop plugins can be used under GIMP
using the 3rd party plugin—PSPI

You can practice scripting in Frinika’s inbuilt
scripting feature

Performance tweaks can be necessary if large
images are opened in GIMP
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right-clicking on the workspace. You
can also create your new Script-Fu to
create your scripts by clicking on the
Xtns > Script-Fu > Script-Fu
Console. You can search commands
and keywords that can be referred to,
by pressing the Browse button.

GIMP Optimisations
Image editing software need to

handle large images and they can get
really heavy. With many steps involved,
the history can really over-utilise system
resources. Some amount of tweaking is
possible from Preferences in the
File menu. Click on the
Environment item on the left. You can
set memory limits on the history and
thumbnails generated.

Adding Custom Tabs To The
Toolbar

The toolbars of GIMPshop are modular,
which means you can add or detach fea-
tures from it. Tabs can be added to the
toolbar by clicking on the arrow
pointing to the left, then click on Add
Tab. Choose from the tabs you want to
add. Similarly, Tabs can be detached into
separate toolbars by clicking on Detach.

Panning The Image
Panning of the image is required

when you zoom into one or you’re
working with an image of really high
resolutions. Using the space bar will
move the image around itself.  An easy
way to keep track of the image while
moving through it is to use the move
icon on the right button of the window.
Hold the left mouse click down and
move the mouse arrow to pan through
the image.

Toys!
This is no Easter bug, but

GIMPshop has a few little fun features
called Toys. First, create a new image or
open an existing one with decent
amount of detail. Now click on Filter
> Toys. There is one called GEE-Slime,
which uses a water-like effect rendered

in real-time on the image you have open.
The other toy—GEE-Zoom gives a 3D illu-
sion. Use the mouse to move in and out
of the image.

PRODUCTIVITY

We all want to work smart,
right? Here are a bunch of
things we’ve learnt from our

own experiences, and some that have
only just occurred to us.

Control The Future
If you want to remind yourself of

an event in the future, send yourself an
e-mail! Time Machiner (www.timema-
chiner.com) is an online service that lets
you send yourself an e-mail at a future
date. Just visit the site, choose a date,

and type the e-mail. The shock of
receiving an e-mail from your past self
will likely be enough to make the event
or task register in your mind. 

SMS Reminders 
If you’re a Google Calendar user,

you can get it to send you event
reminders by SMS—just go to Settings
> Mobile setup to set up your phone
number. Nearly all Indian mobile
providers are supported, and it’s free!

Nota Bene
The first step to increasing your

productivity is to take notes whenever a
noteworthy idea strikes you. You could
turn to good old Notepad (we’ve been
there), or install one of the billion
“sticky notes” applications available on
the Web. The drawback with these
approaches, however, is the fact that
notes you take at home won’t come to
the office with you, and vice versa. The
most hassle-free solution, we’ve found,
is Yahoo! Notepad. Install Yahoo!
Widgets and activate only the Yahoo!
Notepad Widget (not that there’s any-
thing wrong with activating others) on

all the PCs you’ll be using. When an
idea strikes you, jot it down in the
widget, and forget about it. The widget
uploads this note to your online Yahoo!
Notepad, and you can now access it
from anywhere! We assume, of course,
that you have Internet access at the
aforementioned locations, otherwise
this is admittedly pointless.

Nota Bene, Part 2
You can create e-mail templates in

Outlook, but what if you don’t want to
lose that functionality if you’re using
Web-based e-mail? What if you had a
standard reply for all e-mails on a par-
ticular subject (“I did not have relations
with that woman!”) but didn’t want to
type it out all the time? For Opera
users, there’s a way out—Copy to Note.
Just type the e-mail once, select all the
text, right-click and choose Copy to
Note. You can access these notes in the

sidebar (take your mouse cursor to the
left of the screen and click).
Unfortunately, you can’t click and drag
the text into Gmail’s Compose Mail text
area, but it’s handy to have this text for
ready copy-pasting nonetheless. 

Organising Your Inbox Right
Whether it’s Web mail or Outlook,

it pays to be able to look at your inbox
and immediately know what tasks you
must prioritise. Here, we must follow the
teachings of GTD (Getting Things Done),
though you can add your own twist to it.
Most importantly, you should be
checking your e-mail at designated times
of the day, or when someone specifically
tells you it’s urgent that you do so. 

Mentally divide your e-mail into five
categories—mail that can be addressed in
the next five minutes, mail that needs to
be addressed soon and is high-priority,
mail that needs to be addressed soon but
is secondary priority, mail that needs to
be eventually addressed, but can wait a
few days, and finally, mail that you don’t
really need to do anything about. If you
receive an e-mail that can be addressed in
the next five minutes, address it—get it
off your back as soon as you can. For the
rest, create folders—Priority 1, Priority 2,
If I get time, Information, Done, and so
on. Sort your mail every time you check
it, and you’ll find yourself looking at a
clean, un-cluttered inbox. 

Folders in your inbox appear in
alphabetical order, but you should really
sort them in order of importance. To do
this, precede the folder’s name with a
number—”0Priority 1”, for example, will
ensure that this folder’s always on top,
ready for your attention.

Just don’t forget to actually do the
work, though.

Word? Notepad?
Office 2007’s Ribbon offers you a

more uncluttered interface as it is, but if
you’re running at low resolutions or if
the Ribbon still bothers you, you can
minimise it—just double-click on one of
the tabs. This gives Word a Notepad-like
look, where you can concentrate all your
energies on typing and not be distracted
by any graphical elements. 

Another handy tip, as you’ll witness
in the screenshot: if you’re working for
extended periods on a CRT monitor,

change the page colour to black (Page
Layout Tab > Page Colour) to ease
the strain on your eyes.

Archive, Archive, Archive
Gmail has spoiled us all, really—

thanks to the “never delete” philosophy,
we’re left with inboxes that often say
“1—50 of 1687” (or some such ridiculous
figure) at the bottom. Most of us don’t
register that the “never delete” is really
“never delete, archive!”. Use labels liber-
ally (preferably organised the way we’ve
mentioned above), and once you’ve
applied a label to an e-mail, archive it.
It’ll still be visible when you click on the
label, so it’s really like moving e-mail to
a folder in Outlook.

Description

Starts Calculator
Starts Microsoft Excel
Starts Windows Explorer
Starts Firefox if installed
Internet Explorer
Starts Microsoft Sychronization Tool
Outlook Express
Starts Microsoft Paint
Starts Notepad
Starts Microsoft Outlook
Starts Microsoft PowerPoint
Starts Windows Address Book
Starts Microsoft Chat
Starts Microsoft Word
Starts Wordpad

Starts Add or Remove Programs
Starts the Control Panel
Opens Display Properties
Opens Folder Options
Opens Fonts
Opens Mouse settings
Opens Network Connections
Opens Scheduled Tasks
Opens Users Accounts
Starts Windows Firewall
Starts Sound and Audio Device Properties
Starts Network Setup Wizard
Starts Power Options Properties
Opens System Properties
Starts Windows Updates

Opens Indexing Service
Opens Computer Management
Opens Device Manager
Opens Disk Management
Opens Event Viewer
Opens Shared Folders Management
Starts Group Policy Editor
Opens Removable Storage Management
Opens Performance Monitor
Opens Security Policies
Opens Services Management

Runs Check Disk (eg. chkdsk c:)
Opens Clipboard Viewer
Starts a Command Prompt window
Runs Microsoft Disk Partioning tool
Runs Dr. Watson Debugger
Runs DirectX Diagnostic Tool
Starts Private Character Editor
Runs Bluetooth Transfer Wizard
Logs off user from Windows
Starts System Configuration Utility
Starts Remote Desktop Connection 
Starts On Screen Keyboard
Opens packager
Starts Registry Editor
Runs Windows shutdown command
Runs Task Manager 
Starts Windows Tour

Play around with GIMP’s toys

The most hassle-free way to take notes

If you have standard text you use often, store
it as a note

Break the time barrier with TimeMachiner

Minimise the ribbon for a clutter-free Word

Command
Applications

calc
excel

explorer
firefox

iexplore
mobsync

msimn
mspaint
notepad
outlook

powerpnt
wab

winchat
winword
wordpad

Control Panel
appwiz.cpl

control
control desktop
control folders

control fonts
control mouse

control netconnections
control schedtasks

control userpasswords
firewall.cpl
mmsys.cpl

netsetup.cpl
powercfg.cpl

sysdm.cpl
wuaucpl.cpl

Administration
ciadv.msc

compmgmt.msc
devmgmt.msc
diskmgmt.msc
eventvwr.msc

fsmgmt.msc
gpedit.msc

ntmsmgr.msc
perfmon.msc

secpol.msc
services.msc

Utilities
chkdsk
clipbrd

cmd
diskpart

drwtsn32
dxdiag

eudcedit
fsquirt
logoff

msconfig 
mstsc

osk 
packager

regedit
shutdown

taskmgr
tourstart

Windows Run Commands
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NVIDIA continues to
blast away its competi-

tion with the 9 series. The
first wave of attack was
done by the latest excellent
value for money cards—the
9600GT which we tested
last month. They were
almost as good at perform-
ance as the 8800GT for
around an 85 per cent of
the price, but they ran
cooler and consumed a
little less power. The 8
series of cards were led by
the 8800GTX, but the
9800GTXs are finally here.
We have here three GeForce
9800GTX’s from three dif-
ferent companies—
Gigabyte, MSI and ZOTAC. 

While three share the
same design and cooler, the
ZOTAC’s Amp! Edition
and MSI are overclocked.
The MSI runs at a core
speed of 700 MHz and the
ZOTAC at 750 MHz! All the
cards came with 512 MB of
GDDR3 RAM.

NVIDIA doesn’t seem to
be in any hurry to jump
onto the DirectX 10.1 band-
wagon—the 9800GTX, like
the 9600GT, is also a
DirectX 10 card. It is
turning out to be a good
decision, with most cur-
rent games still continuing

to release with DirectX 9
support.

The coolers on the
9800GTXs look a lot like
the stock 8800GTS 512
coolers. The cards need two
6-pin connectors to power
them and the cards occupy
two slots. 

Throughout all the
tests, the Gigabyte
9800GTX was lagging a
little behind the MSI, while
slightly ahead of the Zotac.
The Zotac’s 9800GTX’s
extra power is most visible
in the Splinter Cell Chaos
Theory benchmark. Games
perform equally well, even

after pushing the resolu-
tion up to 1600 x 1200 at
maximum quality with
anti-aliasing and anti-
stropic filtering turned up
to the maximum.

The 9800GTX isn’t the
new benchmark for high-
end cards. It then appears
that the 9800GTX is nothing

more than a refined and
matured 8800GTX, just like
the 9600GT was, as com-
pared to the 8800GT. All the
cards we received per-
formed the same way as
some of the better
8800GTXs we’ve seen. They
are only a bit cooler and
more power efficient

We test the latest hardware
and software products 
available in the market

Geforce 9 Series GTX Unleashed!
8800GTXes In Trimmed Sheep Clothing

BazaarBazaar

mainly because of the move
to 65-nm fabrication
process. The 9800GTX also
supports HybridPower,
which allows the card to be
completely shut down if run
on NVIDIA’s HybridPower-
supported motherboards.
The most significant differ-

ence is that the 9800GTX is
a lot cheaper than the
8800GTXs were when they
were launched. So, there is
no reason whatsoever for an
8800GTX user to upgrade to
the 9800GTX. If at all an
upgrade is needed, a
9800GX2 could be thought

of. We have tested a
Gigabyte 9800GX2 this
month too. The 8800GTX’s
were Rs 6000 to Rs 8000
costlier when they arrived.

Of the three cards we
tested, the Gigabyte was
the slowest, but it still
makes great value for

money. The overclocked
MSI and Zotac 9800GTX’s
result in only a mere 5 to
10 fps improvement over
the Gigabyte. For such
boost, ZOTAC sets you back
by Rs 4,500 and the MSI,
which was the next best,
costs Rs 1,000 more.

Features

Performance

Build Quality

Value For Money 

Overall 

Price

Phone

E-mail

Web site

Rs 24,999

+91-11-41758808 / 09

sales@zotac.com 

www.zotac.com

Rs 21,500

+91-22-23823331 / 2

sanyam@msi-in.com

www.msi-india.com

Rs 20,500

+91-22-40914613

vikas@technologyandgadgets.com

www.giga-byte.com

MSI N9800 GTX

Zotac GeForce 9800 GTXGigabyte GeForce 9800 GTX

Gigabyte
GeForce 9800 GTX—GV-

NX98X512H-B

MSI
GeForce 9800GTX—

N9800GTX-T2D512-OC

Zotac
GeForce 9800GTX Amp! Edition

Ratings and
Contacts  

F.E.A.R.—1600 x 1200
(4x AA, 8X AF)

Splinter Cell Chaos
Theory—1600 x 1200

(4x AA, 8x AF)

Far Cry—1600 x 1200
(4x AA, 8x AF)

DOOM 3 -
1600 x 1200

(4x AA, 8x AF)

PREY 1920 x 1200
(4x AA, 8x AF)
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The Notepal W2 from
CoolerMaster is a note-

book cooler designed to
tackle heating issues asso-
ciated with laptops. We put
it through punishment for
a month and it comes off
with flying colours on
many fronts. 

The cooler is made out
of aluminium, with three
holes in the centre, which
are covered with a steel
mesh. Behind the steel
mesh are three 1500 RPM
sleeve-bearing fans for ven-
tilation. The laptop sits on
the top surface. The sur-
face is concave, thus
leaving room for the fans
to circulate air between
the hot laptop and the alu-
minium surface.

The aluminium surface
is at an angle, which dra-
matically improves
ergonomics when using the
notebook on a desk. The 
relative angle between the
laptop keyboard, eyes and
the screen becomes more
comfortable and reduces
strain on the wrists and
neck. Our reviewer, who
uses his laptop on a daily

basis, noted this after using
the NotePal W2 for a little
over a month. 

On the cooling front, we
didn’t see any perceptible
difference. However, in note-
books with venting on the
back, the fans do help in
lowering the temperature,
but slightly! The fans draw
power from the laptop’s
USB port. However, the USB
hub on the NotePal ensures
you don’t lose any ports.
The fans can be switched off
via the power button—pretty

useful it you are sitting in
an air-conditioned room.   

The NotePal W2 is
sturdy, well finished and
comes in three colour
options—Silver, Black and
Titanium. Priced sensibly at
Rs 1,400, we recommend it
more for its ergonomic
advantages than cooling. 

Specifications:
Two USB Ports, Dimensions:
40 x 30.8 x 5.1 cm, Fan speed:
1500 RPM +/- 20%, Noise: 21
dBA, Current: 0.1 A, Supports

17-inch laptops including
widescreen 

Contact: Cooler Master
Phone: 9833870302
E-mail:
Tanmay_L@Coolermaster.com
Web site: www.coolermaster.com
Price: Rs 1,400

Features  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Cooler Master NotePal W2
Try Something, Accomplish Something Else!
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The Canon PowerShot
A720 IS is an upgrade to

the A710 IS, which was a very
good point-and-shoot
camera—one of the best that
we saw during our compar-
ison test last year. The most
prominent change in the
A720 IS, is its resolution. It is
now an 8 Megapixel camera
as opposed to the 
7.1 MP A710.

The picture quality has
stayed pretty much the same
too. The ISO level on this
camera goes up to 1600. The
A710 IS had a maximum of
800. The amount of grain
beyond 800 is pretty bad and
should be avoided as far as
possible. The zoom lens is
decent and there’s no serious
degradation of quality at
maximum zoom.

The colours—as with all
other Canons—are very neu-
tral and not exaggerated. The
images aren’t too high on

contrast so there’s a smooth
balance between the dark
and the bright areas. This
makes for some good por-
trait photography. The flash
is pretty powerful too and
the slow sync mode works
rather well in illuminating
the background in shots
with the flash on. Macro
shots are fairly easy to shoot
and it’s possible to get
extremely close to the object.
The A720 IS now has a face
detection feature, which
works well and tracks people
through darker areas as well.

The movie quality is
decent and actually usable in
low light situations. There’re
no sudden jumps in expo-
sure while moving from
bright areas to dark ones.
Image stabilization evens out
the bumps and the zoom
works well, although a little
aggressively, in the movie
shooting mode. 

The A720 IS, is incremen-
tally superior to the A710 IS.
The problem with the A720
IS, is not so much to do with
the camera itself, but with
the other cameras even from
Canon itself in the same
price bracket. The SX100 is
more or less available for the
same price in the market
and comes with a 10X optical
zoom. If any, the A720 IS’s
only advantage is that of
being a little more compact
than the SX100 IS.

Specifications:
8.0 MP, 4x optical zoom, ISO

Sensitivity: 80—1600, Shutter
speed 1/2000th—15 seconds,
Aperture range—f2.8—f4.8,
Movie recording: 640x480 at
30 fps, 2.5-inch screen.

Contact: Canon India Private
Limited
Phone: 1800-345-33-66
E-mail: info@canon.co.in
Web site: www.canon.co.in
Price: Rs 14,995
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Altec Lansing’s inMotion
iM600 is an iPod dock

that doubles as a radio and
speaker for your PC or any
other MP3 player.

The dock itself is stylish
and compact, and is a small
rectangular block but can
be unfolded on a table. All
the iPod models can be
docked, including the latest
iPod Touch. You can charge
your iPod or synchronise
your music as well. 

There are controls for
volume adjustment at the

base of the dock and the
track switching buttons on
the top. The volume control
buttons are hard and tacky,
whereas the smaller track
controlling buttons are very
soft and tiny. There does not
seem to be any button for
pausing or stopping tracks.
Other than that, the dock is
simple to use and comes
with an inbuilt display on
the front, which shows the
source of the track and
volume control. There’s also
a compact little remote con-

trol, like those found on
many of their desktop
speakers sets.

The iM600 has good
music quality, but it lacks
bass in the tracks due to its
flat design. It is loud
though, and there is little
or no distortion with the
volume set to maximum.
The SFX button doesn’t
really do a whole lot other
than making the sound
slightly better.

The dock comes with an
auxiliary connector, which
means you can connect any
other iPod MP3 player to it,
or even your computer for
that matter. You also can
use it as an FM radio, and
the antenna comes well
tucked into the back of the
dock. One of the biggest
plus points of this product
is the inbuilt chargeable Li-
ion battery that charges
itself when powered on.
This dock is then mobile
but docking an iPod in a
moving vehicle might not

be a good idea—the base
plug could damage itself or
the iPod connector from
the vibrations.

The Altec Lansing iM600
is priced at Rs 7,500. It’s a
tad costlier than we’d like it
to be, but the functionality,
flexibility and performance
that it offers is hard to come
by in such a product, espe-
cially in the Indian market.

Specifications:
Dimensions: 28.3 x 4.3 x 15.2 cm
(Folded), Weight: 0.9 kgs,
Battery capacity: 2150 mAh

Contact: Rashi Peripherals 
Pvt. Ltd.
Phone: 022-67090909
E-mail: altec@rptechindia.com
Web site: www.alteclansing.com
Price: Rs 7,500

Audioengine is a compara-
tively new brand and is

fairly unheard of to many.
The Audioengine A2s are the
less powerful versions of the
larger A5s.

They are small when
compared with computer
speakers available these
days but the build quality
is just unmatched. They are
made of wood cabinets
with a smooth glossy
finish. They have heavy and
gold-plated connectors.
Quality is maintained
everywhere—even the well
shielded cables are some of
the best we’ve seen. The
only problem with the
design is the volume knob
which is situated at the
back of the speakers which
means you need to move to
the back of the speakers.

When it comes to per-
formance, these small
speakers go ballistic—espe-

cially for their size. They’re
not as powerful as Altec
Lansing’s MX5021, but for
their size, they are highly
impressive and can get
really loud without losing
any clarity. There are vents
at the bottom of the
speaker, which breathe out
loads of air when played at
decent volumes. The power
isn’t even its forte. It
delivers great detail and
very neutral tone, without
any exaggerated highs 
or lows. 

At first, they sound a
little muddy without any
sparkling highs. Speakers
like this require some burn-
in period and some improve-
ment in the quality and
vibrancy could be noticed
after a few days time. 

The solidly built A2s
come in two colours—black
and white and in a neat
package with soft cloth

pouches for each speaker. At
a price of Rs 10,400,
although excellent, it’s a
little difficult to recom-
mend these speakers to
everyone. These speakers are
great for music, but not so
much for movies mainly
because of the lacking bass-
woofer. For people who are
used to listening to music
with loads of bass, this defi-
nitely will be an unfulfilling
experience. However, if it’s
detail, clarity and good tone
you appreciate, the
Audioengine A2 is undoubt-
edly among the best desktop
speaker sets you can find in
this price range.

Specifications:
30W RMS (each speaker 15 W),
Inputs: 2 RCA inputs and 3.5-mm
mini-jack, built-in power amp,
Dimensions: 6 x 4 x 5.25 inches

Contact: Audio Products India
Phone: +91 9324233508
E-mail:
audioenginesales@gmail.com
Web site: www.audioengine-
usa.com
Price: Rs 10,400

Performance  
Features 
Build quality
Value for Money
Overall 

RATINGS

Performance  
Features 
Build quality
Value for Money
Overall 

RATINGS

Altec Lansing inMotion iM600
iPods On The Move

Canon PowerShot A720 IS 
Incremental Update
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Audioengine A2
Affordable Audiophilia Inducer

Performance  
Features 
Build quality
Value for Money
Overall 
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Belkin has entered the
Indian market with one

of their first products—the
N1 Vision router. It might be
a utility, but Belkin has man-
aged to make it look like a
lifestyle product.

The design is very good
and stands out amongst all
the routers you might
come across today. Unlike
most routers, the N1 stands
vertically, but the stand is
stable and has rubber
padding at the base to stop
it from sliding around.
There is a small screen on
the front , which shows
data speeds of all the users
connected to the router,
both wired and wirelessly.
There are buttons that can
be used to navigate
through the interface and
the display can also be used
as a clock as well. 

When it comes to per-
formance, it works pretty
well on the wired ports. We
recorded speeds of 7.36
Mbps for a single large file.
For random files, the speeds
were around 6.92 Mbps. The
wireless tests revealed the
weakness of the N1 Vision.
The wireless performance
was pretty appalling—2Mbps
is the best it could do over a
distance of some 10 feet.

The software interface
has all the features that a
router firmware should
have—Internet connectivity
configuration, VPN, secu-
rity, etc. The interface is
more user-friendly than
those on most well known
routers. One thing you
notice is the long waiting
period for the router to
restart every time you
change a setting.

The price for the Belkin
N1 Vision—Rs 11,699—is
much higher than main-
stream home routers.
Although this router will
look nice in your living
room, it’s definitely not
something you can rely on
for performance.

Specifications:
IEEE 802.11g / b / n compatible,
Security: WPA / WPA2, 64 / 128-
bit WEP encryption, multiple
SSID, VPN Support: PPTP, IPSec

pass-through, One WAN port, 4
gigabit ports.

Contact: Belkin
Phone: 000-800-440-1406
E-mail: madhuj@belkin.com
Web site: www.belkin.com
Price: Rs 11,699

Belkin N1 Vision
Bringing Style To Routers

Performance  
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Build quality
Value for Money
Overall 
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The Palm Centro is the
latest Palm with their

Palm OS, unlike the other
models that we’ve tested in
the recent past that were
based on Microsoft’s
Windows Mobile.

The initial reaction to the
phone is that it seems like a
very casual hip-looking
phone. It’s not the most com-
pact of phones we’ve seen
but its pretty decent for a
phone that comes with a
fully usable keypad.

The build quality is a
little shabby. While holding
it one hand, you can feel the
back cover squeeze from the
pressure. The stylus supplied
with the phone is very light.
It won’t break, but it bends
while using and it doesn’t
have a great feel. The keys on
the keypad are really small,
but are reasonable for

typing. There is no virtual
keyboard, should you want
to use it to type. 

The interface is a little
confusing if you’re used to
Windows Mobile and
Symbian phones. Closing
programs and switching to
other programs is hectic as
well. The SMS and mes-
saging interface looks
great—so does the phone
dialler itself. The software
itself is fast and reacts well.
The design—colours and
fonts used in the interface
doesn’t match up to fancy
Symbian and Windows
Mobile applications and it
looks pretty outdated. 

Reception is good and so
is the voice quality, but the
sound is really flat and a
fair bit different from other
phones. The 1.3-MP camera
is nothing extraordinary,
but is decent for occasional
urgent photos.

Finally, it comes down to
the price of the phone and
that’s where the Palm
Centro has a chance. The
phone has an MRP of 
Rs 13,990. For a similar

price, you can easily get
Windows Mobile phones
with larger screens. In the
Centro, you get a proper
phone with a proper
keypad, a compact but great
screen and for a bit of the
geek factor—Palm OS, which
is still uncommon in India.

Specifications:
320 x 320 65k colour touch
screen, MicroSD slot, 1.3 MP
camera, Bluetooth, IR, Supports
GPRS, GSM, EDGE and CSD.
Dimensions: 10.72 x 5.36 x
1.86cm, Weight: 116gms

Contact: Palm Inc.
Phone: 011-41725228/9
E-mail: myil.nathar@palm.com
Web site: www.palm.com
Price: Rs 13,990
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The Stylus C110 is a piezo-
electric inkjet printer

from Epson. Its price point
and design is aimed for the
home user.

It’s a decent looking
printer, which will defi-
nitely fit in well with the
rest of the computer setup,
but it isn’t the most com-
pact of printers. There are
five cartridges in all, out of

which two are black. The
entire printer installation
and setup is simple and
straightforward.

In terms of quality, there
are a few issues. There’s fine
banding throughout all the
print qualities selected—
more prominent in the
lower quality prints. At low
quality, the print speed is
pretty good. Colour accuracy

wasn’t too good either. As
compared to some other
printers, the colours were a
little washed out. The yel-
lows, especially had a very
different tone—they
appeared much lighter than
yellow. On the other hand,
dark browns and purples
appear black. Our photo
quality test print took a little
over three and a half min-
utes to complete. 

The prints come out
pretty detailed, but the text
has jagged edges all around
them no matter what
quality you print at. The
paper intake mechanism
can be unforgiving with
few sheets of paper in the
tray. We had a few mis-
aligned prints.

The Epson Stylus C110
isn’t a bad printer, but it

isn’t a brilliant one either.
For its price, it’s a tiny bit
costlier than it should have
been. Its speed and
detailed prints are pretty
good. As an everyday
printer for text printouts
and occasional photo
prints, it’s a decent buy.

Specifications:
Dimensions: 43.5 x 24 x 16 cm,
Noise levels: 39 dB, Weight: 3.9
kg, Ink cartridges: Black (2),
Cyan, Magenta, Yellow.

Contact:  Epson India
Phone: 30515000
E-mail: sales@eid.epson.co.in
Web site:  www.epson.co.in
Price: Rs 5,299
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Palm Centro
Palm OS Comes To The Masses

Epson Stylus C110
Slightly Overpriced, Average Printer For The Home User

ASUS’s Formula Rampage
is an X48-based mother-

board that supports Crossfire
and sticks to DDR2 memory.
The launch is timed at
around the same time as
nVidia’s 790i-based mother-
boards, which use DDR3.
With DDR3 still not very
affordable for the masses
and not quite showing any
major performance improve-
ments, the X48 might stand
a good chance to take the
place of the X38.

The motherboard has
been stacked with heat
sinks with copper pipes
forming a long continuous
chain evenly distributing
heat. It does a great job at
that and there are no
noticeable hotspots any-
where. Solid state capacitors
are used all over the board.
At the rear of the board, an
LED display shows informa-
tion and errors while
posting. The BIOS has a sec-

tion called the AI
Tweaker, which has
plenty to keep the
overclocker busy
with reasonably
minute increments
for speeds and voltages.

In terms of perform-
ance, it’s general. There are
no real benefits that one can
find on the X48 chipset.
Most processors today still
use the 1333 MHz FSB. The
motherboard performs as
well as well as the high-end
P35 boards. In 3DMark 2005,
it scores 27927, which
matches the high-end P35
boards of last year, but
shows a very miniature
improvement in games like
Splinter Cell and Doom 3 at
high resolutions.

The board comes with
SupremeFX II’s riser card for
audio. Software bundled
with the board is 3DMark
2006 and a DirectX 10 ver-
sion of Stalker. 

In the end, the X48
stands out as nothing but
just a minor update for the
X38. The performance gain
is minimal, but the board
is a little more future-
ready, which should
interest anyone who ini-
tially planned to get an
X38. This is an enthusiast-
level board that matches
some of the best P35 and
X38 boards so the price of
Rs 17,400 is overpriced as
compared to the best per-
forming boards from a few
months back.

Specifications:
Intel X48/ICH9R chipset
supports 45-nm multi-core Core
2 Quad/Duo/Extreme CPUs,
Dual Channel DDR2 1066MHz
support.

Contact: ASUS Technology Pvt.
Ltd
Phone:  18002090365
E-mail: media_india@asus.com
Web site: http://in.asus.com
Price: Rs 17,400
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ASUS Formula Rampage
X48 Makes A Late Entry

Two PCBs in one—now
that’s something that

the GeForce 8 series was
missing out on. We never
got to see an 8800GX2 in
action. The Gigabyte’s
9800GX2 is the first such
card we look at. It’s been a
while since we’ve seen
something this huge and
heavy. Like all 9 series of
GeForce cards, it’s a 65-nm
card, but this comes with
1 GB of RAM.

In dimensions, it’s as
long as the 8800GTX or
9800GTX, the 9800GX2 is
thick, but flat with the fan
concealed within the unit.
Fortunately, the card takes
two slots just like the GTX
cards. In terms of power, an
8-pin and 6-pin power con-
nectors are required,
unlike two 6-pin power con-
nector configuration for
the 8800GTX.

It performs faster than
any 8800Ultra out there, and

it annihilates them even
more once you go higher res-
olutions. The card scores
18517 points in 3DMark 2006
and 13398 in 3DMark 2005.
For example, on our test rig,
in games such as Splinter
Cell, the GX2 is a consider-
able 27 per cent faster than
the 8800Ultra. At resolutions
of 1600 x 1200, this lead
increases to close to 44 per
cent. The trend is the same
through most of the games.
It’s not just the 8800Ultra
that are beaten. Even the
latest 9800GTX’s we’ve tested
stand no chance.

The 9800GX2 does get
very hot, and that can be
easily made out by the blast
of hot air coming from the
rear of the card. Should you
buy this card, you must also
invest in a decent cabinet
with decent cooling. A
power supply of at least 600
W is also recommended for
this card. 

The price for the
Gigabyte 9800GX2 is 
Rs 34,000, which makes it
a very expensive invest-
ment. The Gigabyte
9800GX2 is a fast card.
We’ve seen it bypassing the
8800Ultras in all our tests.
For users using 24-inch
screens and running games
at resolutions of 1920 x
1200 or higher, the advan-
tage of a card like this is
clearly noticeable and
these are the users for
whom it makes good sense
to buy this card. However,
if you already have an SLI
board, it would be a much
cheaper and most probably
a better option to pair two

8800GTs or 8800GTSes
together.

Specifications:
nVidia GeForce 9800 GX2, 1 GB
GDDR3 memory, PCI-E 2.0x16

Contact: Technology and Gadgets
Phone:  22-2382331/2
E-mail:
vikas@technologyandgadgets.com
Web site:
www.technologyandgadgets.com
Price: Rs 34,000
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Gigabyte 9800GX2 GV-NX98X1GHI-B
The GX2 Returns After An Absence In The 8 Series
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Trend Micro Internet
Security Pro is an all-in-

one security solution that
has been developed to keep
your PC trouble free by
taking care of all possible
threats of all kinds.

If the suite finds that
your system does not have
enough memory to run it, it
warns you. If there are other
anti-spyware programs such
as Spybot for example, it will
uninstall it if you allow it to. 

Once installed, it’s a
good idea to register the
program as a few additional
features are given access to.
Trend Micro Internet
Security also scans
Windows for any vulnera-
bility fixed that you may
have not updated to.

There are a few features
like Data Theft Protection,
which stops any credit card
number or personal infor-
mation from being sent out

through instant messengers
for example. You can also
add information to be pro-
tected. There are some other
features for stopping any
unwanted access to your PC.
Any new computers that
appear on your LAN can be
scanned after every few
minutes and you can choose
to stop them from accessing
your PC—this is useful if
you’re on a public LAN or
WAN. The Parental Controls
are also pretty advanced in
the sense that you can
simply check the boxes of
the types of content you
want to block. You can also
manually make changes to
add or remove sites from
the block list.

The memory consump-
tion of the antivirus is pretty
high and we recorded
around 55—60 MB on idle
state. Even after you stop the
suite, there are still a few
running services consuming
some memory like most
other suites of its kind. A

screenshot-filled manual
with an explanation of fea-
tures is provided with the
software, but the software
itself is fairly easy to use
after a few minutes.

Trend Micro Internet
Security Pro is just another
security suite, which doesn’t
really stand out among the
rest. It does the job of han-
dling viruses and security
threats well but is a little
heavy on the system. The
price tag of Rs. 2,760 is
asking a lot, especially when
there are free alternatives
available online.

Specifications:
Windows XP / Vista supported.
Requires 350 MB to 1 GB of free
disk space with 1 GB of memory
recommended

Web site: www.trendmicro.com
Price: Rs. 2,760
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Projectors can go where
no LCD or Plasma screen

can—they can give large
screen areas for a compara-
tively cheap price. BenQ’s
MP612c is one such pro-
jector that was sent to us
for testing. 

The design of the BenQ is
very stylish and it’s also very
rigid at the same time. The
top of the projector has a
glossy finish and the quality
of buttons is very good too.
The quality of the zoom and
focus rings, feels cheap and
is not as great as the external
design though. There is a fan
at the front of the project,
which blows loads of hot air
out of the unit. 

Although there is no
DVI port, connections can
be made through VGA, S-
video and composite con-
nectors. The remote control
gives you all the controls
you get on the projector
itself. The interface is excel-

lent and only takes a few
minutes to get used to.

Installing the projector
and then setting it up is also
simple. The BenQ 612c can
easily handle resolutions up
to 1280 x 1024.  It’s also very
easy to display on a large
area. The default brightness
is high to begin with, and
the settings let you increase
it further. Colours aren’t
very saturated, but they are
still pretty good. There is no
flickering of any kind, but
increasing the brightness
can be a little strenuous on
the eyes. There are modes
for different types of media
as well as custom profiles
that can be customised by
the user. There’s also a dig-
ital zoom to zoom and pan
into a scene, which is really
useful in places when you’re
trying to explain details in
an image, for example.

The price of the BenQ
MP612c is around Rs

39,990, which makes it one
of the more affordable pro-
jectors of the lot. For this
price, it actually makes
good sense to buy one. The
crippling problem with pro-
jectors is the reliability,
because of the heat gener-
ated. The same can be
found in the BenQ MP612c.
It gets very hot and run-
ning it for long hours
doesn’t seem to be a good
idea. It might be alright if
you want to use it for
watching movies every once
in a while and of course
perfect for official presenta-
tions and slideshows.

Specifications:
Native resolution: 800 x 600,

Lamp life: 4000 hours
(Economy mode), Dimensions:
23.9 x 10.6 x 25.1 cm,
Weight: 2.5 kgs.

Contact:  BenQ India Pvt. Ltd.
Phone: 1800-22-0808
E-mail:
sales.enquiryin@benq.com
Web site: www.benq.co.in
Price: Rs 39,990
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A ntec is well known
mostly for the P180,

P182 and the Antec 900
cases, which are high-end
enthusiast level cases that
compete with the best from
Coolermaster and the likes.
The NSK4400 is an entry
level mini-tower case for
desktop PCs, which target
cases from the lesser-
known brands.

The quality of the cabinet
is pretty good. The metal
work is thin, but is sturdy
and doesn’t flex a lot under
pressure or weight. The
biggest dilemma is when you
don’t read the manual that
comes with the cabinet! This
is a cabinet opens from the
top first. Once that’s done,
the side panels can be
removed. Two thumbscrews
are to be removed before
opening the cabinet.

There’s enough space
for three optical drives,
three hard drives and two
floppy drives or other
panels of the same size.
The hard drive bays have
bits of padding to reduce
vibrations. For cooling,
there is a 120-mm fan
attached to the back, with
a speed switch that acts as
a good exhaust. There is an
air guide attached to the

side cover of the cabinet
that directs air to the
processor. The guide can be
removed and an 80-mm fan
can be fixed. There is provi-
sion for a fan in the front
under the drives. The rear
expansion panels pop out
easily and can be snapped
back into place if you
choose to remove any cards
or change positions. That
way you have no open slots
in your cabinet letting 
dust in.

The cabinet doesn’t look
stylish, but it’s elegant and
straightforward. Even
though it’s small, it has a
very clean flat look to it.
The front face of the cab-
inet is sturdy without any
loose bits from the remov-
able panels. There are two
USB ports with an extended
cable that can be connected
to your motherboard.

The price for the Antec
NSK4400 is Rs 2,285. It’s def-
initely one of the cheapest
Antec cabinets we’ve seen,
but the lack of a power
supply makes it not-so-
cheap. If you are building
an entry level system, and
you want a sturdy cabinet
with decent cooling, then
the slightly overpriced
NSK4400 is worth it. 

Specifications:
Supports Mini-ATX and
Standard ATX form factor,
Dimensions: 42 x 20 x 42 cm

Contact: Cyber Space Abacus
Pvt Ltd
Phone: 9884021688
E-mail: vinod@antecindia.com
Web site: www.antecindia.com
Price: Rs 2,285

BenQ MP612c
LCD TVs Need Not Sweat

Trend Micro Internet Security Pro
Slightly Overloaded System Security Guardian

Antec NSK4400
Antec’s Attempt At Bringing Quality To Entry Level Cabinets

The Siberia Neckband is a
product from Steelseries

for the professional gamer,
or so it seems. Steelseries has
played an active role in the
professional gaming arena
and tied up with clans and
communities.

If you think wearing a
headphone with a stretch-

able strap that attaches to
the back of your head is com-
fortable, you’re wrong. Sure,
for people with smaller
heads, it should work fine,
but anyone with a larger
head will find it too tight or
hanging from the top of your
ears. You’ll also notice that
they start slipping back from

the back of your head and
adjusting it from time to
time can be irritating.

The sound quality of the
Siberia isn’t too shabby. It
lacks the extreme low bass,
so isn’t ideal for music or
movies. For gaming, it
should do fine. These phones
do not distort or lose quality
at high volumes, and the
volume can get pretty high.
These are open headphones
and as they don’t hug the
side of your face properly, a
lot of the sound leaks out.

There’s a flexible micro-
phone that retracts into the
headphone too. It performs
pretty good quality audio
recording. There’s an
adapter for the Xbox360 sup-
plied with it and a volume
control too. The headphones
are built well and the look
is appealing. 

Good audio recording
quality and an easily
adjustable microphone are
the good points of the

Siberia Neckband but even
then, a price of Rs 5,999 is a
lot to ask for. There are
much cheaper solutions
without the Steelseries tag
and slightly inferior, which
do a better job without any
of the discomfort. 

Specifications:
Headphone: Frequency
response: 18—28,000 Hz,
Impedance: 40 Hz,
Microphone: Frequency
response: 80—15,000 Hz

Contact: Vstreet Netserve
Pvt. Ltd.
Phone: 079-40020127
E-mail: sales@v-street.net
Web site: www.steelseries.com
Price: Rs 5,999

Steelseries Siberia Neckband
Pain In The Neck
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2.1 Speaker Sets
Altec Lansing MX5021

Excellent performance
Some minor vibrations in woofer

Contact Rashi Peripherals Pvt.Ltd
Phone +91-22-67090909
E-mail altec@rptechindia.com
Price Rs 7,600

5.1 Speaker Sets
Logitech Z-5500 Digital

Explosive power
Too expensive

Contact Logitech
Phone +91-22-26571160
E-mail kavita_nath@logitech.com
Price Rs 27,995

Projectors
Acer PD726W

Great overall performance
Lacks remote sensor at rear

Contact Acer India Pvt Ltd
Phone +91-9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,35,000

MP3 Player above Rs
10,000
Cowon D2

Very good performance
Slightly bulky 

Contact Lipap Systems P. Ltd
Phone +91-9819917440
E-mail iaudio@lipap.com
Price Rs 11,000

Digital Cameras
(High-End)
Canon PowerShot A570 IS

Good overall performance
Lacking in macro 
performance 

Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 13,995

MP3 Players up to Rs 5,000
Apacer Steno A4351

Good performence
Tacky build, Screen quality

Contact Apacer Technology
Phone +91-80-25702208
E-mail suraj_raina@apacer.com
Price Rs 1,720

MP3 Players up to Rs 10,000
Samsung T10

Good music quality, nice
screen
Tacky exterior

Contact Samsung India Ltd
Phone +91-11-41511234
E-mail jitendra.c@samsung.com
Price Rs 6,600

Internal DVD-Writers
Samsung SH-S203

Performance, inexpensive 
None in particular

Contact Samsung India Electronics
Pvt Ltd

Phone +91-11-41511234
E-mail c.serrao@samsung.com
Price Rs 1,200

Internal Hard Drives
Seagate 7200.11 750GB
ST3750330AS

Class leading performance
None as such

Contact Fortune Marketing
Phone +91-11-2641 4468
E-mail sales@fortune-it.com
Price Rs 8,900
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Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up

Contact Technology and Gadgets
Phone +91-22-23823331
Web site technologyandgadgets 

.com
Price Rs 35,000

Graphics Cards 
(Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular

Contact Asus Technology Pvt Ltd
Phone +91-22-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular

Contact Champion Computers Pvt Ltd
Phone +91-11-26214751
Web site www.championindia.com
Price Rs 6,500

Internal Hard Drives
Seagate 7200.11 500GB
ST3500320AS

Value for money, performance
None in particular

Contact Fortune Marketing
Phone +91-11-2641 4468
E-mail sales@fortune-it.com
Price Rs 4,900

Multimedia Cell Phone
above 20,000
Nokia N95 8 GB

Great all round performance
Slightly bulky

Contact Nokia India
Web site www.nokia.com
Price Rs 28,000

Below Rs 20,000
Sony-Ericsson W910i 

Great sound
Flat and clumsy keypad

Contact Sony Ericsson Mobile 
Comm. India Pvt Ltd

Web site www.sonyericsson.com
Price Rs 19,000

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone +91-22–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive 

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone +91-120-4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 5,995

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800-222-422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India) Pvt
Ltd

Phone +91-44-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone +91-22-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone +91-124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

The best products tested so far in different 
hardware and software categoriesThe A-List
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Value Executive Phone
Nokia E51

Loads of features
None

Contact Nokia India
Web site www.nokia.com 
Price Rs 13,000

Business Device
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt. Ltd.
Phone +91-124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

DVD/DivX Players

Samsung DVD-1080P7
Great looks and perform-

ance
No 5.1 channel RCA

Contact Samsung India Electronics
Pvt. Ltd.

Phone +91-11-41511234
E-mail shailja.m@ samsung.com 
Price Rs 2,990

DIGIT MAY 2008

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive

Contact Intel Tech India Pvt Ltd
Phone +91-9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

LCD Monitor
LG 246Wp

Great performance and Build
Bulky, Slightly expensive

Contact LG Electronics India Pvt. Ltd.
Phone 91 - 120 - 2560900 / 940
E-mail sanjoyb@lgindia.com
Price Rs 28,000
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After last year, the onslaught of cheaper and (sometimes) better LCDs continues. 
We’ve tested 33 of them, ranging from 17 to 24 inches of prime real estate.

Take your pick…

Michael Browne

After last year’s flat panel 
fiasco and the fact that 
nobody was willing to send 

us CRTs to test, we’d thought 
things couldn’t get any better 
and the time of the LCD was 
now… err… then! If you’re won-
dering what all the hullabaloo 
is about, imagine a 19 inch wide-
screen LCD monitor that costs a 
mere Rs 14,000. Wouldn’t that be 
enough to get everybody waiting 
in turn for LCDs to become more 
affordable salivating in antici-
pation? Now flash forward to 
this year—we’ve got 22-inch wide-
screen LCDs available for well 
below 14,000, with 19-inch LCDs 
now sitting pretty at below the 
10,000 rupee mark. That’s what 
we call depreciation.

If anything, the focus has 
shifted to the bigger panels. 
Previously, any LCD larger than 
19 inches were rarely in stock, 
and orders had to be placed. As 
per your beloved Agent 001’s last 

report 22-inch panels were well 
and truly in stock. This focus 
shift is seen from manufactur-
ers as well. You can always tell 
when there’s a slight emphasis 
towards a particular product or 
category. This year we saw a lot 
of mediocre build quality in the 
19-inch category. Designs were 
simple, nothing inspiring, ditto 
with the quality of materials. 
The 22-inch panels were another 
matter entirely—and this differ-
ence is not just a function of a 
costlier product.

Just like last year, we could 
only get a single 24 inch monitor 
for this test—it seems their time 
hasn’t come yet.

Another very noticeable 
change is the rise in popularity 
of widescreens—especially when 
one crosses the 19-inch mark. 
Going widescreen today makes 
even more sense than it did 
last year, with most multimedia 
content including games sup-
porting widescreen resolutions 
natively.

Sadly, the scene for good 
panels hasn’t changed much. 
The bulk of the LCDs out there 
are still based on colour and 
contrast deficient TN (Twisted 
Nematic) panels. Although there 
were a couple of MVA (Multi-
domain Vertical Alignment) pan-
els, and a single S-IPS (Super 
In-Plane Switching) panel, the 
prices of these are significantly 
higher than the regular TN pan-
els. There also exists a large dif-
ference between the prices of 
24- and 22-inch monitors, mak-
ing the 22-inch a superb value 
for money buy. Similarly, buying 
a 17-inch minnow makes very lit-
tle sense, unless you absolutely 
cannot afford to spend more.

In case you’re feeling a little 
stingy just watch a 17- and 19-
inch screen in action side by 
side—or better still, a 17- and 
22-inch. We guarantee that your 
wallet will open just a little bit 
more to gobble up one size larger 
than what you originally intend-
ed to splurge on.
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22-inch LCDs
The New Entry Level?
       

Dell SP 2208 WFP
Add a little gloss to your life

The worst thing about Dell’s 
new 22-inch Ultrasharp is the 

fact that it’s based around a TN 
LCD panel. We have just one last 
grouse and then we’re done, and 
then some of us are going out to 
see if we can buy one. The silver 
bezel that some love, and oth-
ers hate, and the entire fit and 
finish, exudes quality. The stand 

is finished in piano black, and 
adds a striking contrast to all the 
silver. A 2 megapixel Web camera 
has been cleverly integrated into 
what has to be one of the slim-
mest bezels ever to grace an LCD 
to date. No ugly bulges, no pro-
trusions, and the SP 2208 WFP 
looks like it’s seen the inside of 
a wind tunnel during its design. 
We do feel Dell goofed up with a 
glossy LCD panel rather than the 
matte ones we’re used to seeing 
for one huge reason—reflection. 
It’s like looking into a mirror, 
especially with any sort of light 
source in the background, and 
we found this quite annoying 
during our tests. 

Other than this one niggle 
and fact that a silver bezel isn’t 
the best idea for any LCD (read 
glare), the SP 2208 WFP boasted 
of an intuitive menu system and 
good, easy to use buttons—very 
ergonomic. The integrated cam-
era has excellent quality. This one 
features an HDMI port as well—
superb connectivity options.

Considering the fact that a 
similar discrete webcam could 
cost as much as Rs 2,500, this 
monitor is a superb deal at Rs 
15,386, and the price alone makes 
a very strong point to purchase it. 
And that’s before you even con-
sider that it’s a good performer. 
We had issues with the Intensity 
Range Check in DisplayMate 
where we missed out on a lot of 
the darker grey squares which 
were indistinguishable from the 
black background. In the reverse 
text tests we had issues with bright 
green text on a black and grey 
background—the text just wasn’t 
visible. Colour intensity was very 
good for a TN panel, especially 
the colour green, which is very 
easy to discern. This monitor also 
did well in the 256-shade ramp 
test, where even slight gradations 
were noticeable—of course it can-
not produce the entire intensity 
gamut like an S-IPS panel, but 
then we didn’t expect it to.

It does well at games, and 
the very contrast-sensitive F.E.A.R. 

looked quite good—deep shad-
ows with good variations in 
relative lightness and darkness 
of a screen. In HD movies you 
will notice its slightly deficient 
contrast, but it’s nothing out of 
the ordinary for a TN panel—and 
we’ve seen much worse.

Aside from a couple of design 
flaws and the mirror-like panel, 
there’s nothing wrong with this 
monitor, and you’ll hardly find a 
better conglomerate of features 
and performance at the price. If 
you’re looking for a monitor with-
in the range of Rs 16,000, you’d 
have to be daft not to consider the 
SP2208 WFP as a serious option.

HP L2208w
When matte met flat

If you’re not one for loud state-
ments then you’ll appreciate 

the laid back, even bland design 
on this one. A matte finished body 
extends to the bezel—black is the 
best colour for an LCD bezel, and 
if it’s dull enough to refrain from 
reflecting ambient light so much 
the better. The stand looks cool 
with a silver and black colour 
tone. However the swivel action 
on the stand is quite hard, and 
a couple of days of, err, swivel-
ling didn’t loosen things much. 
The control buttons aren’t backlit 
or colour indicated, and fiddling 
with them in dim lighting is a hit 
and miss affair. The slight inden-
tation in the centre of the stand 
is quite useful for keeping a few 
utilitarian knickknacks like pen-
cils, erasers or screwdrivers.

DisplayMate’s Intensity Range 
Check showed a lot of indiscern-
ible grey squares—this bespeaks 
a poor contrast ratio. We faced 
no issues with the 16-shade ramp 
test, but in the 256-colour ramp 
test we had issues with the varia-
tion in intensity of colours green 
and grey. The movie tests revealed 
slightly less colour rendition and 
contrast in most HD clips (com-

pared to the Dell and Samsung 
monitors of the same size). In 
F.E.A.R we had issues with contrast 
where the enemies in dark khaki 
uniforms were virtually invisible 
when in shadowy areas. This is 
a serious put off for any gamer 
especially when playing dark, 
atmospheric games.

All in all at Rs 18,500 the 
L2208w is a costly proposition, 
both on your wallet and your 
visual senses. It’s a great looking 
monitor that corrects some of 
the flaws of Dell’s SP 2208 WFP 
design, but also detracts a lot on 
the performance front. With the 
exception of the extreme rarity of 
you being a diehard HP fan, give 
this one a miss.

AOC 2217 Pwc
Strictly mediocre stuff, this…

It’s a good looking monitor but 
the fact that it integrates speak-

ers doesn’t excuse the rather 
broad bezel. The piano finish is 
quality. The stand is very big for 
a monitor that doesn’t have any 
kind of height adjust, and it man-
aged to fool us that it did have 
this feature till we used it. Three 
USB ports add some connectivity 
options. The contrast ratio isn’t 
too good as a couple of quick 
DisplayMate tests revealed. This 
dismal performance continued 

in the 16 shade intensity test 
where we couldn’t discern any 
difference between two or three 
of the most intense shades for 
each colour. Due to its lack of a 
proper colour rendition, contrast 
calibrating was a chore. While 
it performed decently at games 
like F.E.A.R (no worse than the HP 
L2208w) it didn’t do as well at 
movies and we recommend you 
avoid this panel for any kind of 
serious multimedia PC.

At Rs 16,000 the AOC 2217Pwc 
is slightly costly, but it does have 
a serious competitor in Dell, who 
manages to outdo it on all fronts, 

including price. One position is its 
decent performance in the geom-
etry tests along with its competi-
tive price (compared to the HP) 
which make it a decent buy for an 
office monitor.

ViewSonic VX2255WM
White n Bright…

A piano white finish is some-
what a rarity in this colour 

prejudiced LCD world where black 

is a defacto standard. The three 
little birds (ViewSonic’s trade-
mark) stand out in visible relief 
and detail from all the white, 
another perk for deviating from 
black. Speaking about the bezel, 
it isn’t as narrow as we’d have 
liked—especially considering the 
space hogging buttons have been 
moved to the side. The trim on 
the lower bezel looks a little out 
of place and flimsy.

In DisplayMate the contrast 
was immediately better than 
the HP and AOC 22-inch offer-
ings, although not as good as the 
Samsung and the Dell monitors. 
No serious issues in the colour 
tests but the rendition of green 
isn’t good enough. In F.E.A.R we 
noticed a decent contrast ratio 
and good particle effects but 
both Dell and Samsung are bet-
ter. Oblivion is much more forgiv-
ing and the VX2255WM makes a 
very good showing in games with 
dimly lit scenes, something where 
its TN panel bearing compatri-
ots also performed reasonably 
well on. Movies show good colour 
but mediocre contrast, especially 
noticeable in darker scenes and 
with dim indoor lighting. At  
Rs 15,500, the VX2255WM is a 
decent offering—good enough for 
multimedia, games, and office 
use. However it doesn’t really excel 
at any of these applications, and 
there are better options available.

We divided our test candidates into five categories on the basis of screen size.
Features: Besides the theoretical parameters which we mention we awarded points for 
presence of add-ons like Web cameras, speakers, USB ports, and memory card readers. 
We awarded points according to the connectivity options available. Aside from this we also 
looked at certain features like the ability to pivot and swivel, or the presence of portrait 
mode and height adjustment. We graded the looks of the LCD and the intuitiveness of the 
menu system and the button layout. We rated the quality of moving parts as well.

  How We Tested
Operating System Windows XP Professional
CPU Core 2 Duo E6700 (2.66 GHz)
Motherboard Gigabyte DQ6 (P965)
RAM Kingston HyperX 512x2 DDR2 

800 MHz
Graphics Card NVIDIA GeForce 8800GTX
Hard Drive Seagate 7200.9 250GB SATA

Benchmark Tests What we looked for

DisplayMate Video 
Edition

Geometry Tests Point Shape and visibility, Pixel sharpness, Line resolution, shape integrity. This basically 
tests the ability of a monitor to work with shapes like cones, spheres, cubes, and even 2D 
shapes. Useful for professional users. Professionals will want to look here.

Contrast and greyscale 
Tests

Checks the ability to produce subtle variations in intensity of a single shade, and the ability 
to display purest blacks, and whitest whites.

Colour Tests Tests the colour rendition ability of an LCD. Uses a number of tests like colour purity tests, 
reverse text tests, shade intensity and colour ramp tests for the same. Animation, image 
editing and rendering professionals look at these values.

Movie Tests Pixel persistence, colour 
and contrast 

A mean value is taken for all these parameters, pixel persistence is a measure of response 
time, while colour and contrast are necessary parameters for a proper movie experience

Overall experience Here we look at the type of panel, whether it reflects a lot of light, the bezel colour and its 
interference with the image onscreen, and the aspect ratio—which also affects the overall 
experience.

Game Tests F.E.A.R Very dark and atmospheric game, with a lot of weapon, environment and special effects 
including bullet time and particle effects that are still the best in the business, very good to 
test contrast ratios of monitors as it trips most of them up with its ability to produce lifelike 
shadows, and their interaction with light sources which is very realistic. A good benchmark 
for gamers to base decisions on.

Oblivion Unbelievably detailed environments, with some great foilage and overall texturing. Also 
showcases transparency effects very well, and has some of the best colours seen in any 
game. Usually trips up monitors with texture detailing on floors, sand and other environment 
shaders, and even bloom and transparency effects. Gamers look here and decide.

Viewable Angle Text and Movie Here we look at the ability to view the monitor from angles other than straight on, this 
reveals how much distortion of the image and and its colours will occur if you happen to be 
sitting at an angle. Important for those people looking at an HTPC monitor, simply because 
with a number of people watching, say, a movie, it becomes impossible for each person to be 
directly in front of the monitor. 
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ViewSonic Va2216W
Decent for movies

The cheaper brother of the 
VX2255WM, the Va2216W is 

simple looking and a bit lighter. 

The stand is simple as well, and 
although small does a good job 
keeping this rather large beast 
well and truly grounded. With 
a rated contrast ratio that is 
less than is costlier sibling we 
figure ViewSonic ought to have 
dropped in a cheaper panel into 
this one. As expected whatever 
the VX2255WM does, this one 
does with a little less aplomb. Its 
contrast ratio isn’t too bad, but 
will be a little deficient in games 
like F.E.A.R, and our DisplayMate 
tests showed a slight issue with 
colour rendition of the green in 
the 256 intensity ramp test. The 
blues and reds were good enough 
though. One nicety is the very 
decent performance in movies, 
and it’s very close to its costlier 
sibling here, and makes a good 
choice for multimedia aficiona-
dos—unless you’re really discern-
ing. At Rs 13,500 the Va2216W 
makes a strong case for itself in 
the value market, except that the 
SP 2208 WFP is a lot more moni-
tor for a slightly higher price.

Samsung SyncMaster 
2253LW
Pricey performer

A very narrow bezel, great build 
quality, a sleek stand, and a 

Bordeaux-like slick piano black 
finish mean this monitor looks 
timelessly hot. The transparent 
fibre bezel on the bottom catches 
the power on/off buttons blue LED 
light and it looks as if the bezel 
itself is illuminated—neat! Don’t 
go by the Dynamic Contrast Ratio 
of 8000:1 mentioned on the top 
bezel. We figure the actual static 
ratio is more like 800:1 which is 
very good by the way. The menu 
system is uncluttered and very 
intuitive; the controlling but-
tons are easy to use. This moni-

tor features a matte panel (thank 
you God!), a blessing after the 
SP 2208 WFP. In DisplayMate it 
outshone the Dell in the Intensity 
Range Check where it displayed 
even more grey cards. The perfor-
mance in all other DisplayMate 
tests was very good, although the 
Dell seemed to be as good in 
the 256 shade ramp test. Colour 
rendition is good if not as vivid 
as the Dell’s colours, but this is 
a great panel for movie watching 
and our HD clips looked amazing, 
with ample contrast. In Oblivion, 
the outdoors look resplendently 
alive with detailing and textur-

ing, great HDR and contrast once 
again. Even the gloomy interiors 
of F.E.A.R were no issue for this 
monitor, except for a couple of 
dark spots where the contrast 
seems to be a touch deficient.

With good performance across 
the board, and a great matte panel 
accompanied by some fine build 
quality and designer looks, the 
2253LW is a great LCD all round. 
A price of Rs 17,500 is lower than 
the inferior HP monitor, but more 
expensive than any other moni-
tor in this size category. It is the 
best monitor of the 22-inch lot, 
albeit by a small margin. You 
decide if the premium is worth 
the performance.

19-inch Monitors
One size too small?

AOC 913FW
Standing tall…

With the most unique stand 
of all, the 913FW looks lore 

like an LCD TV than a monitor. 
We were surprised to see how 
firm this sits on a desk with just 
a little nub like protrusion for a 
stand—great design by AOC. Even 
the front bezel looks slick, with 
a contoured facia. The menu sys-
tem is good, although the navi-
gating buttons are a little confus-
ing. Our DisplayMate tests showed 

very good performance in the 
geometry tests and decent perfor-
mance in the contrast and bright-
ness tests. The colour tests were 
rather uneventful other than a 
slight discrepancy in the rendi-
tion of green and red in the 16 
shade ramp test. Overall a satisfac-
tory performance for a TN panel 
based LCD. We were surprised to 
see the contrast ratio being the 
main deterrent in our movie tests, 
especially noticeable with darker 
screens and areas where light and 
dark areas interact, like a scene 
with leaves dappled in sunlight 
moving in and out of bright spots 
of sunlight due to the breeze. It 
performed decently in our gam-
ing tests, although as usual F.E.A.R 
was a little too much for a TN 
panel, and we felt the contrast 
deficient by a decent margin. The 
colour and effects looked good.

For a price of Rs 9,600 the 
913FW is a great looking moni-
tor that will fetch more than a 
single glance. A great price, a 
decent performer with a look that 
demands a desk upgrade. What’s 
not to like?–nothing unless you’re 
a discerning gamer or a serious 
movie junkie.

AOC 917VW
Plain Jane

The 917VW is one of those fairly 
inconspicuous looking prod-

ucts that is never going to get 
a lot of attention. It features a 
well laid out menu and good 
build quality with great finish 
of materials. In our DisplayMate 
tests we found performance to 
lag behind its identically-priced 
sibling the 913FW, a weird show-
ing, especially since we figured 
both LCDs used the same panels. 
We missed out on quite a few 
grey cards in our Intensity Check 
test, and the contrast ratio gener-
ally felt a little deficient. What 
was a noticeable problem was the 
reverse text tests, especially with 
the colours yellow and green. 
Performance in the colour inten-

sity tests was acceptable, but not 
commendable. F.E.A.R showed a 
noticeable lack of contrast, as did 
the darkest dungeons of Oblivion. 
Our movie tests fared a little bet-
ter with decent colour, although 
the contrast issue still rears its 
head. At the same price (Rs 9,600) 
as its sibling, we suggest you go 
for the better-looking and per-
forming 913FW, unless it’s too 
loud for your office environment, 
in which case the 917VW will 
fit the bill.

ASUS PG191
Bassy stand…eh?

We reviewed the same moni-
tor last year. It features a 

stand heavy enough to knock 
Godzilla silly, which cunning-
ly incorporates a 10 watt RMS 
speaker unit with a subwoofer 
that delivers good sound, the 
best we’ve heard from inbuilt 
LCD speakers. To say this panel is 

well built is an understatement, 
although it’s not a widescreen. 
The soft touch buttons are as 
annoying as they are nifty—the 
problem is that they don’t work 
as they should. We missed a lot of 
touches—irritating!

The dated TN panel in this 
monitor shows up a few issues 
with contrast in DisplayMate. 
After that we had a few more 
issues with geometry which were 

rectified with judicious use of 
the calibration tool. In terms of 
colour performance it’s a mixed 
bag with accurate rendition of 
primary colours at the expense of 
some issues in the 16 shade inten-
sity test. F.E.A.R and Oblivion sport 
great detail and the effects and 
colour look really good on this 
monitor, and unless you’re in one 
of those shadowy areas the lack of 
contrast won’t be very noticeable. 
The lack of widescreen will annoy 
you when watching HD content, 
but the quality itself was satis-
factory. With a good webcamera 
adding value to an already good 
offering the only possible goof up 
could be the price. Rs 26,990 is too 
much to pay for a 19 inch, moni-
tor. Heck…its too much to pay for 
a 22-inch monitor. Enough said…

Dell 1908FP
Great stand meets mediocre screen

Its great build, combination of 
colours, excellent stand and 

height adjust, and the fact that 
it has a portrait mode are all 
facts that simply grab you by the 
throat and force you to accept 
this as a serious contender for 
your cash, if you happen to be 
shopping for a non-widescreen 19-
inch LCD. DisplayMate showcases 

some issues with contrast first 
and colours later. This monitor 
has issues with the shade inten-
sity tests, a testament to a medio-
cre TN panel behind the scenes. 
F.E.A.R had a good time thrashing 
this panel, although we must say 
the colours were rather good in 
the game, but the contrast (or lack 
of it!) will annoy you throughout. 
As with the PG191 movie watch-
ing isn’t recommended on a 
non-widescreen. There was also 
a slight issue with pixel response 
time as our movie tests revealed. 
At a price of Rs 14,000, the 1908FP 
offers a great number of features 
not seen on monitors this cheap. 

If only its performance was really 
great we’d have recommended it 
with our eyes closed. For now, it 
makes sense as a solution for an 
office or Internet PC.

HP L1950
More of the flexible stand

The L1950 is a hunk of a moni-
tor with a colossal stand that 

allows you to pivot and swivel 
and even orient it flat, face up. It’s 
got supreme build quality and a 
matte finish looks elegant, but to 
many the stand looks like a fold-
able plastic Eiffel Tower. Once cali-
brated on DisplayMate we noticed 
some good performance in the 

geometry and contrast tests. With 
a good showing of the primary 
and secondary colours the L1950 
even did reasonably well in the 
shade ramp tests making it suit-
able for professional users (image 
editing, rendering etc). The flex-
ibility of the stand means it can 
even be used by office goers for 
presentations of all sorts—decent 
viewing angles also help here. 
F.E.A.R was close to its atmospher-
ic best with baddies visible even 
in the depth of shadow, and the 
exteriors of Oblivion spring to vivid 
life. A good panel, suitable for all 
possible uses, the only bitter pill 
will be the price—Rs 17,500 which 
we feel is a couple of thousand 
more than an ideal price.

Intex IT1904W
Well built!

This one is making a second 
round over to our labs after 

last year. With an excellent stand, 
good build quality and a nice 
finish the aesthetics are well cov-

M ay  2 0 0 8



76 DIGIT May 2008

Digital Tools l LCD Test

77DIGIT May 2008

Digital Tools l LCD Test

ered. The menu system is strictly 
so-so, as are the buttons which 
feel tacky. We first saw issues 
with contrast under DisplayMate, 
where this monitor missed out on 

a lot of grey cards in the Intensity 
Range Check. Some issues with 
line and point shape tests in the 
geometry gamut of tests mean 
that professional users steer clear 
of this one. In games there’s a 
noticeable lack in contrast, par-
ticularly in F.E.A.R which is merci-
less with most mediocre LCDs. 
With mediocre performance in 
the movie tests the IT1904W cer-
tainly isn’t a bad performer, its 
just that there are too many indi-
vidual little flaws to really recom-
mend it, even at a sterling price 
of Rs 9,500.

LG W1952 TQ-PF
Fancy, but performance-free

A good looking monitor with 
a very slim bezel and com-

pact stand the W1952 TQ stands 
out because of its simplicity of 
design. It performs below par in 
the contrast ratio tests, and does 
a little better at the colour tests in 
DisplayMate. With barely accept-
able performance in F.E.A.R and in 
the movie tests particularly in the 

contrast and colour department, 
this monitor isn’t the best choice 
for multimedia aficionados. At Rs 
12,000 it’s a little too costly for 
the performance it offers…look 

elsewhere

LG W1942 T
Simply functional

The second monitor from LG in 
this category, and definitely as 

good looking. It’s built well too, 
and the menu system and but-
tons are very easy to work with. 
In DisplayMate we noticed some 
issues with contrast but it wasn’t 
as bad as its sibling. In the colour 
tests we noticed some issues with 

rendition of red, but this isn’t 
very noticeable in everyday use. It 
performed decidedly better in our 
gaming and movie tests—although 
we did notice some issues with 
contrast, especially in F.E.A.R and 
its shadowy environs. Priced at  
Rs 9,400 it’s cheaper than its sib-
ling, and better performing. Its 
one of those inexpensive purchas-
es that you can’t go wrong with, 
especially if you’re building any 
sort of home PC.

NEC MultiSync 1990 SX
A pricey welcome to S-IPS land

This LCD sports the only S-IPS 
panel we received and the 

industry grade build quality 
makes no bones about its focus 
audience. The matte black finish 
looks very boring on this monitor 
and the humongous stand doesn’t 
help. The stand is adjustable for 
height and pivots to portrait mode 
as well. The ultra slim bezel looks 
great. Calibrating this monitor 
proved easy, and aside from a cou-
ple of missing grey cards we could 
see them all. Colour rendition 
was excellent as is to be expected, 
and this monitor performed flaw-
lessly in the reverse text tests as 
well. When it comes to games 
like F.E.A.R this monitor excels at 
reproducing colour and contrast, 
no issues, except for a little pixel 
response lag courtesy the slower 
response time specification. It’s 
pretty decent for watching mov-
ies, but at Rs 42,000 you could buy 

a 32-inch TV for the same. It really 
shines for discerning profession-
als, but despite the astronomical 
performance we still feel it’s over-
priced by a good bit.

NEC MultiSync 1970NXP
Bulky Beast

Based around an MVA panel 
the 1970NXP is another bulky 

looking monitor like its costlier 
sibling. In DisplayMate whatever 
its sibling did it did with a little 
less performance. There was very 
little discernable performance 
gap in the contrast and geometry 
tests where both monitors excel, 
but in the colour tests we could 
make out a difference between 

the two which is where its costlier 
brother really earns its stripes. In 
games like F.E.A.R you’ll be able to 
play with all the detail available 
even in the darkest areas of the 
screen, and it outshines its excel-
lent sibling. It also sports excel-
lent viewing angles, the types TN 
panel based monitors can only 
dream about. At Rs 28,900 the 
1970NXP is excellent but sadly 
grossly overpriced. We reckon 
NEC needs to seriously look at its 
pricing of these brilliant moni-
tors in India—and as a result we 
cannot recommend the 1970NXP 

for anyone, including profession-
als for whom there are better 
choices as you will see.

Samsung 943NXW
Touch me!

Touch controls look so ooh!–
a pity they don’t work the 

same way, and we found a bril-
liant design, menu layout and 
fit and finish let down by quirky 
touch controls. In DisplayMate 
this panel proved to be a let-
down of sorts after their excel-
lent 2253LW—it misses out on a 
lot of the contrast, particularly 

with dark shades and intensely 
bright shades i.e. both opposite 
ends of the intensity spectrum. In 
movies we liked the fact that it’s 
widescreen, but the issue with 
contrast once again rears its ugly 
head. While gaming, we noticed 
shadows appearing as blotches 
at times—another contrast ratio 
issue. Priced at Rs 12,500, we feel 
it’s a bit too expensive for the 
performance. The only real thing 
this monitor has going for it is 
aesthetics. 

Samsung 953BW
Simple goodness

It’s not unusual to find a cheap-
er priced product that proves 

to be a better performer overall, 
so do perk up at this point. The 
953BW shares the same tasteful 
design of the 2253LW. Running 
DisplayMate first we noticed bet-
ter performance than its costli-
er sibling, and a contrast ratio 
that seemed anywhere between 
five and ten per cent better. 
DisplayMate decrees that this 
panel has issues with green on a 
grey and black background in the 
reverse text tests. Movie watch-
ing is fun on this monitor as was 
gaming, with a decent contrast 
ratio the overall experience while 
playing F.E.A.R was acceptable if 
not exemplary. At Rs 10,000 this 

953BW is cheaper than most of 
its 19-inch brethren and makes a 
good choice for anyone building 
a multimedia PC. Its looks will 
ensure it’s at home on a corporate 
desktop as well.

ViewSonic VA1912W
Old and going strong

This is another monitor from 
last years’ lot, and its age 

shows. Its very simple looking, 
archaic even, and hardly any-
thing about the build quality will 
inspire or appeal. A few minutes 
into DisplayMate’s tests revealed 
some geometry issues in the line 
and point shape and visibility 

tests. Next up, the contrast ratio 
was something that we felt could 
improve a good bit. It ran through 
the colour gamut tests without 
serious incident, but not without 
a couple of incidents in the 16 
shade ramp test and the colour 
purity tests. For gaming this mon-
itor is a mixed bag—it has decent 
colours, although not as good as 
the Samsung 953 BW, and while 
the contrast ratio is also inferior 
to the 953BW it’s not totally unac-
ceptable. This scenario is identical 
for movies. At Rs 9,650, it is cheap, 
but not as cheap as the identical 
performing LG W1942T, though 
you could pay four hundred 
rupees more for something much 
better (the Samsung 953BW).

ViewSonic VX1940W
When new isn’t good

This is a newer monitor, but 
doesn’t feel as solid in build as 

its older sibling. It has that built-
to-a-budget feel and look to it. 
Neck deep in DisplayMate’s geom-
etry tests we had some issues with 
the point and line tests, and later 
with the contrast tests where, try 
as we might, we couldn’t spot 

much of the grey cards in a black 
background in the Intensity Range 
Check tests. In the colour tests, we 
ran into some problems with the 
16 and 64 shade tests, where the 
monitor kept missing out on cer-
tain intensities especially at the 
brighter-end of things. Gaming 
isn’t the experience we wanted it 
to be, not that this was unexpect-
ed, considering the performance 
in DisplayMate. Movies also 
show a contrast issue, although 
the colours aren’t too bad. At  
Rs 10,650 the VX1940W isn’t the 
cheapest monitor around, nor is 
it the best performing. The fact 
that the cheaper Samsung 953BW 
outshines it in nearly every test 
is reason enough to stay away 
from it.

20 inch LCD monitors
Middlemen

BenQ T201WA
Plain Jane, but a good pane

The T201WA has a nicely curved 
front bezel that immediate-

ly looks Jurassic because of its 
width. Finished in silver, the lar-
gish buttons in a neat row work 
well, but look and feel tacky. The 
large stand with curved sides is 
square and appears squat, wheth-
er its okay looking or downright 
ugly is up to you to decide. First 
up DisplayMate ran into issues 
during calibration, where the 
Intensity Range Check lost a lot 
of grey cards. While adjusting 
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brightness helped reveal more, the 
background was no longer black. 
Next up, the colour tests revealed 
slight tonal imbalance, which we 
must say plagued nearly all the 
TN panel-based LCDs, regardless 
of whether we’ve individually 
mentioned this or not. F.E.A.R saw 
some contrast issues, and a couple 
of issues of discolouration with 
certain darker hues like purple 
shadows, but overall nothing out 
of the ordinary. Both the games 
were sufficiently detailed and 
showed good overall effects. Our 
movie tests fared slightly better, 
and aside from a slight issue with 
insufficient contrast there were 
no other complaints. For Rs 10,500 
the T201WA is cheap enough for a 
good home PC, or a multimedia 
and gaming PC, as long as you’re 
not too discerning about qual-
ity. Its good build and typically 
industrial bulky looks will stand 
tall in the corporate environment 
as well. 

Dell SP 2008 WFP
Features, looks and value—a rare 
combination

Looking exactly like its ‘larger by 
two inches’ brother, the SP 2008 

WFP is a handsome monitor, and 
aside from the lack of an HDMI 
port has the same connectivity, 
build, and features. Sadly it’s once 
again a glossy TN panel, albeit 
an excellent one. DisplayMate had 
minor issues with contrast on this 
panel. In fact we missed on a num-
ber of darker cards in the Intensity 
Check. Geometry tests were com-
pleted without any compliant, and 
even the reverse text tests went 
well. There were some issues with 
colour, but they weren’t major, 
and mostly centred around its abil-
ity to produce certain intensities 
of green. The reds and blues were 
spot on. It did well in the gaming 
and movie tests proving its mettle 
as a serious multimedia option. 
The price of Rs 12,700 makes the 
SP 2008 WFP excellent value for 

money and a terrific deal for any 
kind of audience. We’d just like 
a couple of quirks worked out—
something both 20- and 22-inch 
siblings share.

 
Samsung 2053BW
Bordeaux’s baby boy

A matte panel, a monitor 
with a body that can only 

be described as hot—the kind of 
hot that brings cold shivers of 
anticipation. Add to this exem-
plary build quality and you’ve 
got the 2053BW. DisplayMate was 
rather kind to this monitor and 
aside from the usual contrast 
issues (although not severe) the 

geometry tests were a breeze. The 
2053BW handles colours well, it’s 
just not able to produce many 
more than its 6-bit TN panel’s 
theoretical limit. Gaming is good 
on this monitor, and aside from 
the lack of contrast in some of the 
darkest areas of F.E.A.R it did well 
accurately reproducing all special 
effects, particle effects and explo-
sions. The world of Tamriel comes 
to vivid life in Oblivion. With a 
good showing in the movie test 
as well, this monitor makes a 
good buy, except that its priced 
a little stiffly—Rs 14,500 is a little 
too much with the SP 2008 WFP 
breathing down its neck with 
identical performance at a lower 
price. The 22-inch panels are also 

similarly priced, and two inches 
of real estate more for the same 
amount is a steal as well.

Samsung 2043 NXW
A touchy case

This is 2053BW’s smaller 
brother in terms of price, but 

retaining the build quality and 
looks, and adding a touch control 
system that is quirky at times. A 
quick initial run of DisplayMate 
revealed issues beyond what its 
sibling had. We didn’t get the full 
colour gamut, with noticeable 
flaws, and the contrast test was 

just above what we’d consider 
acceptable. It has the same 
quality at geometry though. In 
gaming, the issue of contrast will 
be noticeable, although not quite 
so in movies, where for some 
reason we couldn’t find much 
to gripe about. At Rs 12,500, it’s 
cheaper than its sibling, but a let 
down in most other ways. We’d 
recommend shelling out Rs 2,000 
more and crying once, instead 
of pinching your pockets and 
crying later.

17-inch LCD Monitors
Minnows 

Acer X173W
Featherweight pushover

Its light, with mediocre yet 
acceptable build quality. The 

lack of DVI is an annoyance as 
are the eyesore buttons—large 
and ugly, the lower bezel pouts at 
you like a puffy lip. DisplayMate 
was its unkind self, and the little 
Acer huffs to keep up with the 
contrast and colour tests. It does 
manage to pass, though by a 
hairsbreadth. In games, the lack 
of an adequate contrast is notice-
able. At Rs 8,500 the X173W is a 
good entry level monitor, suit-
able for a home PC and Internet 
use. Don’t expect too much from 
this 17-inch, though.

Dell 1708FP
A better stand we never did see

As the title says for a 17-inch 
monitor this one has a superla-

tive stand that allows swivel, pivot 
and height adjustment, as well 
as portrait mode. Build quality is 
excellent too. It does have its fair 
share of problems, courtesy yet 
another TN panel, where a poor 
contrast ratio was 
seen in DisplayMate 
first, and F.E.A.R 
later. The fact that 
it’s not a wide-
screen doesn’t make 
it any better, and 
the contrast ratio 
doesn’t help either. 
We were some-
what mollified by the price (Rs 
11,500) which makes it a slight-
ly better option than the Acer 
X173W, since it outperforms it by  
10 per cent.

HP L1710
A tad too expensive

The L1710 looks  iden-
tical to the L2208W 

except it’s not a wide-
screen monitor. 
It has decent 
p e r f o r m a n c e 
in DisplayMate, 
although the 
colour and con-

trast issues still remain. 
We did notice some seri-
ous discrepancies in the 
colour tests—particularly 
the 16-shade ramp test. In 
games and movies it per-

formed sub-par—a pity, because 
we expected more, especially  
for Rs 9,593. 

Intex 1707 WBLK
Dances with wind 

The L1707 is a good looking 
monitor featuring a glossy 

panel. Unfortunately, it took three 
minutes under our ceiling fan for 
us to realise this monitor actually 
shakes with a little breeze—cour-
tesy a flimsy plastic stand, unlike 
its 19-inch sibling, which had a 
full metal stand. Performance 
was nothing worth writing home 
about, but we noticed no real issues 
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except the usual niggles with con-
trast and colour which plagued 
us throughout DisplayMate and 
occasionally during our game and 
movie tests. At Rs 8,500 it’s simi-
larly priced to the X173W from 
Acer, so we recommend you give 
this one a wide berth.

LG L177 WSB-PF
Value-oriented all-rounder

A neat-looking LCD with solid 
build quality. This was one 

of the only monitors to who 
DisplayMate was really kind 
throughout the tests, although 
we did notice issues with con-
trast and some minor issues 
with point shape and visibility 
in the geometry tests. While 
gaming, this monitor performs 
decently, except when a good 
contrast ratio is called for. This 
was one of the only 17-inch 
monitors on which Oblivion 
looked glorious. If you’re look-
ing for an all rounder in this 
size category you’ve just found 
it—at just Rs 8,500.

NEC 1770NX-BK
The weakest link

Sporting the same kind of 
build quality that we saw on 

the larger 19-inch NEC moni-
tors, the 1770NX immediately 
ran into issues with contrast 
in DisplayMate—nearly half of 
our grey cards were indistin-
guishable from black. In the 
colour tests, for some weird 
reason, the 16-shade intensity 
ramp had serious issues with 
the four brightest intensities 
in the colour green, and with 
the three brightest intensi-
ties in the colours red and 
blue where the shades looked 
the same—a shame for this 
monitor. In games the con-
trast ratio was noticeable 
although the colour issue was 
only apparent with games. At  

Rs 18,900 nobody is going to 
lose any sleep over whether to 
purchase this monitor or not, 
so we’ll leave it at that.

Samsung 732NW
We’d like to imagine a lot more

A compact and cute monitor, 
the 732NW is built well. 

It’s a mediocre performer as 
DisplayMate revealed in the 
colour and contrast tests, 

although to its credence the 
geometry tests were cleared 
without incident or hiccup. In 
F.E.A.R, it got the usual criti-
cism we’ve levelled against 
most panels—a poor contrast 
ratio, and lower brightness. At 
Rs 8,850 it’s a little expensive 
to recommend.

ViewSonic VA1716W
For crying out loud!

ViewSonic’s 17-inch offering 
has a plasticy body, devoid 

of any of the fancy glossy mate-
rials we’re used to seeing. We 
ran into problems at every step 
of our test—the first stop being 

DisplayMate, where the poor 
contrast became apparent. Also 
the geometry tests, normally 
a breeze for most LCDs were a 
pain here, we had issues with 
line and point resolution.

Then came the colour tests 
and (sigh) by this time we 
nearly gave up—the perfor-
mance in the shade ramp tests 
was terrible particualrly with 
the 256 shade ramp, where 
this monitor is not capable of 
many variations in intensity of 
the same colour.

Needless to say it’s not very 
suitable at gaming and mov-
ies too. Neither is the text 
rendition as clear as other 

monitors. Performance doesn’t 
come cheap, a known anal-
ogy, but its corollary is also 
true—what you don’t pay for, 
you don’t get.

24-inch LCD Monitor
Coming soon…to an affordable 
price near you

LG 246Wp
A colossus of expletives

When we saw this giant 
screen we knew we had 

something special. It’s heavy, 
has a huge stand and allows 
the screen to swivel for a por-
trait mode. Portrait mode is 
never more apparent than on 
a huge widescreen—where the 
screen size is larger than an A3 
sheet of paper.

The thickness of the outer 
casing and the amount of heat 
dissipated by the panel told us 
that this was either an MVA or 
a PVA panel.

In fact, this is a P-MVA 
panel. Calibrating it wasn’t 
easy, since keeping yourself 
at eye-level with such a large 
screen is nearly impossible. 

In DisplayMate, we saw 

strong contrast, and a lot of 
grey cards were visible with 
a really black background—a 
good showing for contrast for 
this panel. In the colour tests 
we saw an accurate rendition 
of red and blue with only a 
slight issue in the 256 shade 
ramp test for the colour green.

In our movies test we got 
to experience the full glory of 
1080p, and this monitor han-
dled colour and contrast very 
well. Only in F.E.A.R did we 
see a little issue with contrast, 
but this was only in one or 
two areas. Oblivion looks gor-
geous at 1920 x 1200 pixels, 
and you’ll be as mesmerised 
as we were. With a price tag 
of Rs 28,000 this monitor may 
seem expensive, but that’s 
before you consider the qual-
ity of the panel inside, and 
the extra functionality that the 
stand gives you. It makes for a 
terrific gaming or multimedia 
monitor—just make sure your 
graphics card can handle the 
large resolutions you want.

Closing Thoughts
Though newer models are being 
introduced around twice a year, 
there’s hardly any difference in 
terms of quality—larger screens 
are getting cheaper, but they’re 
hardly getting better.

Sure, features like HDMI and 
other connectivity and orien-
tation options  have become 
cheaper, but the biggest factor—
quality—essentially remains the 
sole dominion of costlier pan-
els. So while the common user 
has a plethora of ever-changing 
options the discerning buyer is 
stuck at a crossroad—does he 
go cheap or does he pay signifi-
cantly more for something that 
is noticeably better?

This is a question which 
manufacturers should be made 
to answer. n

michael.browne@thinkdigit.com

Needs Suggestions We Say Price Range

A basic LCD monitor for an 
Internet/home PC

LG L177 WSB-PF Decent colours and contrast, a good entry level monitor Rs 8,500

A high-end LCD for gaming 
and full 1080p HD content

LG L246Wp Based on an 8-bit P-MVA panel, this 1920x1200 pixel 
resolution sporting panel is just what the doctor ordered. 
With connects galore and a sterling build quality, a stand 
that lets you swivel in and out of portrait mode, and even 
adjust the height, this is a steal

Rs 28,000

High-end multimedia and 
gaming on the cheap

Dell SP 2208 WFP With an integrated 2.0 megapixel webcamera, HDMI port 
and a great panel with stunning contrast and colours this 
monitor is a steal at the price it commands

Rs 15,386

A non glossy panel, some-
thing that offers a good 
dose of performance and is 
well priced

Samsung 2253LW This monitor even outperforms the Dell, and is better for 
a matte panel that cuts down on reflection. Very good for 
gaming and movies, the price is a on the high side

Rs 17,500

A professional grade moni-
tor with spot on colour and 
geometry rendition

NEC MultiSync 1990 
SX

An 8 bit S-IPS panel doing duty inside just says it all, excel-
lent colour rendition, perfect for image editing profession-
als. Very costly, keep fingers crossed for a price drop

Rs 42,000

A decent 19-inch monitor 
for home usage, with some 
multimedia performance

Samsung 953 BW / 
Dell 1908 FP

Both these monitors are different beasts. The Dell is a 
regular panel while the Samsung is a widescreen. They’re 
both excellent for the price though.

Rs 9,899—10,000

 Buying Guide

Contact Sheet        LCD Monitors
Brand Company Name Phone Numbers Email Website
Acer Acer India Pvt. Ltd. 080 25219520 Balaji_A@acer.co.in www.acer.co.in
AOC Top Victory Technology Group. +91-124-280 6116/17 & +91-80 41122 335 info@in.aocmonitor.com www.aoc.com
Asus ASUS Technology Pvt. Ltd 022-67668800 Media_india@asus.com http://in.asus.com
BenQ Neoteric,esys 1-800-22-0808 sales.enquiryin@BenQ.com www.benq.co.in
Dell Dell India Pvt. Ltd 1800-425-4026 dell_enquiries@dell.co.in www.dell.co.in 
HP HP India 0124-2566111 rakesh.balachandran@hp.com www.hp.com /in
Intex Intex Technologies (India) Ltd. 1800116789 info@intextechnologies.com www.intextechnologies.com 
LG LG Electronics India Pvt. Ltd.  91-120-2560900/940 sanjoyb@lgindia.com www.lgindia.com
NEC NEC India Pvt Ltd 011-46570000 enquiries@necindia.in www.nec-pj.com
Samsung Samsung India Electronics Pvt. Ltd. 011-41511234 rengith.nair@samsung.com www.samsung.com/in
ViewSonic Roop Technology Pvt. Ltd. 022- 26681921 sales@rooponline.com in.viewsonic.com
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19 - i n c h LCDs
Brand   
Model

Acer
X173W

Dell
1708 Fp

HP
L 1710

Intex  
1707 WBLK

LG
L 177 WSB-PF

NEC
1770 NX-BK

Samsung
732 Nw

 ViewSonic
VA 1716W

AOC
913 FW

AOC
917 VW

ASUS
PG 191

Price Rs 8,500 Rs 11,500 Rs 9,593 Rs 8,500 Rs 8,500 Rs 18,900 Rs 8,850 Rs 8,400 Rs 9,600 Rs 9,600 Rs 26,990

Plus (+) Compact, 
lightweight

Great Features Well Built Looks neat Decent Performer Build Quality Neat Looks Lightweight Unique Stand Built well Great Build Quality

Minus (-) Lacks DVI Contrast Colour 
performance

Light, Flimsy Stand None in particular Lower Performance Quirky touch 
buttons

Poor colour 
rendition

Lacks performance Lacks performance Quirky touch 
buttons

Grand Totals (Out of 100) 45.14 61.36 44.07 46.35 46.16 46.89 44.06 42.96 46.55 55.03 55.35

Features (Out of 45) 10.82 25.65 10.62 12.96 11.03 14.11 10.80 10.64 11.07 19.94 19.67

Performance (Out of 55) 34.32 35.71 33.45 33.39 35.13 32.78 33.26 32.31 35.48 35.09 35.68

Features

Pixel Pitch (mm) 0.264 mm 0.264 mm 0.264 mm 0.290 mm 0.250 mm 0.264 mm 0.255 mm 0.255 mm 0.285 mm 0.284 mm 0.294 mm

Luminance (Cd/m2) 250 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 250 Cd / m2 250 Cd / m2 250 Cd / m2 250 Cd / m2  300 Cd / m2 300 Cd / m2 300 Cd / m2

Contrast Ratio 1000:1 800:1 800:1 500:1 700:1 500:1 600:1 500:1 800:1 800:1 800:1

Type of Panel 
(TN/S-IPS/MVA/PVA etc)

TN TN TN TN TN MVA TN TN TN TN TN

Native Resolution / 
Aspect Ratio

1440 x 900 pixels 
/ Wide

1280 x 1024 pixels 
/ Normal

1280 x 1024 pixels 
/ Normal

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1280 x 1024 pixels 
/ Normal

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1280 x 1024 pixels 
/ Normal

Number of Colours (Millions) 16.2 Million 16.7 Million 16.7 Million 16.2 Million 16.2 Million 16.2 Million 16.2 Million 16.7 Million 16.2 Million 16.7 Million 16.2 million

Response Time in milliseconds 8 ms (GTG) 5 ms (R+F) 5 ms (R+F) 16 ms 8 ms (R+F) 12 ms (R+F) 8 ms (R+F) 8 ms (R+F) 5 ms (R+F) 5 ms (R+F) 8 ms (R+F) / 2 ms 
(GTG)

USB Hub / No of Ports N/NA Y/4 N/NA N/NA N/NA Y/4 N/NA N/NA N/NA N/NA Y/3

Card Reader / Cards 
Supported

N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA

Built-in Speakers / Output 
(RMS) / Quality (Scale of 10)

N/NA/NA N/NA/NA N/NA/NA Y/4 watts/3.5 N/NA/NA N/NA/NA N/NA/NA N/NA/NA N/NA/NA N/NA/NA Y/10/7.75

VESA Wall Mount Y Y Y Y N Y Y Y Y Y Y

Swivel Base  
(Vertical/Horizontal Axis)

Vertical Vertical/Horizontal Vertical Vertical Vertical Vertical/Horizontal Vertical Vertical Vertical Vertical Vertical

Height Adjustment / 
Portrait Mode (Y/N)

N/N Y/Y N/N N/N N/N Y/Y N/N N/N N/N N/N N/N

HDCP Support (Y/N) N Y N N N N N N N Y N

Input Interfaces D-Sub D-Sub, DVI D-Sub D-Sub D-Sub D-Sub D-Sub D-Sub D-Sub D-Sub, DVI D-Sub, DVI

Extra Features NA NA N N N N N N N N Webcam

Miscellaneous (Scale of 10)

Bezel Thickness 6.25 6.5 6 6 6.75 6.75 6.25 7.5 7.5 7.5 6.75

Quality Of Moving Parts 7 7 6.5 6.5 7 7.5 6.75 6.25 7.25 7.25 8

OSD Usability 7.25 7.5 7.5 6.5 7.5 7.75 7.5 7.25 7 7 6

Performance (All Scale of 10)

Displaymate

Sharpness And Resolution

Image, Line Resolution  
and Point Shape Tests

6.42 6.50 6.17 6.00 6.33 6.42 6.00 5.75 6.50 6.33 6.58

Moiré Tests 6 6.5 6 6.5 6.5 6.25 6 6.5 6.5 6.5 6.5

Colour And Grayscale

Streaking And Ghosting 6.25 6.5 6.0625 6.125 6.25 6.125 6.0625 6.25 6.625 6.4375 6.5

White Level / Black Level Shift 6.25 / 6 6.5 / 6.5 6.5 / 6.25 6.25 / 6.25 7 / 7 6 / 6.5 6.5 / 6.5 6.25 / 6 6.5 / 6.25 6.5 / 6.25 6.75 / 6.75

RGB Colour Purity Tests 6.5 6.75 6.5 6 6.5 6.25 6.25 6 6.75 6.75 6.5

Colour Text Tests 6.25 6.5 6.25 6 6.25 5.75 6.25 6.25 6.5 6.5 6.5

16 Intensities Levels 6 6.5 5.75 6 6 4 5.75 5 6.5 6.25 6.25

64 Intensity For Primary /  
Secondary Colours

6 / 6 6.5 / 6.5 6 / 6 5.75 / 6 6 / 6.25 5.25 / 5 6 / 5.75 5.25 / 5.25 6.25 / 6.25 6.25 / 6.5 6.5 / 6.25

256 Colour Ramp Test 5.75 6.5 6 5.5 6.25 5.75 6 4.75 6 5.75 6

Multimedia / Games

HD Video Clip Pixel 
Persistence /  Colour / 
Contrast

6.42 6.42 6.33 6.25 6.67 6.00 6.17 5.75 6.42 6.42 6.67

HD Video Clip Overall 6 6.25 6 6 6.5 5.75 6 5.75 6.25 6.25 6.5

F.E.A.R 6.6 6.55 6.2 6.25 6.4 6.3 6.2 6.3 6.6 6.45 6.55

Oblivion 6.42 6.58 6.08 6.33 6.67 6.42 6.00 6.33 6.58 6.50 6.67

Viewable Angle (Text / Movie) 6 / 6 6.5 / 6.25 6 / 5.5 6 / 6 6.25 / 6.25 6.25 / 6 6 / 5.75 6 / 6 6.5 / 6.25 6.5 / 6.25 6.25 / 6.25

  17-inch LCDs
M ay  2 0 0 8 M ay  2 0 0 8
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Brand   
Model

Dell
1908 FP

HP
L 1950

Intex
IT 1904 W

LG
W 1952 TQ-PF

                LG
          W 1942 T

NEC
MultiSync 1990 SX

NEC
MultiSync 1970 NXP

Samsung
943 NXW

Samsung
953 BW

ViewSonic
VA 1912 wb

ViewSonic
VX 1940 w

Price Rs 14,000 Rs 17,500 Rs 9,500 Rs 12,000 Rs 9,400 Rs 42,000 Rs 28,900 Rs 12,500 Rs 10,000 Rs 9,650 Rs 10,650

Plus (+) Great Stand and 
Build

Good build quality Great Stand, looks Sleek, Compact Sleek, compact Great performance Good performance Neat Looks Decent performer Compact Built Well

Minus (-) Mediocre Contrast Pricey Mediocre performer Slightly expensive None in particular Very Costly Very Costly Quirky touch buttons None in particular Build Quality Poor colour 
performance

Grand Totals (Out of 100) 61.27 63.73 48.41 46.23 46.59 59.29 56.06 45.87 52.44 47.97 53.73

Features (Out of 45) 25.74 26.33 13.59 11.61 11.79 18.52 16.22 10.67 16.65 13.10 19.13

Performance (Out of 55) 35.53 37.40 34.82 34.62 34.80 40.77 39.83 35.20 35.79 34.87 34.61

Features

Pixel Pitch (mm) 0.294 mm 0.294 mm 0.283 mm 0.283 mm 0.283 mm 0.294 mm 0.294 mm 0.258 mm 0.284 mm 0.285 mm 0.248 mm

Luminance (Cd/m2) 300 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 250 Cd / m2 250 Cd / m2 300 Cd / m2 300 Cd / m2 280 Cd / m2 300 Cd / m2

Contrast Ratio 800:1 800:1 700:1 800:1 800:1 800:1 800:1 800:1 800:1 700:1 1000:1

Type of Panel 
(TN/S-IPS/MVA/PVA etc)

TN TN TN TN TN S-IPS MVA TN TN TN TN

Native Resolution /
Aspect Ratio

1280 x 1024 pixels / 
Normal

1280 x 1024 pixels / 
Normal

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1280 x 1024 pixels / 
Normal

1280 x 1024 pixels / 
Normal

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

1440 x 900 pixels 
/ Wide

Number of Colours (Millions) 16.7 Million 16.7 Million 16.7 Million 16.7 Million 16.2 Million 16.77 Million 16.77 Million 16.2 Million 16.2 Million 16.2 Million 16.7 Million

Response Time in milliseconds 5 ms (R+F) 5 ms (R+F) 8 ms (R+F) 2 ms (GTG) 5 ms (R+F) 8 ms (GTG) 20 (R+F) 2 ms (GTG) 2 ms (GTG) 5 ms (R+F) 5 ms (R+F) / 2 ms 
(GTG)

USB Hub / No of Ports Y/4 N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA

Card Reader / 
Cards Supported

N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA

Built-in Speakers / Output (RMS) / 
Quality (Scale of 10)

N/NA/NA N/NA/NA Y/4 watts/2.5 N/NA/NA N/NA/NA N/NA/NA N/NA/NA N/NA/NA N/NA/NA Y/2 watts/2.5 N/NA/NA

VESA Wall Mount Y Y Y Y Y N Y Y Y Y Y

Swivel Base
(Vertical / Horizontal Axis)

Vertical/Horizontal Vertical/Horizontal Vertical Vertical Vertical Vertical Vertical/Horizontal Vertical Vertical Vertical Vertical

Height Adjustment / 
Portrait Mode (Y/N)

Y/Y Y/Y N/N N/N N/N Y/Y Y/N N/N N/N N/N N/N

HDCP Support (Y/N) Y Y N N N N N N Y N Y

Input Interfaces D-Sub, DVI D-Sub, DVI D-Sub D-Sub, DVI D-Sub, DVI D-Sub, 2 x DVI, 
S-Video

D-Sub, DVI D-Sub D-Sub, DVI D-Sub D-Sub, DVI

Extra Features N Flat orientation N N N N N N N N N

Miscellaneous (Scale of 10)

Bezel Thickness 7 6.25 6.75 6.5 7.5 8 8 7 6.75 6 6

Quality Of Moving Parts 7 7.5 7 7 7 7.75 7.75 6.25 6.25 6.5 6.5

OSD Usability 7.5 7 6.5 7.5 7.5 7.75 7.75 7.5 7.5 7 7

Performance (All Scale of 10)

Displaymate Video Edition

Sharpness And Resolution

Image, Line Resolution 
And Point Shape

6.50 6.67 6.42 6.58 6.42 7.08 6.83 6.42 6.42 6.25 6.25

Moiré Tests 6.5 7.25 6.5 6.25 6.25 7.25 7 6.5 6.75 6.25 6

Colour And Grayscale

Streaking And Ghosting 6.375 6.6875 6.375 6.1875 6.4375 6.875 6.6875 6.5 6.1875 6 6

White Level / Black Level Shift 6.5 / 6.5 7.25 / 7.25 6.25 / 6.25 6.5 / 6.5 6 / 6 7.5 / 7.5 7.25 / 7.25 5.75 / 5.75 6.25 / 6 5.75 / 6.25 5.75 / 6

RGB Colour Purity 6.75 7 6.5 6.25 6 8 7.25 6 6.5 6.5 6.75

Colour Text 6.5 7 6.5 6.5 6.25 7.5 7.25 6.25 6.5 6.75 6.5

16 Intensities Levels 6.5 6.75 6.25 6 6.25 7.75 7.5 6.25 6.5 6.5 6.5

64 Intensity For Primary / 
Secondary Colours

6.5 / 6.5 6.75 / 6.75 6 / 6 6.25 / 6.25 6.25 / 6 7.75 / 7.75 7.25 / 7.25 6.5 / 6.5 6.5 / 6.5 6.25 / 6.25 6.25 / 6

256 Colour Ramp Test 6 7 6 6 6.25 8 7.5 6.25 6.5 6 6

Multimedia and Game Tests (So 10)

HD Video Clip Pixel Persistence / 
Colour / Contrast

6.42 6.67 6.58 6.33 6.25 7.00 6.83 6.58 6.58 6.42 6.33

HD Video Clip Overall 6.25 7 6.5 6.5 6.5 7 7 6.5 6.75 6.5 6.5

F.E.A.R 6.55 6.9 6.3 6.4 6.25 7 7.2 6.45 6.6 6.4 6.4

Oblivion 6.58 6.67 6.50 6.58 6.58 7.58 7.58 6.58 6.75 6.58 6.58

Viewable Angle (Text / Movie) 6.5 / 6.25 6.75 / 6.5 6.25 / 6 6 / 6 6.5 / 6.5 8.25 / 7.75 8 / 7.75 6.5 / 6.25 6.5 / 6.5 6.5 / 6.25 6.25 / 6.25

  19-inch LCDs
M ay  2 0 0 8
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Brand   
Model

BenQ
T201W

Dell
SP 2008 WFP

Samsung
2053 BW

Samsung
2043 NWX

Dell
SP 2208 WFP

Samsung
SyncMaster 2253LW

HP
 L2208w 

AOC
2217 Pwc

ViewSonic
Va 2216W

ViewSonic
VX 2255WM H2

LG
L246 Wp

Price Rs 10,500 Rs 12,700 Rs 14,500 Rs 12,500 Rs 15,386 Rs 17,500 Rs 18,500 Rs 16,000 Rs 13,500 Rs 15,500 Rs 28,000

Plus (+) Built Well Great looks and Build Well Built, Neat looks Decent performer Excellent Value,
Great performance

Good performance Attractive looks Decent Looks Decent Performance Neat Looks, good 
performance

Great performance and 
Build

Minus (-) Dated Looks Glossy panel Slightly costly Quirky touch panels Glossy panel Slightly Expensive Mediocre Performance Bulky Stand Build Quality Mediocre Build quality Bulky, Slightly expensive

Grand Totals (Out of 100) 45.21 61.64 55.40 48.00 64.30 58.99 47.07 60.44 54.10 57.90 69.21

Features (Out of 45) 9.95 23.27 17.28 11.21 25.83 20.48 11.43 25.47 18.61 21.35 29.86

Performance (Out of 55) 35.27 38.38 38.12 36.80 38.47 38.51 35.64 34.97 35.49 36.55 39.35

Features

Pixel Pitch (mm) 0.258 mm  0.258 mm 0.258 mm 0.258 mm 0.282 mm 0.276 mm 0.282 mm 0.277 mm 0.282 mm 0.270 mm 0.270 mm

Luminance (Cd/m2) 250 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 300 Cd / m2 Cd / m2 280 Cd / m2 500 Cd / m2 500 Cd / m2

Contrast Ratio 1000:1 1000:1 1000:1 1000:1 1000:1 1000:1 1000:1 1000:1 700:1 1000:1 1000:1

Type of Panel (TN/S-IPS/MVA/PVA etc) TN TN TN TN TN TN TN TN TN TN P-MVA

Native Resolution (H. Pixels x V. Pixels) / Aspect 
Ratio

1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1680 x 1050 pixels / Wide 1920 x 1200 pixels / Wide

Number of Colours (Millions) 16.2 Million 16.7 Million 16.7 Million 16.7 Million 16.7 Million 16.7 Million 16.2 Million 16.7 Million 16.7 Million 16.7 Million 16.7 million

Response Time in milliseconds (Gray To Gray) 5 ms (R+F) 2 ms (GTG) 2 ms (GTG) 5 ms (R+F) / 2 ms (GTG) 2 ms (GTG) 5 ms (R+F) / 2 ms (GTG) 5 ms (R+F) 5 ms (R+F) 5 ms (R+F) 5 ms (R+F) / 8 ms (GTG) 8 ms

USB Hub (Y/N) / No of USB Ports N/NA Y/4 N/NA N/NA Y/4 N/NA N/NA Y/3 N/NA N/NA Y/2

Card Reader (Y/N) / Types of Memory Cards 
Supported

N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA N/NA

Built-in Speakers (Y/N) Output (RMS) / Quality 
(So 10)

Y/2 watts/3.75 N/NA/NA N/NA/NA N/NA/NA N/NA/NA N/NA/NA N/NA/NA Y/4 watts/3 Y/4 watts/3 Y/4 watts/3 Y/6 watts/3.5

VESA Wall Mount Y Y Y Y Y Y Y Y Y Y Y

Swivel Base (Vertical/Horizontal Axis) Vertical Vertical Vertical Vertical Vertical Vertical Vertical Vertical Vertical Vertical Vertical

Height Adjustment / Portrait Mode (Y/N) N/N N/N N/N N/N N/N N/N N/N N/N N/N N/N Y/Y

HDCP Support (Y/N) N Y Y N Y Y N Y Y Y Y

Input Interfaces (D-Sub/DVI/Component/S-
Video/ HDMI)

D-Sub D-Sub, DVI D-Sub, DVI D-Sub D-Sub, DVI, HDMI D-Sub, DVI D-Sub D-Sub, DVI D-Sub, DVI D-Sub, DVI D-Sub, Component, HDMI

Extra Features If Any (WebCam, Ipod dock etc) N Integrated Webcam N N Integrated Webcam NA NA Integrated Webcam NA Integrated Webcam NA

Miscellaneous (So 10)

Bezel Thickness 6.25 7.75 7.25 7 8 7.75 7.5 7.5 7 7 7.75

Quality Of Moving Parts 6 8 7.25 7.25 8 7.75 7.5 7.5 7 7.25 7.75

OSD Usability 6.5 7.5 7.5 7.5 7.5 7.5 7.5 7.5 7.25 7.25 7.25

Performance

Displaymate Video Edition  (So 10)

Sharpness And Resolution

Image, Line Resolution and Point Shape Tests 
(Avg Score)

6.33 6.42 6.67 6.33 6.50 6.50 6.42 6.42 6.25 6.42 6.67

Moiré Tests 6.25 6.75 6.75 6.25 6.75 6.5 6.5 6.5 6 6.5 6.75

Colour And Gray-Scale

Streaking And Ghosting Tests (Avg Score) 6.25 6.625 6.5625 6.4375 6.6875 6.625 6.25 6.4375 6.375 6.4375 6.6875

White-Level/Black Level Shift 6.5 / 6.25 6.75 / 7.25 7.5 / 7.25 6.75 / 6.25 7 / 7 7 / 7 7 / 7 6.5 / 6.5 6.25 / 6.25 6.5 / 6.5 6.75 / 6.75

RGB Colour Purity Tests 6.5 7.25 6.75 6.25 7.25 7.25 6.75 6.5 6.5 7 7

Colour Text Tests 6 7 7 7 7 7.25 7.25 6.75 6.25 7 7.25

16 Intensities Levels 6.25 6.25 6.5 6.5 6.25 6.75 6.5 3.25 6.5 6.5 7

64 Intensity For Primary Colours / Secondary 
Colours

6.75 / 6.25 6.5 / 6.5 6.25 / 6.5 6.25 / 6.25 6.5 / 6.5 6.5 / 6.5 6.25 / 6 5.75 / 5.75 6 / 6 6.25 / 6.25 7.25 / 7

256 Colour Ramp Test 6.25 6.5 6.5 6.25 6.25 6 5.75 5 6.25 6.25 7.25

Multimedia and Game Tests (So 10)

HD Video Clip Pixel Persistence/ Colour / 
Contrast

6.42 7.00 7.00 6.50 7.08 7.00 6.33 6.42 6.25 6.42 6.83

HD Video Clip Overall Viewing Experience 6.5 7.25 7.25 7 7.25 7.25 6.5 6.5 6.25 6.5 7.25

F.E.A.R (Pixel Response, Effects, HDR, Contrast) 6.4 7.3 7.1 6.95 7.2 7.25 6.8 6.8 6.7 6.85 7.25

Oblivion (Texture Quality, HDR, Transparency) 6.50 7.42 7.33 7.17 7.67 7.58 6.92 7.17 6.83 6.83 7.42

Viewable Angle Test (Text / Movie) 7 / 6.5 7.5 / 7.5 7.25 / 7.25 7.25 / 7.25 7.5 / 7.5 7.5 / 7.5 6.25 / 6 7 / 7 7 / 6.75 7.25 / 7 8.25 / 8

  20-inch LCDs   24-inch LCD

A P R I L  2 0 0 8

M ay  2 0 0 8 M ay  2 0 0 8
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You’ve just upgraded your 
ancient PC—got the fastest 
processor, truckloads of 

memory and the best graphics 
card on the market. 

But before you can really 
enjoy the power and speed of 
your new PC, you will wake up to 
the realisation that there is hard-
ly any space left on your mod-
est hard drive! Games, music, 
movies, HD clips, e-books—all 
this eats into that precious 
real estate. Most people buy 
hard drives as an afterthought 
(“Hmm... I have so much money 
left over, so I’ll buy the biggest 
drive that fits”)—we don’t give 
them as much love as we do 
processors or RAM.  Fortunately, 
higher capacity drives are now 
getting much more affordable. 

A couple of years ago, 40 GB 
was the standard across most PCs, 
but today we see the momentum 
shifting towards 160 and even 
250 GB. Rightly so—for nearly 
the same price, these drives offer 
better features and significantly 
higher performance. Last year 
a 750 GB hard disk retailed for  
Rs 14,000; today you can get a 
better-performing 750 GB drive 
for just half the price! 

Recent developments such 
as Perpendicular Recording have 
vastly improved storage density. 
Hence, fewer components (plat-
ters and heads) are required to 
manufacture drives. Seagate has 
introduced single platter drives 
with capacities ranging from 80 
GB to 250 GB. Fewer  moving 
parts mean better speed, lower 
heat generation and hence lon-
ger life. Western Digital has 
introduced energy-efficient 
drives labelled “Green Power” 
or GP. These drives intelligently 
manage power consumption 
through smart control of rota-
tion speed (RPM) and head actu-
ator movement. They claim to 
shave off 4 to 5 watts of power, 
without any significant perfor-
mance hits. 

In this test, we see the indus-
try also aligning itself toward 
higher capacity drives. For 
instance, out of the 17 drives 
we’ve tested, the bulk comprises 
of 500 GB, 750 GB and 1 TB 
drives. In contrast, last year we 
had just one each of 750 GB and  
1 TB, with 500 GB drives mak-
ing the bulk. Back then, 320 GB 
drives were the newest thing in 
the market, and 500 GB were 

for the “elite”. Higher capacity 
drives now offer better value to 
the customer—at an asking price 
of Rs 7,500, a single 750 GB drive 
makes more sense than three 
250 GB or two 500 GB drives.

We put these drives through 
their paces to see which of them 
fulfil their promises. 

   
Features
Interface
Barring the WD Raptor 
150 GB, all other drives are  
SATA II compliant—that is, their 
interface speed can go up to 3 
Gbps. However, note that the  
SATA II specification also lists 
down other features, and it does 
not exclusively refer to 3 Gbps. 
Around the completion of our 
test, WD launched a newer ver-
sion of their Raptor drive—called 
the VelociRaptor (300 GB) that 
supports SATA II. We will review 
it shortly. 

All drives have improved 
SATA connectors with 
additional latches, ensuring 
that the cables don’t come out 
like it used to with the older 
connectors. Also, all drives offer 
the option of going back to  
1.5 Gbps, if there are 
compatibility issues with your 
motherboard’s SATA controller. 
Seagate and Western Digital 
have jumpers for this purpose. 
In the case of Hitachi, you need 
to download the Feature tool to 
downgrade the interface speed. 

Buffers And RPMs
Till last year, most drives would 
come with 8 MB buffer and a 
select few would boast of 16 MB. 

Seagate’s newer drives—7200.11 
(7200.9 and 7200.10 are older 
generation), have an integrat-
ed 32 MB buffer, and it seems 
to benefit on the performance 
front—even if slightly. Hitachi’s 
1 TB also has 32 MB, but a 16 MB 
version is also available. Most 
Western Digital drives have  
16 MB, except for the AV drive, 
which comes with 8 MB—still 
reasonable for the daily grind. 
Seagate’s 80 and 160 GB drives 
were the only drives with 2 MB 
buffers, and we also see it affect-
ing their performance, espe-
cially, when you compare the 
single-platter drives with their 
250 GB counterparts. 7200 RPM 
is still the speed of choice for 
most hard drive manufacturers—
the Raptor was the only drive 
whirling at crazy 10,000 RPM. 
The Green Power drives from 
Western Digital, dynamically 
adjust the rotational speed, but 
we understand the speed varies 
between 5400 to 7200 RPM. 

Performance
HD Tach RW
HD Tach RW is the first low-level 
test, where the hard drives are 
tested without creating any file 
system—making the results quite 
accurate. Although burst speeds 
are not of practical significance, 
they give us a glimpse of the drive 
functioning as a whole. We found 
that Seagate’s 7200.10 750 GB 
achieves the maximum through-
put, followed by its newer coun-
terpart—the Barracuda 7200.11 
1 TB. Both these drives reach 
an astonishing 260 Mbps—quite 
close to the theoretical limit. 

DIGIT May 200890

Platter 
Matters!
Here’s all you need to enter the world of the Terabyte!

Sanket Naik

Usage You need Go For Recommendation

Entry Level PC A reliable, reasonably 
fast, decent capacity 
hard drive

Any 80 GB SATA drive. 
Also consider extending 
your budget by a few 
hundreds.

Seagate Barracuda 7200.10 250 
GB or Western Digital Caviar SE 
16 250 GB

Mid-Range PC A high-capacity, 
better performing 
hard drive 

A 500 GB SATA drive. If 
your wallet permits, we 
recommend a 750 GB 
drive instead

Seagate Barracuda 7200.11 500 
GB or Seagate 7200.11 750 GB or 
Western Digital RE2 750 GB

Gaming PC A high-throughput 
hard drive that can 
handle continuous 
and rigourous usage 

A high capacity drive 
with low access time and 
fast I/O 

Seagate Barracuda 7200.11 500 
GB or Seagate 7200.11 750 GB or 
Hitachi Deskstar 1TB

Media centre PC A quiet but high 
performing drive

An AV-rated drive that 
has low acoustics with 
reasonable performance

Western Digital AV 1TB 

Backup Drive A reliable, high 
capacity drive 

A drive with high 
interface transfer speeds 
and proven track record

Hitachi Deskstar 1 TB or Western 
Digital RE2 750 GB

 Decision Maker
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The WD Raptor has a random 
access time of 6 ms, matched only 
by the Hitachi 1 TB drive. Other 
drives fall far behind here, with 
double- digit random access times. 
We also see this performance in 
the file copy tests. The Green 
Power drives from WD posted the 
worst access time, thanks mostly 
to the slower rotation speed.    

The WD Caviar SE16 320 GB, 
Seagate 7200.11 drives and the 
single platter Seagate 250 GB 
sported the best Average Read / 

Write speeds. The large 16 and 
32 MB caches are doing their bit 
to speed up the read and write 
operations of these drives. Other 
drives were not far behind, 
but a difference of 10 Mbps 
between hard drives translates 
to a lot more in practical usage. 
Seagate’s Barracuda 7200.10 
250 GB marches ahead of other 
drives in this test, thanks to a 
perfect balance of cache, inter-
face speed and single platter 
configuration. 

H2Bench
Another low-level benchmark 
which reproduces precise results 
and requires raw hard drives—
that is, drives without any file 
system or partitions. Seagate’s 
Barracuda 7200.11 posted the 
best sequential transfer speeds—
we attribute this to better drive 
electronics and higher cache. 
The WD 320 GB AAKS (last year’s 
winner), still holds its ground 
and delivers a performance as 

good as Seagate’s new gen-
eration drives. Seagate’s 
Barracuda 7200.11 500 GB 
trumps in this test. Hitachi 
drives, especially the 1 TB 
does come really close to the 
winner, but looses out by a 
tiny margin. Though one would 
expect the WD Raptor to deliver 
a knockout performance, its 
1.5 Gbps interface limits it. We 
expect the new VelociRaptor to 
put up a better show. 

PCMark 05
The well known system-wide test 
suite, PCMark 05, has a special 
test aimed at gauging hard drive 
performance. In the XP start 
up sub-test, WD’s Raptor scored 
the highest. This is largely due 
to its low access time (seek 
time). Similar results are seen 
with the Hitachi 1 TB drive 
that has a low access time of 6 
ms. Seagate’s 7200.11 and the 
WD Caviar SE16 750GB followed 
closely. In the Virus scan test—
important because it involves 
lot of IO—the Seagate Barracuda 
7200.11 500 GB, delivered an 
astonishing 142 Mbps. Seagate’s 
750 GB and 1 TB were trailing, 
but still ahead of the WD and 
Hitachi drives. Seagate’s 80 and 
160 GB Barracuda are at the 
bottom of the heap and it’s 
partly the 2-MB cache that’s to 
blame! Please stay away from 
these drives—the 250 GB is a 
much better bet. 

SiSoft Sandra XI SP1
Seagate’s Barracuda 7200.11 
500 GB posted the highest 
Drive Index score, followed very 
closely by Western Digital’s 
Caviar 320 GB and Seagate’s 
7200.11 750 GB. These three 
drives have significantly better 
sequential read and write 
speeds, and they overshadow 
other drives. Despite lower 
interface speeds, the WD Raptor 
does deliver when it comes to 
random read / write operation—
better access times make up for 
the lower interface speeds. WD’s 
RE2 750 GB posted better scores 

across the various sub-tests and 
is one of the better drives other 

than the Seagate 7200.11 drives. 
Overall, the Seagate Barracuda 
7200.11 500 GB came out as  
the winner. 

Real World Copy Tests
In the assorted write test, the 
Western Digital Raptor com-
pleted the test in the least pos-
sible time. The 10K spindle 
speed coupled with low access 
times helps it achieve this feat. 
Western Digital Caviar 320 GB 
and Seagate’s 7200.11 500 GB 
were next set of drives to com-
plete the file transfer. All other 
drives took 4 to 5 seconds more 
than these two drives to com-
plete the test. The 80 GB and 160 

GB from Seagate took 43 seconds 
more, and were way behind all 
drives. These two drives are seri-
ously handicapped and should 
be avoided. 

Almost all drives did well 
on the Assorted Read test, and 
delivered consistent results, 
taking approximately 83 sec-
onds to read 4 GB of data. In the 
partition-to-partition file copy 
test, WD’s caviar 320GB com-
pleted the feat in the least time. 
In this test, the buffer mem-
ory makes all the difference. 
However, apart from buffer size, 
buffer speed also dictates the 
final outcome. For example, the 
Seagate’s 7200.11 has a 32-MB 
buffer. However, these are out-
done by the 7200.10 Seagate 
drives and we presume it is due 
to the buffer speed. 

The sequential read / write 
test results are similar to the 
assorted read / write test results. 
However, in sequential parti-
tion-to-partition file transfer, 
the Western Digital Caviar 
320 GB takes the pole position 
dethroning Raptor. The other 
drives put up reasonably good 
performance, barring the two 
Seagate’s namely 80 and 160 GB.

Winners
Seagate’s Barracuda 7200.11 
500 GB delivered consistent per-
formance throughout, and we 
adjudge it as the Best Performer. 
Western Digital’s Caviar 320 GB 
(our last year’s winner), still 
has enough steam to stay ahead 
of the competitors. However, 
given the price difference, we 
recommend Seagate’s 500 GB. 
You get 160 GB of more space 
at a paltry difference of just 
400 bucks. For its superb value 
for money, we also award the 
Seagate Barracuda 7200.11 500 
GB our Best Buy award. 

The Editor’s choice goes to 
Seagate’s Barracuda 7200.11 750 
GB drives. To put it in simple 
words, the 750 GB makes more 
sense, given the quantity of data 
that resides on our hard drives—
especially, HD movies and games. 
For us—1 TB drives are still 
expensive, but the 750 GB are 
sweetly priced! 

sanket.naik@thinkdigit.com

Barracuda 7200.11 500 GB

M ay  2 0 0 8

M ay  2 0 0 8

Seagate’s Barracuda 7200.11 750 GB

A P R I L  2 0 0 8

The performance test for hard drives consists of synthetic 
tests, benchmarking software and real-world tests—where 
application performance and file transfer speeds are tested. 
The synthetic tests were conducted using two types of bench-
marks—low-level benchmarks—namely, HD Tach RW 3.0.1.0 
and H2Bench, and standard benchmarks PCMark 05 and 
SiSoft Sandra XI SP1.

Features
In the features, we noted and rated various features of the 
hard drive such as capacity, dimension, weight, bundled soft-
ware, interface type, cables and accessories and ruggedness.

Performance
HD Tach RW 3.0.1.0 was used for noting down the following 
parameters in the test hard drive. 

CPU Utilisation
Lower CPU utilisation is better, and is measured as a percent-
age of the maximum.

Random Access Time Benchmark
Random access is the time required to retrieve data from  
random locations on the drive. It is represented as time—the 
lower the value, the better the drive.

Average Read And Write Speed
It is the speed with which data can be accessed from the drive. 
The speed is represented as throughput and generally speci-
fied as Mbps—the higher the score, the better the drive.

Burst Speed
The maximum interface speed that can be achieved by the 
drive is known as the burst speed. This is identical to PMPO 
in speakers. Burst speeds are indicated in terms of Mbps—the 
higher the score, the better the drive. 

H2Bench
With H2bench, we measure the interface speed at 50 per cent 
of the drive’s capacity. The “Core Test” or Repetitive Sequential 
Read Test was then performed and through repeated sequen-
tial reads, revealed the maximum transfer rate of the drive. 
The read and write seek times were also noted.

PCMark 05 
FutureMark’s PCMark 05, is a very popular tool to benchmark 
the entire system. We noted the scores of the following com-
ponents from the hard drive benchmark module.
XP Startup: This simulates a typical Windows XP startup, and 
tests the performance of the hard drive at initiation.
Application Loading: This simulates the opening and closing 

of several applications such as Adobe Reader and Windows 
Media Player.
Virus Scan: This tests the drive performance during a simu-
lated virus scan of approximately 600 MB of files with differ-
ent file types.

SiSoft Sandra XI SP1
The scores of Sequential Read, Random Read, Sequential 
Write, Random Write and Access Time were reported at the 
end of this benchmark, which we duly noted. This is one 
benchmark that reproduces constant results, which is why 
we still use it. 

Real World Tests—File Copy
The Real World tests consisted of copying a 4 GB (1 GB for 
external drives) file (for sequential data transfer speed) and  
4 GB of assorted files (for random data transfer speed). 
The time taken for this data transfer was noted down. The 
assorted files consisted of multiple file types that included 
applications, Word documents, Excel files, MP3s and small 
video clips, thus simulating the real world situation where 
such files will be copied.

Three tests were carried out—first Read/Write Assorted 
files, followed by Read / Write sequential file and lastly, both 
file types were copied from one partition of the test hard 
drive to the other. The last test puts the hard drive to the 
highest stress levels and gives a clear verdict of how good 
the drive performs in a real world scenario, where we end up 
moving data between partitions. 

Real World Test—Photoshop CS3 
We installed Adobe Photoshop CS3, and configured the 
scratch disk to occupy the first partition of the test drive. We 
then started the application and noted the time taken for it 
to open completely. We then copied two PSD files, a 550 MB 
and a 1 GB, to the first partition of the test drive and clocked 
the times taken to open each of these.

  How We Tested

 Test Rig Configuration

Processor Intel Core 2 Extreme X6800

Motherboard Intel D975XBX2

Chipset Intel 975

Memory 1 GB Corsair at 800 MHz

Host Hard Drive Hitachi 500 GB

OS Windows XP SP2 (updated)

Brand Company Phone No E-mail Web site
Western Digital Western Digital India 9321029204 amarjeet.singh@wdc.com www.wdc.com

Hitachi Cyberstar Infocom Limited 080-34035467 sales@cyberstarindia.com www.hitachigst.com

Seagate Fortune Marketing 011- 26414468 sales@fortune-it.com www.seagate.com

 Contact Sheet	          Speakers
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Hard Disk Drives
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Brand
Model

Seagate 7200.10
ST3802154S

WD Raptor
WD1500ADFD

Seagate 7200.10
ST3160215AS

          Seagate 7200.10
             ST3250310AS

         WD Caviar SE16
           WD3200AAKS

Seagate 7200.11
ST3500320AS

Hitachi T7K500
HDT25050 VLA360

WD Caviar SE16
WD5000AAKS

WD AV
WD5000AVJS

Seagate 7200.10
ST3750640AS

Seagate 7200.11
ST3750330AS

WD Caviar SE16
WD7500AAKS

Formatted Capacity (GB) 80 GB 150 GB 160 GB 250 GB 320 GB 500 GB 500 GB 500 GB 500 GB 750 GB 750 GB 750 GB

Performance (Out of 100) 44.88 51.15 44.12 51.78 56.53 56.77 49.34 45.52 46.67 50.57 56.36 53.76

Price Rs 1,895 Rs 9,000 Rs 2,325 Rs 2,900 Rs 4,500 Rs 4,900 Rs 5880 Rs 5,000 Rs 8,400 Rs 7,500 Rs 8,900 Rs 7,500

Features

Interface Type SATA II SATA I SATA II SATA II SATA II SATA II SATA II SATA II SATA II SATA II SATA II SATA II

Number of Platters 1 NA 1 1 NA 2 3 NA 3 4 3 NA

Rotational Speed (RPM) 7,200 10,000 7,200 7,200 7,200 7,200 7,200 7,200 7,200 7,200 7,200 7,200

Buffer Memory (MB) 2 16 2 8 16 32 16 16 8 16 32 16

Performance 

HD Tach 3.0.1.0

CPU Utilisation (%) 2 4 2 2 2 3 3 3 3 2 3 2

Average Read (MB/s) 73.3 75.3 63.4 89.9 92.7 92.2 64.2 62.2 69.4 66.9 91.4 80.2

Average Write (MB/s) 70.3 66.2 61.2 86.9 84.1 83.5 60.5 59.5 66.8 62.4 82.2 73.9

Random Access Time (ms) 12.4 8 15.4 15.2 16.4 12.2 13.2 13.4 20.2 13.7 12.8 13.8

Read Burst Speed (MB/s) 231.7 135.2 231.8 245.7 237.9 255.3 221.2 192.2 205.8 260.9 254.7 222.4

H2Bench

Random Access Write (ms) 6.51 5.93 7.64 8.2 8.19 7.22 7.35 7.69 8.24 10.6 7.62 7.38

Random Access Read (ms) 12.41 8.12 15.21 15.29 16.34 12.26 13.59 13.31 20.41 13.61 12.4 13.31

Interface Speed (50%): Sequential Transfer (MB/s) 133.05 118.07 137.38 141.9 202.8 207.83 162.4 120.6 143.95 191.58 211.34 152.73

Repetitive Sequential Read “Core Test”(MB/s) 177.44 127.13 175.22 205.1 191.8 221.89 201.3 150.89 161.68 225.71 221.88 171.78

PCMark 05

HDD XP Startup (MB/s) 7.9 11.25 8.47 9.4 9.8 9.31 9.71 8.97 8.88 8.88 9.21 10.05

HDD Application Loading (MB/s) 5.3 9.2 5.7 6.8 7.21 7.45 7.48 7.49 7.08 6.95 7.37 7.9

HDD General (MB/s) 4.2 8.08 4.28 5.5 6.18 6.7 6.43 6.64 5.81 5.4 6.78 6.7

HDD File Write (MB/s) 64.95 83.97 74.32 94.9 105.71 99.15 68.352 65.59 74.27 72.87 99.07 90.98

HDD Virus Scan (MB/s) 50.58 96.88 61.19 117.68 122.66 141.98 129.25 80.09 94.97 138.07 137.05 109.62

SiSoft Sandra XI SP1

Drive Index (MB/s) 65 70 65 77 89 90 64 61 68 65 88 80

Sequential Read (MB/s) 76 83 76 97 109 109 74 71 79 77 106 93

Random Read (MB/s) 51 54 51 45 58 59 50 47 51 49 59 58

Sequential Write (MB/s) 74 76 76 98 107 104 68 70 79 76 104 92

Random Write (MB/s) 42 55 43 50 70 77 51 49 51 48 76 67

Access Time (ms) 7 6 7 12 8 8 6 7 7 7 8 7

Real World Tests (lower is better)

Assorted 4 GB File Write (sec) 113 70 114 79 73 73 79 77 77 76 75 72

Assorted 4 GB File Read (sec) 83 82 86 85 83 88 84 83 83 87 86 85

Assorted 4 GB Internal File Copy (sec) 351 138 362 187 126 168 160 174 194 152 167 139

Sequential 4 GB File Write (sec) 60 97 59 58 58 59 60 60 59 58 59 58

Sequential 4 GB File Read (sec) 65 65 67 65 67 65 64 65 61 63 62 65

Sequential 4 GB Internal File Copy (sec) 308 127 377 142 109 170 135 167 180 124 170 123

Photoshop CS2 Image Load (1 GB file) (sec) 82 85 85 80 85 85 86 84 85 84 84 84
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 HDD
Brand
Model

WD RE2
WD7500AYYS

Seagate 7200.11
ST31000340AS

Hitachi 7K1000
HDS721010KLA330

WD AV
WD10EVCS

W D RE2 GP
WD1000FYPS

Formatted Capacity (GB) 750 GB 1 TB 1 TB 1 TB 1 TB

Performance (Out of 100) 52.42 54.16 53.69 49.10 47.80

Price Rs 8,400 Rs 11,250 Rs 16,100 Rs 14,000 Rs 17,000

Features

Interface Type SATA II SATA II SATA II SATA II SATA II

Number of Platters NA 4 5 4 4

Rotational Speed (RPM) 7200 7,200 7,200 5400-7200 5400-7200

Buffer Memory (MB) 16 32 32 16 16

Performance 

HD Tach 3.0.1.0

CPU Utilisation (%) 3 3 3 1 2

Average Read (MB/s) 79.2 85.9 72.7 64 64.3

Average Write (MB/s) 72.9 77.7 70.1 58.8 59.1

Random Access Time (ms) 13.9 12.7 12.5 21.8 15

Read Burst Speed (MB/s) 222.1 259.7 219.7 224.2 233.8

H2Bench

Random Access Write (ms) 7.9 12.33 6.36 8.39 7.67

Random Access Read (ms) 13.47 12.79 12.83 21.99 15.52

Interface Speed (50%): Sequential Transfer (MB/s) 150.5 216.5 162.5 163.19 162.9

Repetitive Sequential Read “Core Test”(MB/s) 166.9 221.8 200.8 174.7 173.11

PCMark 05

HDD XP Startup (MB/s) 9.73 8.87 10.1 8.22 8.15

HDD Application Loading (MB/s) 7.7 7.2 9.1 6.8 6.7

HDD General (MB/s) 6.63 6.8 8.08 6.7 5.77

HDD File Write (MB/s) 91.33 92.6 79.15 74.96 74.76

HDD Virus Scan (MB/s) 109.6 137.8 132.98 105.23 105.71

SiSoft Sandra XI SP1

Drive Index (MB/s) 79 82 72 64 65

Sequential Read (MB/s) 93 98 83 75 75

Random Read (MB/s) 56 56 55 48 47

Sequential Write (MB/s) 92 94 83 73 75

Random Write (MB/s) 65 73 62 50 56

Access Time (ms) 7 8 6 8 8

Real World Tests (lower is better)

Assorted 4 GB File Write (sec) 76 75 76 77 76

Assorted 4 GB File Read (sec) 84 88 83 86 83

Assorted 4 GB Internal File Copy (sec) 139 172 137 159 155

Sequential 4 GB File Write (sec) 59 60 59 59 59

Sequential 4 GB File Read (sec) 63 70 66 63 68

Sequential 4 GB Internal File Copy (sec) 124 178 122 139 136

Photoshop CS2 Image Load (1 GB file) (sec) 84 84 86 85 85
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didn’t use measures to block peer-to-peer (P2P)
software, instant messaging (IM) or USB Flash
drives—the new wave in security breaches. And
the bad news doesn’t end there, either. 

“[SoHos and small businesses] are prime
targets for attackers, as enterprises are hard to
break thanks to mature security implementa-
tions. With growing penetration of broadband
and the introduction of WiMAX and 3G servic-
es—especially for SMBs—it is a matter of con-
cern that awareness of security is very still
limited,” Mahendra Lalwani, Country

Nimish Chandiramani

At the end of 2007, a Websense State of
Security survey stated that small business
and SoHo owners are rather confident of

the state of their security. The survey also stated
that they had no reason to be. Despite more

than 95 per cent claiming that they
have installed antivirus and antispy-

ware programs, more than 70 per
cent of the businesses surveyed

If you’re a small
business in the
big, bad world,
you should be
more worried
about your
security than
anyone else

Lead Feature

Little Guy, 
Big Worry

Business_Main Story_May 08.qxd  5/13/2008  2:19 PM  Page 99



101DIGIT MAY 2008

Digital Business l Lead Feature

100 DIGIT MAY 2008

Digital Business l Lead Feature

Manager, ZyXEL, tells us. It doesn’t end at just
installing security software.

What You’re Up Against
These are new times, and if you’re setting up a
new business, you don’t even need a physical
office! With online office suites and collabora-
tion tools in this new broad(ish)band-enabled
country, there’s nothing stopping you build-
ing a team that’s spread across the country.
But we digress.

One side effect of the distributed office is
that laptops and smartphones are a common
sight, and the amount of work-related data you
could find on them is shocking. What’s worse,
this (potentially sensitive) information is easily
accessible once you get your hands on them. The
loss or theft of your device can lead to a lot of
trouble for your company—according to a
McClatchy-Tribune study, around 57 per cent of
corporate crime starts at a stolen laptop. You
may not necessarily have to deal with a crime in
such a case, but there will be the palpable
embarrassment to come to terms with, at least.

And then, there’s the common oversight
that Sunil Chandna, CEO, Stellar Information
Systems points out: “Small businesses have data
distributed across desktops, laptops and
servers—this increases their risk. Usually, data
created by server applications is backed up, but
the desktop / laptop data is left unattended.”

Then, of course, there’s the threat to your
network. The Internet and e-mail continue to be
the biggest threats—more importantly, it’s the
way employees use them that matters. In
Websense’s 2007 State of Security India survey,
35 per cent of the IT managers surveyed believed
that employees were a great threat to security—
sending work-related documents to personal
accounts, clicking links that come from
unknown sources and so on. Thirty per cent of
the professionals surveyed admitted that they
surfed aimlessly—no wonder IT managers worry
so much. Not very encouraging, is it?

What You Need
To address the threat to your networks, Lalwani
recommends a “multi-layer” defence—at your

Internet gateway, on your servers and on every
client. “Spam can be addressed with a good serv-
er-level filtering mechanism which should be
supplemented by gateway-level filtering,” he
says, “and the defence you design should address
all applications used in the organisation, includ-
ing IM, P2P, VoIP and other wireless  systems.

To protect your data from untoward inci-
dents like hard disk crashes, accidental deletion
and the like, you need an automated backup
solution installed on all your clients and servers.
The data on your laptops and smartphones
should be backed up to a secure location on your
network both before they’re taken out of the
office and after they’re returned. 

If these are company-owned laptops, you
should also be able to manage them remotely—
disable their USB ports and / or DVD writers and
so on. To secure laptops from theft, you first
need to raise a physical barrier—laptop locks can
prevent access to your laptop without a key or
combination. You also need a way to track the
laptop on the Web, and in the event of a theft,
even help recover it. 

What Everyone’s Doing
Lalwani tells us what one of his sales executives
encountered once—“He had approached the R &
D unit of a large business group. It was a small
network of around sixty users. A scientist is in
charge of the IT setup, and the Accounts
Manager acts as the System Administrator.”

Few (if any) small businesses have a dedicated
IT staff, so this is usually the case—people adding
IT administration to their regular jobs. To get
this load off their employees, small businesses
all over the country are moving towards man-
aged security solutions—in other words, out-
sourcing. Security software will be deployed on
your network, and administered from a Security
Operations Centre (SOC), from where your net-
work is monitored for any suspicious activity.

Security software vendors themselves are
waking up to the needs of the small business
and have begun to offer solutions that specifi-
cally target your needs, and more importantly,
aren’t dauntingly expensive. You can purchase
software licenses for groups as small as three
people—a welcome change from the times when
business licenses were for a minimum of 25 peo-
ple and cost a bomb. Their approach has
changed, too—instead of selling you the product
once and forgetting about it, they now offer you
yearly maintenance contracts—in the long run,
this can save you a lot of money. 

A lot of software vendors have a well-estab-
lished presence in India, and Indian software
developers have started to build their own solu-
tions too. For the international vendors that
don’t have Indian offices, there are several fran-
chisees that provide sales and support. 

Securing The Network
Let’s consider the multi-layer defence we spoke
of earlier—the first layer is the Internet gateway.
Your gateway stands between your network and
the Internet, so securing this level makes secur-

ing the rest much easier. Instead of just a router,
you could invest in an Internet Security
Appliance (ISA)—which is, simply put, a router
with security measures like a firewall, access
rights and an anti-virus built in. Prices start at
Rs 10,000, and depending on how much you’re
willing to shell out, you can even get access con-
trol to IM and P2P applications. You can get one
of these from ZyXEL, Trend Micro and
Cyberoam, among others. 

To secure your servers and clients, you’re
better off with a managed security solution. You
could either approach larger vendors like Sify,
or strike up a deal with your local software
reseller—some will install and maintain security
software for you. The latter will likely come
cheaper, and more importantly, will work better
for you if you’re in a small town. As for the soft-
ware itself, take your pick—Norton, McAfee,
Trend Micro, BitDefender, QuickHeal—anyone
you want. Of late, both Trend Micro and
BitDefender (through Unistal, an Indian securi-
ty software vendor) have taken an active interest
in the Indian small business, so you might find
the features and prices more to your liking.

Securing Your Data
This one’s really a no-brainer, but is unfortu-
nately easily ignored. Backing up data can be as
simple as setting up an automatic backup with
Windows’ own backup tool. While this is easy
for one or two PCs, for many clients, you’d want
to ensure that data being backed up regularly,
and that you can trigger a backup whenever you
wish. These solutions have something of a man-
agement console that runs on a server and keeps
track of the clients on your network and the
files and folders on them that need to be backed
up regularly, and a client service that runs on
each desktop or laptop that’s on your network.
Bacula is an open source backup solution that
runs on a Linux- or Unix-based server and
Windows or BSD-based clients—perfect for busi-
nesses on a tight budget. To make sure that your
backup is safe, you can use software like Stellar
Smart, which monitors your hard disk’s per-
formance and warns you if a crash is immi-
nent—you can then take your backed-up data to
a new location before the crash occurs.

Many backup software vendors also offer
software that’ll recover your data in the event of
a crash or corruption—both Stellar and Unistal
have impressive tools to recover data from cor-
rupt hard disks, damaged Outlook PST files,
Word files and many more. 

If you have the bandwidth, you could consid-
er using an online backup service like JungleDisk
(www.jungledisk.com) or BingoDisk (www.bin-
godisk.com). Both offer high levels of security and
redundancy—something that would cost you an
exorbitant amount to implement in your own
office—and are priced rather reasonably too. One
thing we like about JungleDisk is that you only
pay for what you store—$0.15 (Rs 6) per GB—but
for larger amounts of data, BingoDisk might
work out cheaper. You can visit JungleDisk to cal-
culate your expenses based on how much storage

you require and how much data you’ll be upload-
ing every month. 

Finally, secure your laptops. Unistal offers a
tool called Locate Laptop, which runs stealthily
on your laptop and reports its IP address to a
personal tracking page only you have access to.
If your laptop is stolen, law enforcement officers
can use this IP address to track it every time the
thief uses it to connect to the Internet. At 
Rs 3,000, it’s a welcome addition to any laptop.

The Real Secret
While installing a lot of security software can
give you peace of mind, there is one flaw in our
reasoning—your team. Even though IT managers
believe that employees are a huge threat to your
data, they also admit that it’s the employees,
and not the software, that are the key to keep-
ing your data safe. No software can compete
against educating your employees about your
security policies and brainwas...er...inculcating
the habit of following them. If employees are
aware of the damage that your company’s repu-
tation could take in the event of a security
breach, they’d probably pay more attention to
what they’re doing online. 

It’s a tall order, but in the long run, it’ll save
you money, and more importantly, will give you
the time to catch up on your FreeCell skills.

nimish.chandiramani@thinkdigit.com

Solution vendors
are moving from
product sales to
annual
subscriptions to
reduce the total
cost of ownership
of their solution”

Sunil Chandna
CEO, Stellar
Information Systems

In your quest for a security solution,
you’re bound to encounter and
obscene number of three-letter
acronyms (TLAs)—we know we did. To
ease the pain, here are some:
VAR: Value-added Reseller. These are
software resellers who will also offer
you support and added services for
the products you buy.
SOC: Security Operations Centre. If
you’ve opted for managed security,
the Security Operations Centre is
where your network will be monitored
from. SOCs may operate during regu-
lar office hours, but you can pay extra
for 24-hour service as well. 

CPE: Customer Premises Equipment.
This is the opposite of the SOC.
Instead of a third party providing you
with a security solution, you do it
yourself with your own equipment, in
your own premises.
UTM: Unified Threat Management. This
is the term given to firewalls (usually
hardware) that have a bunch of fea-
tures built into them—spam filters,
intrusion detection and so on.
NSA: Network Storage Appliance. A
fancy term for a Network Attached
Storage (NAS) box. These are loca-
tions on your network meant specifi-
cally for backing up important data.

TLAs
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in selecting our ERP application, as other solu-
tions required separate installations of heavier
databases, Java Environments and a client in
addition, and expectedly, being really heavy on
system resources. One such example is that of
Compiere (www.compiere.com).

After you download the setup for Tiny ERP,
ensure that you do not have PostgreSQL
installed on your system, because this can
really be an issue, thereby causing error mes-
sages to pop up. Now, run the application, and
just follow the instructions as they proceed.
Leave the default values, especially be sure
not to change any port values—assuredly, this
can be the biggest pain factor during installa-
tion. The error messages as a result of port
conflicts can really dampen your ERP plans.
With Tiny ERP, however, you should not face
such issues.

After the setup is run, it will prompt you to
“Launch the Tiny ERP client”. Check this box
and click Finish. After launching the service, do
not be alarmed to see error messages that say
“cannot connect to the server.” Click Cancel,
and in the client, go to File > Databases >
New Database. Enter details of the new data-
base. By default the super admin password is
“admin”. Type in a new database name and
click OK. After entering all these details, Tiny
ERP will setup a database for your company.
This will take about a minute. By default, two
users are created—each with a username and
password as “admin / admin” and “demo /
demo”, respectively.

Login as an administrator, as you are the
first user. Select the minimal configuration,
and select your language as English. Proceed
with the details of your address, which is 
non-essential information as far as testing
this software goes. Click Install at the end of
it. Tiny ERP will install all the required mod-
ules, depending on the selections that you
make initially.

Sample Application
Once the database is installed, you are all set
to use Tiny ERP! The server application is
installed on the main server, while user termi-
nals are selected as clients. Effectively, they
will login as demo-user. After login, you will
see a default dashboard. 

Close this dashboard by clicking on the
close button on the toolbar on the top of the
window. On the menu screen, as an example we
will take a closer look at the Human Resources
application. As we all know, Human Resources
requires a considerable amount of data, such as
payroll, leave applications, project details, and
even attendance. All these involve logging into
a database. 

Once you click on Human Resources from
the main menu, you will see a host of options.
Depending on your application, you can click
on any of them, and Tiny ERP will take care of
entering it appropriately into the database.
Being the Human Resource module, the obvi-
ous first step will be entering details of the
employee names. Click on New Employee to
enter all the relevant details. Typical fields
such as the name of the reporting manager
are also provided, so that the database is
organised for queries such as leave and proj-

ect details.

Easy To Use
Similar to the application of Human Resources,
Tiny ERP also provides CRM, Projects, Sales,
Procurement, e-commerce and accounting
modules, which you can greatly benefit from.
The best part of it all is that it is really friendly
to use. So feel free to experiment with the dif-
ferent modules that best suit your needs.

nash.david@thinkdigit.com
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As a matter of fact, this industry is so large,
that by itself, other outsourcing companies such
as TCS, Infosys, Wipro and others are generally
roped in to carry out the implementation part!
Not to forget the time lag and other overhead
costs that are associated with these projects.
Which is why we present this article on ERP, to
equip you to stabilise, control, track and stream-
line your venture for higher productivity. From
a host of free, open source solutions, and
analysing a range of considerations, we rounded
up with Tiny ERP—an open source solution,
which is as expected, free, small in size, and
most of all—if done meticulously, is the easiest
to install.

Basic Installation
The pre-requisites of most ERP software are
higher RAM and larger memory for the data-
base. Nevertheless, for an SME, around 5 GB
free space on your hard disk with anything
around or more than 1 GB of RAM will be suf-
ficient for smooth and glitch-free operation.
Another important point to make note of is
that, Tiny ERP will work only if your disk parti-
tioning format is NTFS—it should not be FAT or
FAT32. Start off by downloading the installer
from the Tiny ERP Web site, at
http://tinyerp.com/download/stable/win32/ .
Alternatively, click on the home page, click on
the products tab, and then on download. From
this page, navigate to the appropriate file.
Download the all-in-one file, named tinyerp-
allinone-setup-4.2.2.exe, which is a 70 MB file.
This includes the database (postgresgl), as well
as the server and the client, all bundled into
one single setup file. This was a decisive factor
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All the benefits
of an ERP

package at your
fingertips—with

none of the costs!

Nash David

n recent times, we have all heard of the
significance of ERP solutions in stream-
lining businesses. Heavyweights such as
SAP, Oracle and Microsoft are all trying to
woo global businesses to implement their

tools, which no doubt, costs money—in fact, the
word fortune is apt!

It is, apparently, a costly affair to implement
ERP solutions in a business. However, in today’s
world of “free and open source”, you should
have no excuse for being left behind in the race
to maximise productivity and profitability.
Keeping in mind, the numerous tiny businesses
and small and medium-sized entities in the
industry today, we decided to find the most
effective solution for this one need—Enterprise
Resource Planning. Considering the shoestring
budgets of SMEs, tools such as R/3 by SAP,
PeopleSoft by Oracle, Microsoft Dynamics by
Microsoft Corporation and SYSPRO, all seem to
be out of the picture. 

I

Initiate the creation of a new database

The default dashboard for an accounting profile

Add details of employees to streamline your HR needs

Track And
Streamline 
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which you are working is called the “Active
Workspace”. You can have multiple number of
workspaces open at the same time and can
switch between them instantaneously.

You can create Workspaces by clicking on
the “Create Space” icon in the toolbar. Each
Workspace has a name and a description. The
new workspace can be created within a previ-
ously created workspace, or as an entirely inde-
pendent entity by selecting the appropriate
radio button in global space.

Members
The Members module shows the number of peo-
ple who are online during a particular session. If
you are starting the session this space will ini-
tially display only your name. To invite other
users, click on the Invite
icon from the menu bar and
type the name or e-mail
address in the search box.
These users, however, need
to be online when you send
them invites. Online mem-
bers are represented by a
green icon against their
names. They can also
change their profile status
to busy by clicking on the
icon in the taskbar and selecting either “Busy”,
“Online” or “Offline”.

You can invite virtually unlimited number
of collaborators for each of the workspaces that
you have opened. Members typically have three
types of permissions—Guest, Participant and
Manager. The Manager initiates the session and
can invite others to participate or observe. These
permissions, along with other options, like
change of status and uninviting or leaving the
workspace, can be accessed by right-clicking on
the member names in the Member panel.

Content
Collanos Workspace can work with differing
content, which are called objects and are con-
tained within a single folder. You can create a
folder by clicking on the New Folder icon in
the toolbar. Users can share Word documents,
PDF files, spreadsheets, slides, links, notes and
even music and video. All these are viewable in
a single place, so that you know what
resources are being viewed by every member
in your workspace.

How Things Work
Such organisation is also essential when you
have to keep track of changes people make to
“live” documents. Consider this scenario—you
are working with your team members on a
report, and they are all scattered across various
locations. You are required to give inputs on a
report, which is going to be presented in an
important meeting. In a conventional situa-
tion, people would give their brief via e-mails,
which would then be probably collated by one
member of the group into a single document.
This document would go back and forth
between the participants, until all issues are

sorted out. In practice, however, anyone who
has attempted this sort of exercise knows that it
is a time consuming affair which ends up with
someone or the other not really having their
say in the final report, along with some
unpleasant eye strain and migraine or two.

Compare this with the way Collanos
Workspace handles this task. A draft report is
shared by the manager of the session. All other
participants simultaneously read it and append
their own modifications or updates. Each time
a change is made a bright orange marker
appears over the document, alerting you of the
changes. The document always represents the
latest changes made, while overwriting earlier
changes. In case someone deletes your version
with a new version your version will be stored
in the Conflict Bin, which can be accessible
from Tools > Conflict Bin.

Launching chats in this software is also
really simple. Just click on the Discussion icon
in the toolbar and give a name to the
Discussion. Invite other members to join the
discussion by clicking on the Start Chat icon
on the top right of the Members pane.

Links and notes can also be added as objects
in the workspace. Links are added by using the
Add URL icon while notes are added using the
Post Note icon. Notes are short messages that can
be about anything and are visible to anybody in
the Workspace. Each object in the Workspace

has its own creator / modifier,
the date and time on which it
was modified.

One management tool
which is of great value in the
context of managing teams
and projects is the Tasks
object. Users can allocate
deadlines and set priorities for

themselves and others for specific assignments.
Click on the Add Task icon and complete the
data fields. One limitation here is that you can
only allocate tasks to people who are online and
present in the Workspace. Other than that we
found the Task object pretty useful.

Concluding Remarks
Collanos Workspace is still evolving and is best
suited for students, small teams and organisa-
tions who can’t afford the resources and the
training needed to deploy enterprise level offer-
ings like MS Groove. Similar to Skype or Kazaa,
it uses the P2P model, instead of client-server
model for networking. This means that even
without an Internet connection, members can
keep working and collaborating on the local net-
work. Changes are saved on the local machine
and when the Internet connection is back up,
all the changes are synchronised in the final ver-
sion, which is viewable by all members. Security
used is 256-bit AES encryption, which is the
same as used by banking software. The help doc-
umentation is pretty exhaustive—you would,
however, need to be online to access it.

Use this software for a quick, cheap and no
frills way of collaborating with your team! 

bhaskar.sarma@thinkdigit.com

Different user permissions
in Collanos
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anaging businesses in the pre-glob-
alization days was pretty simple.
For example, in a large company
like IBM, design and production
teams were housed in the same or

adjoining locations (Poughkeepsie being one of
them), with only the sales and marketing peo-
ple separated geographically. If people wanted
to discuss something face-to-face they would
just schedule a meeting or walk over to the
respective cubicle or cabin. 

However, things got more complicated as
companies had to expand across countries, con-
tinents and time zones. For a while, e-mail was
used as the primary means of communication
when documents needed to be exchanged
among team members who might have never
seen each other. But anyone using e-mail knows
that in spite of it being pretty instantaneous
and reliable, it’s only good when the number of
people involved is kept to the bare minimum.
You really can’t have 20 people mailing back and
forth discussing minor changes and making
modifications to a document - after a couple of
hours the entire thread would look as convolut-
ed as an online debate about “PCs vs. Macs”.

Collaborating Online
This realisation led to a more proactive and
imaginative use of the Internet when it comes to
collaborating on work. Online office suites like
Google Docs and Spreadsheets and Zoho Office
Suite were introduced, which were intended to
replace offline office suites like Microsoft Office.
However, these tools didn’t really cut down on
multiple applications like e-mails and chats.

Therefore, another type of software known
as collaborative tools, which allow remote users
to synchronise and regularise their workflow
were launched. Two examples of this kind are
Microsoft Groove and Collanos Workspace.
These collaborative tools act as a combination
of online whiteboard, message forums and chat
rooms, so that physical distances are no longer
a hindrance to effective communication. Users
also have access to management tools, which
help in assigning tasks, deadlines and manag-
ing multiple assignments. 

In this article, we are previewing Collanos
Workspace—a free software that works across
multiple platforms and though a bit bare-boned
compared to the paid Microsoft Groove, it does its
job pretty well. The latest version can be down-
loaded from www.collanos.com. Also check the
December 2007 Personal Tech DVD for a slightly
older version (1.1.16) of the same software. 

Inside Collanos Workspace
After you have installed the software, you would
need to adjust your settings, if you are working
behind a proxy. You would also need to create a
user account and create a profile, which can be
viewed publicly. Once that is done, you are all set! 

Collanos Workspace is based on Eclipse, so
if you have used that IDE, you will find yourself
on familiar territory. The default interface is
made up of different modules like Members,
Workspace and Discussions, though the View
option in the menu can be used to show more
modules. Here is the full deal on the ins and
outs of Collanos. 

Workspaces
Workspaces are where a user typically spends
maximum amount of his / her time. This
space lists all the files, links, discussions, etc—
basically all the activity since the start of the
current session. It also includes all the mem-
bers that you have invited to share those
resources as well as the discussions, which go
on in the discussion pane. You can open
unlimited number of workspaces with their
own separate collaborators, resources and dis-
cussion threads. The current workspace in

With
collaborative

software,
businesses
spread over

multiple
locations can

now work
seamlessly with

just a click

The default view of Collanos Workspace

Creating a new task
takes seconds
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The Best 
Indie Games
You (n)Ever 

Played
There are games that cost a small country's GDP to 
make, and are about as much fun to play as dipping 
naked into a pool filled with hungry piranhas must 

be. And then, there are Indie games. Small, short, fun, 
and brimming with unique ideas. These are the games 

that take the risk. These are the games that protect 
you while you sleep. This is thus a public service 

announcement: adopt an Indie game, save the world.

Ahmed Shaikh

And Yet It Moves
http://www.andyetitmoves.at/

And Yet it Moves is a classic platformer with a 
twist—while it lets you run and jump around 

the game world, like any Mario game might, it 
also gives you the unique ability to rotate the 
entire world. This simple mechanic opens up 
opportunities in level design which are used to 
great effect by the game. Platforming puzzles 
take on a new bend asking you to literally get 
your head around them to solve: rotate the 
world around and walk on the ceilings or run 
along the walls! When you rotate the world, all 
objects are briefly frozen in mid-movement, 
only to continue in their original velocity after 
the rotation. The game, created by a group of 
students at the Vienna Institute of Technology, 
also uses an attractive “ripped-paper” look to 
translate its world. Give it a go!

Chains of 
Olympus114 Burnout 

Paradise115 Tabloid 
Tech130
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Karoshi 2.0
http://gmc.yoyogames.com/index php?showtopic=369491

Karoshi and its sequel both consist of a 
series of levels in which the goal is for 

the player character to kill himself. The levels 
are essentially puzzles, each with a different 
goal—while some might ask you a simple Yes / 
No question (“Are you an idiot?”), others will see 
you pushing crates and collecting coins. With 
progressing levels, the puzzles get more bizarre 
and clever and the game succeeds in being fun 
by not resorting to obtuse puzzles. The second 
game is more varied in its content than its pre-
decessor, which had one too many levels consist-
ing of crate-pushing puzzles.

As its name suggests, this 
game is all about pulling 

off heists. In The Art of Theft 
you control Trilby, a thief out 
to “scare the ignorant rich by 
hitting them where it hurts—
their wallets”. It is a mission-
based, stealth platformer, pre-
sented in 2D and created by 
Ben “Yahtzee” Croshaw—the 
British-born author of several 
adventure games and the hilar-
ious Zero Punctuation series of 
video reviews.

Your goal in The Art of Theft 
is to infiltrate a variety of 

buildings in Chapow City, steal 
loot, avoid alarms and security 
guards and get out again with-
out being caught. The game 
allows you to trigger a certain 
number of alarms each level, 
before forcing you to play the 
level again. Similarly, you can 
tazer security guards to knock 
them unconscious—this too 
can only be done a limited 
number of times each level. 
The game then scores you on 
the basis of time taken, loot 
stolen, and alarms triggered, 
and so on.

Trilby: The Art of Theft
http://www.escapistmagazine.com/content/games/yahtzee/artoftheft

Jonatan Söderström is a 
young game designer from 

Gothenburg, Sweden and 
Cactus Arcade is a compila-
tion of some of the best games 
he has released under the 
banner of his fledgling game 
development company Cactus 
/ Games. The compilation con-
sists of 17 games that vary 
across genres—from platform-
ers to shoot ‘em ups. 

Clean Asia, for example, is a 
vertical shooter in which you 
play the role of some US fighter 
pilots as they go against an 
alien menace. The game has 
three levels and two selectable 
ships, each with unique con-
trols and abilities. It faces you 
off against fourteen bosses and 

around ten regular enemies.
The compilation also con-

tains Shotgun Ninja—a plat-
former, and SeizureDome which 
Jonatan describes as a sumo 
wrestling game but with guns: 
the goal is to avoid letting the 
swarm of enemies push you out-
side of a ring; using powerups, 
and special weapons to garner 
combo kills.

Cactus Arcade
http://www.cactus-soft.co.nr/

You Have To Burn The Rope
http://www.mazapan.se/games/BurnTheRope.php

Perhaps the shortest game in this list, or not, 
depending upon the way you interact with 

games. The game has been described as a “joke” 
by its creator—the 21-year old half-Persian, half-
Finnish Kian Bashiri. Kian describes it as “this 
really silly idea… a statement about how games 
are too hard and complicated. It’s also a sub-
tle reference to how some games are kind of 
patronising toward the player, like too easy.” 
The tongue-in-cheek nature of the game is 
also reflected in the ending credit song which 
declares: Now you are a hero / you managed to 
beat the whole damn game / we are happy you 
made it / but how are you gonna spend the rest 
of the day? 

You of course, hit refresh and play it all over 
again.
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PAROXYSM
http://neuralscan.co.uk/Paroxysm.html

Spinning blades, swinging axes, pools of blood, 
and lots of fun, that’s Paroxysm in a nutshell. 

If you crave for a platformer with cool traps and 
fiendish jumps to sink your afternoon into, this 
game will do you little wrong. The concept is 
simple: You have fallen into the Dungeon, and 
the only way out is through it.
As the game says, “Be quick, be smart. Your life 
depends on it.”

Takase’s Dot Fighters is a 2D 
fighting game with a unique 

art style. The game’s sprites are 
made up of exaggerated pix-
els and coloured squares. As a 
fighting game, while it does not 
reach the level of complexity of 
a Virtua Fighter or even a Dead 
or Alive—its fighting engine is 
nevertheless satisfying enough 
to entertain. Two attack but-
tons are used—to punch and to 
kick, however there are plenty 
of moves that emerge from 
this two-button combination. 
Successful fights see you accu-
mulate Dot Power which can 

then be used to unleash special 
attacks. Four fighters are avail-
able in the latest version of 
this Japanese title. Gameplay is 
extended slightly by the Quest 
Mode which adds additional 
boss fights and bonus rounds.
(CONTROLS: [A] = punch [S] 
= kick. [ESC] = pause the 
game. [Alt] + [Enter] 
= fullscreen mode). Combos 
are usually initiated by tap-
ping one of the action buttons 
repeatedly. Additional moves 
such as air combos, reversals, 
throws, safe landings and rolls 
are all here.

Dot Fighters
http://www.indiegames.com/blog/2006/10/news_39.html

If Geshundheit (read on) grabs 
you by its concept and artwork, 

Cottage of Doom does so by the 
sheer force of its name. Cottage, 
OF DOOM. DOOM. Admit it: you 
want to play this bad-boy right 
now, caress its DOOM, rub your 
mouse all over… 

CoD is an arcade shooter 
with a survival-horror bend. The 
game puts you inside a Cottage 
(of DOOM) and throws an ever-
increasing number of zombies 

at you. The goal is simply to 
survive as long as possible. 
What makes it cooler than 
cool is that you can interact 
with your surrounding—repair 
doors and windows to serve 
as barricades, pick up and use 
furniture to get ammo and 
planks, and of course right-
click to shoot (combo kills rack 
you bonus points). It’s a hectic 
little shooter that fittingly 
always ends with your DOOM.

Cottage of Doom
http://sourceforge.net/project/showfiles.php?group_id=197730

Gesundheit
http://www.underwaterbase.com/

This game has you from hello—playing a 
sneezing pig to save a city from snot-eating 

monsters? If your heart doesn’t skip a beat to 
the idea, then you sir, have no soul! Geshundheit 
is a 12-level action / puzzle game created by 
Matt Hammill. The game features handmade 
“scratchboard graphics” and an original toy-
instrument soundtrack, making it a true treat 

for both the eyes and the ears! Matt has only 
released a demo, but the demo contains the 
aforementioned twelve levels and a tutorial to 
teach you how to sneeze.

The puzzle aspects make this game an 
interesting experience through its levels: 
while keeping out of sight, you must lure your 
enemies with your delicious nasal discharges. 
Objects scattered around town provide your 
pig with different ways of solving each puzzle. 
Boogericious!
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Phun
http://www.phun.at/

Phun is a game in the most classic sense of 
being an open sandbox which allows you 

to do pretty much anything that is anchored 
with a pretty good simulation of the basic 
laws of physics. As a sandbox game, how much 
fun you have with it, is entirely up to you. It 
was created as a thesis project by Computing 
Science student Emil Ernerfeldt. Think of 
Phun as The Incredible Machine meets your 
physics professor.

De Blob entered the main-
stream radar when THQ 

picked it up for a release on 
the Wii console. The game was 
a project by students at the 
Utrecht School of the Arts, 
developed by a team of nine 
in just four months. De Blob is 
a 3D game in which the player 
controls a blob of paint rolling 
through the city. The goal is 
to paint the entire town—not 
just red but in various colours 
available. The blob absorbs new 
colours by rolling over char-
acters in the game world and 
as it does so, it also becomes 

larger. The game also allows 
mixing of colours to create 
new colours: if you need to 
turn green you’ll have to pick 
up a blue and a yellow person. 
Almost everything in the game 
can be painted—the trees, the 
buildings, the cars, the blob 
even leaves a trace of paint on 
the ground as it rolls along. 
The game offers 17 landmark 
buildings which must all be 
painted to fulfill the goal of 
the game. De Blob also hides 50 
coins across its level that can 
be found by meeting platform-
ing challenges.

De Blob
http://www.fun-motion.com/physics-games/de-blob/

Toribash is an idea that at 
first seems bizarre and gim-

micky but soon presents itself 
as a wickedly good twist to 
an age-old genre. Toribash is a 
turn-based fighting game. Yeah, 
you read that right. The turn-
based fighter features charac-
ter customisation, online mul-
tiplayer, saving and sharing of 
replays, and plenty of gore and 
dismemberment. The core of 
the game sees your character 
represented by a rag-doll (the 
appearance of heads, limbs, 
and joints can be changed). 
The game is then played by 
manipulating the various joint 
that comprise this rag-doll, and 
then hitting the spacebar to 

inflict dangerous kung-fu on 
the opponent’s rag-doll. When 
properly manipulated your rag-
doll will strike the opponents 
and will do a certain amount 
of damage based on the angle 
of attack, the momentum, and 
so on. The hours disappear into 
Toribash as you seek to find 
the best combination of angled 
arms, twisted hips, bent ankles 
and so on… to effect flying 
limbs and fountains of blood 
from your opponent.

Toribash
http://www.toribash.com/

Chalk
http://www.konjak.org/chalk.htm 

Draw your way to glory! Chalk is a unique 
action game created by Joakim Sandberg—

some of his professional work can be seen in 
games such as X-Men 3: The Official Game released 
for the Nintendo GBA and Contra 4, released for 
the Nintendo DS. In chalk your drawings are 
the means to interact with the game world. 

Your right mouse button controls player move-
ment, while you draw shapes with the left but-
ton to interact with the game elements.

Chalk allows you to draw lines across shapes 
in the game world in order to destroy them, or 
turn bullets back at your enemies, and defeat 
bosses by bouncing stuff off them, much like a 
game of Arkanoid.

The game comes with six levels. Beating 
each of them with an A ranking, unlocks the 
endurance challenge.
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Racing Pitch
http://secretexit.com/games/racingpitch

Well here’s a strange one from an indepen-
dent game development company of two 

called Secret Exit. Racing Pitch calls on you to 
race around the track using, wait for it, your 
engine-mimicking skills to race down tracks. A 
microphone is an essential tool for the game as 
you literally blow “vroooom vroooom” noises 
into the phone to move your race car around. 
The speed of the car is controlled by the pitch 

of your engine mimicry and no other control 
points are required except for your voice. 
Racing Pitch also has party games to break the 
monotone, and its track challenges add another 
layer to this simple concept. The game also 
allows you to take a break from the racing by 
taking a flight in a hot air balloon. While not a 
game one would sink hours into, it’s definitely 
one that will leave you breathless!

Rose and Camellia
http://nigoro.jp/game/rosecamellia/rosecamellia.php

In Rose and Camellia, the goal is to slap your 
opponent silly, in order to climb the social 

ladder. Why are you still reading this? 
Since this is in Japanese: To launch your 

slap, move the mouse from the bottom right of 
the screen to the upper left, creating a line that 
crosses the opponent’s cheek. Click on the eva-
sion button to avoid your opponent’s attacks, 
and counter attack. Move the cursor from the 
bottom left of the screen to the bottom right to 
sidestep a slap.

Knytt is a 2D platform game 
developed by Nicklas 

Nygren. The game sees a 
creature called Knytt (“tiny 
creature” in Swedish) abducted 
by an alien and taken to a 
planet, where the abductor’s 
ship crashes trapping both 
Knytt and the alien on an alien 
land. The story then sees Knytt 
venture into the alien world to 
look for the missing parts of 
the spaceship. The game has 
no bosses or alien creatures 
to defeat—it is described as 
“ambient gaming”, in that you 
explore a world which is at 
best oblivious to your presence. 
The game has a prequel to 

its name called Knytt Stories 
which builds upon Knytt by 
offering four worlds of varying 
sizes to explore. Each world 
is a self-contained adventure. 
For example, in one particular 
level, you have to stop a 
machine that sucks the life out 
of the planet. 

Knytt / Knytt Stories
http://nifflas.ni2.se/index.php?main=02Knytt_Stories

An oldie from 2005, Ocular 
Ink is a bizarre game that 

features you as the role of a 
paintbrush-wielding eyeball. 
Gameplay is through gestures 
rather than button presses—
think Black & White—these 
gestures play a variety of 
effects on your surroundings 
and help you vanquish the 
evil dismembered body parts 
(are those kidneys?!) that roam 
the countryside as you make 
progress to defeat the evil 
eye-pirate known as Patches 
Deadlights. Cute. The game 
also comes with a full-featured 
level editor, called DARLA 
which can be accessed from 

the main menu. All the game 
assets are available to edit and 
you can either alter existing 
maps or create your own 
levels via neat features such as 
terrain height manipulation, 
which allows you to lower, 
raise, and deform terrain to 
create landscapes.

Ocular Ink
http://pistachioproductions.com/dart/
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Cave Story is perhaps syn-
onymous with Indie game 

development. First release in 
2004 by Daisuke Amaya, it is 
the second Metroidvania game 
in our list and is perhaps the 
most sublime game created, 
not with a large budget, but 
with over five years of love and 
attention to detail. Simply put, 
Cave Story is a must-play for 
every gamer.

The game starts you off 
without any weapons but items 
are soon acquired throughout 
the game’s progress. Jet packs, 
beam weapons, bubble gun, 
and so on are some of the 

weapons and items that see 
you through the game’s tale of 
amnesiac robots, bunnies, and 
power-hungry scientists. The 
graphics, presentation, and 
music are deliciously retro and 
serve to underline the classic 
roots of this title.

Cave Story
http://agtp.romhack.net/project.php?id=cavestory

Warning Forever is an amaz-
ing shoot ‘em up that 

throws in the mechanic of a 
boss-rush to make it an abso-
lute must-play for fans of 
the genre. The game pits you 
against a constant stream of 
battles that increase in diffi-
culty as you progress. Each of 
the game’s stages consists of a 
single boss battle. To progress 
to the next stage, the boss must 
be completely destroyed within 
the time limit. The game starts 
with a default time limit of 
180 seconds, with 30 seconds 

rewarded for every boss defeat-
ed and 20 seconds lost for each 
time the player is destroyed. It’s 
fast, it’s frantic, it’s clever, and 
it’s a lot of fun.

Warning Forever
http://www18.big.or.jp/~hikoza/Prod/

The Underside
http://www.superfundungeonrun.com/insignificant-
studios/preview.php

Described by the author as an “exploration 
platform game”, Underside is a Metroidvania 

game similar to Castlevania, Metroid, and Cave 
Story. The difference lies in how progress is 
made: while classic Metroidvania games reward 
free-roaming exploration, Underside is more 
driven by plot.

The story revolves around ‘Ip’ who must 
make his escape from the Underside, and pre-
vent the world from being destroyed by the 
world’s god—The Universal King—while he’s at 
it. The game’s creator, Arthur Lee, claims to 
have been inspired by the classic Earthbound 
series (also known as Mother in Japan) in shap-
ing the game’s concept of a flat world turned 
upside-down. Underside sees characters and 
dialogue that take on a quirky appeal, with a 
decidedly whimsical plot.
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I
could try, but I still
couldn’t come up with a
flaw for the God of War
(GoW) game, except this:
they end. While we wait

impatiently for God of War 3,
we must content ourselves
with God of War: Chains of
Olympus (CoO) on the PSP... 

CoO takes us to a time that
predates the first God of War
game, to establish further why
Kratos is so ticked off with the
gods of Olympus. The madness
begins when Morpheus, the
god of dreams, kidnaps Helios,
the Sun God, plunging the
world into darkness. As he
goes on his quest to bring light
back to the world, Kratos will,
once more, get acquainted
with the innards of many
beasties, from basilisks to
Cyclopes to Minotaurs and
floating suits of armour. 

The action begins about
five seconds after you select
“New Game”, and stops at the
last cutscene, so prepare for a
really sore pair of thumbs. The
control system had to change
because the PSP doesn’t have
the L2 and R2 buttons or the
right analog stick—this takes
about ten minutes to get used

to. Kratos’ Blades of Athena
are still the most fun weapons
you get to use, but there’s also
the Gauntlet of Hercules that
does enough damage in a
single blow to make you grin
from ear to ear. 

This title has everything
you could possibly love about
a GoW game—huge, beautiful
environments, insane action,
lots of blood, a sex minigame,
more blood, a story befitting a
high-budget B-grade movie,
puzzles that give you a “sense
of accomplishment” (even
though a five-year-old could
accomplish them), a little more
blood, and best of all—no
annoying loading screens! For
the best-looking game on the
PSP yet, that’s saying a lot. So
why am I not giving it a 10? 

About seven hours into the
game, when you’ve realised
that you’re addicted and should
go warn the world that you’re
unavailable until further notice,
CoO ends. Just when you’re get-
ting warmed up. Poof—Main
Menu. Grr. You can satisfy your-
self with the challenges, but it’s
just not the same. Bah.

nimish.chandiramani@
thinkdigit.com

Rating: 9/10
Developer:

Ready at Dawn Studios
Publisher:

Sony Computer Entertainment

Distributor:
Milestone Interactive

Contact: sales@
milestoneinteractive.com

Price: Rs 1,499

Ye Gods!
Kratos’ bad-assed goodness—now on the go!

Ye Gods!
Kratos’ bad-assed goodness—now on the go!
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W
hile Burnout Dominator was
something of an incremental
update on Revenge, Criterion
has taken Burnout’s original
concept, thrown away all but

the essentials, and given us a lot more to
love. Instead of racing on a collection of
tracks, you’re thrown into Paradise City
(yes, the game even begins with the song)
and told to go forth, crash, and burn(out). 

Paradise’s heart is still in the right
place—there’s lots of racing, and lots of
crashing. Thanks to the power of the X360,
crashes are minutely detailed, and so beau-
tiful you’ll want to crash again. Racing
speeds start at eye-widening and move up

to eye-popping—there is much adrenaline
to be secreted here. 

My favourite new game mode is Marked
Man—you have to survive the journey from
point A to point B, while other racers try to
take you down. Opponents in this mode are
particularly nasty too. Race events evoke
mixed feelings—you’re only told your desti-
nation, and you get to choose the route you
take to it. While this is nice—you can blast
your way through shortcuts and win easily—
it also means that in your first few races,
you’ll take a wrong turn and lose your way. 

For some reason, Criterion has removed
the tremendously fun aftertouch takedowns
(taking down opponents even after you’ve

crashed) from the game, but after spending
so much time in the game, I’m not too sore. 

Burnout Paradise is easily one of the
best-implemented games ever. Explore
Paradise city all you want, find shortcuts,
super jumps and other secrets, and when
you want to start an event, drive up to your
nearest traffic signal. The Multiplayer
mode is loaded with different sets of chal-
lenges for two, three or more players, so
there’s a lot to do when you’re online. Even
if you don’t go online, it’ll probably take
you a hundred or more hours to actually
hit the “100% Complete” mark, and it’ll be
time well spent.

nimish.chandiramani@thinkdigit.com

Xanadu! Utopia! Valhalla!

Rating: 9/10
Developer: Criterion

Publisher: Electronic Arts
Distributor: Redington

Contact:xbox360@redington.co.in
Price: Rs 1,999
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According to a survey by
brandchannel.com, Apple is

considered the world’s best brand.
Which of the following didn’t
make to top five?
a) Google
b) Microsoft
c) Coca-Cola
d) Nike

Which of the following is not a
browser from the early 90s?

a) Cello
b) Opera
c) Nautilus
d) Mosaic

Only one of these artists
hasn’t released an album

that isn’t a free or “pay what you
want to” download. Who?
a) Nine Inch Nails
b) Radiohead
c) Eminem
d) Madonna

Which of the following games
recently hit the 100-million-

sold mark?
a) Half-Life
b) Diablo
c) The Sims 2
d) Lineage 2

Find the odd one out 
a) Bluetooth

b) Zigbee 
c) Wibree
d) Infrared

This software for the Apple II
computer established

personal computers as viable
business tools. 
a) VisualCalc
b) OpenOffice
c) Lotus 1-2-3
d) Word Star

Which of the following
companies released the Open

Computer—one that could run Mac
OS X natively?
a) Psystar
b) Spystar
c) Rockstar
d) Psychstar

By using the computing power
of PlayStation 3’s Cell

Broadband Engine, over a million
users donate computing resources
to a project called…
a) Folding@home
b) Rosetta@home
c) SETI@home
d) Proteins@home

Which Web browser is tuning
itself for the upcoming

release of Android?
a) Firefox
b) Safari
c) Opera
d) Skyfire

10

9

8

7

6

5

4

3

2

ACROSS
7. A vertical set of data as in a table or

spreadsheet (6)
8. Program that runs continuously in the

background on Unix machines (6)
9. Forward Explicit congestion

Notification(abbr) (4)
10. To enter data into a computer (5)
11. Famous internet portal (5)
13. Audio or video file that subscribers can hear

or view online (7)
16. ‘C’ in CPU (7)
17. Bug-free code (5)
20. Social networking site sponsored by Google (5)
21. Available software that is not paid for (4)
22. ‘O’ in OSI (4)
23. An image representing a user in a multi-user

virtual reality space (6)

DOWN
1. Front sheet of a Web site (8)
2. To write content on a CD,DVD, or other

recordable disc (4)
3. To decompress and open up a file compression

program (5)
4. Automatic DAta Parallelism TranslatOR(abbr) (7)
5. A column in spreadsheet software (8)
6. Connector on a computer to which peripheral devices

are attached (4)
12. Call initiated from a call centre agent to a customer (8)
14. Keyboard part when pressed, enters ASCII character

32 (5,3)

15. Part of the Microsoft Windows GUI typically occupying a
fixed strip along the bottom of the screen (7)

18. Abbreviated Test Language for Avionics
Systems(abbr) (5)

19. Readable and writable external storage medium (4)
21. File Transfer and Access Method(abbr) (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

All Hail The Web
What does AIR in Adobe AIR
stand for?

a) Application Instruction Runtime 
b) Adobe Integrated Runtime
c) Application Interface Realtime
d) Anonymous Installation

Repository

1

Although online
documents

showed the Opera
browser at The Third
International WWW
Conference in 1995, it was
called MultiTorg Opera and
was not available to the
public until version 2.0 was
ready for public release as
shareware.

Did You
Know?

Answers

1. b
2. b
3. c
4. c
5. c

6. d
7. a
8. a
9. a
10. c

Crossword by Nitta Jaggi

Last month’s Winner
No Winner!
Better luck next time!

Send in your entries to
TQ@thinkdigit.com on
or by the 20th of this
month. One lucky
participant 
will win 
3ds Max 9 Bible
By Murdock
Published by

Win!

April’s Solution

TQ_May_08.qxd  5/13/2008  2:29 PM  Page 116



vital as this is helping their
cause. Somebody sure has a
lot of explaining to do!

IMMMORAL POLICE

Illegal
Records

While file sharing
and downloading
movies isn’t a big

deal in India, in the west,
people go to jail or land up
in courts for illegally
downloading content.
Therefore, it was surprising
when a security audit in
South Australia police
stations yielded movies in
computers belonging to
hundreds of officers. It has
been speculated that all
these movies were illegally
downloaded using P2P
software, either at these
computers or transferred
from other computers.
What tickles the bones of
oppressed file sharers and
dismayed the anti piracy
industry bodies is that
authorities have flatly
refused to prosecute the
officers involved for
copyright infringement. 

On paper, this “crime” in

Australia carries a stiff
penalty of A$ 60,500 (about
Rs 22,72,440) per file and
also a jail sentence of 5 years.
This means that if the bosses
in the South Australian
police force heed the anti-
piracy body’s pleas, then the
whole state would face a
problem enforcing the law,
because hundreds of officers
would be broke and behind
bars. And come to think of it,
when you have problems like
drugs and terrorism, file
sharing is just a harmless
schoolboy prank. People
don’t get hurt, nobody loses
money, artists get free
advertisements and the only
ones getting pinched are the
record labels. 

With this decision, it has
become harder to make
money off selling music and
movies in South Australia.
People down under
complain that they
download files because
latest movies and TV shows
beamed in Australia are
about 4 years old! A single
DVD also costs an arm and a
leg, swelling the ranks of
those using Bit Torrent and
other P2P applications. Here
is a bit of free advice to the
suits—lower the prices and

give the Aussies an updated
dose of the daily feed of
movies and soaps. That
would keep them busy.
Meanwhile the constabulary
can always be offered some
complimentary copies so
that everybody is happy.

I DO… WHILE GAMING

Bejewelled
Liaisons

Y
ou are a geek! You are
great at writing code,
serving up spiffy

applications and fragging
opponents in FPS games.
You are the king of all you
survey, as long as you only
survey your PC. Once you
have left those familiar
environs, the world and its
customs seem too
complicated and you make
yourself and people around
you feel uncomfortable with
your lack of social
conventions.

That’s the reason geeks
and nerds don’t really have
a great life when you take
computers out of the scene.
Sure, there are many geeks
who have girlfriends and
singing careers, but on the
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Like people,
organisations and
companies too have

their bad days. In such
times, a company would find
its touch with the normally
appreciative press to be
shaky and it gets flak for all
mistakes—big and small,
when the media honeymoon
ends and real life begins. 

This seems to be
happening with Facebook a
lot these days. Not long ago,
Facebook was this cool new
kid in town with most
media sites heaping scorn
on rivals like MySpace.
Starting with the Beacon
fiasco, however, Facebook
has seen only combative
attitudes from the press
and millions of users.
People were not the least
amused when the Beacon
started showing purchases
made by them on their
friend feeds. After the hue
and cry, Facebook withdrew

the feature and even though
it still gets bad blood over
Beacon, it seemed that the
worst was behind it.

But Facebook didn’t
reckon with the litigious
tendencies of its American
users. Cathryn Harris was
embarrassed when her
friend’s feed showed that

she had purchased a tacky
horror movie from an online
retailer Blockbuster. We
don’t know why she wanted
to keep her choice of movies
hidden from contacts—
perhaps she belonged to a
club dedicated to shunning
tacky horror movies, but she
was very clear on her next
step. She went ahead and
filed a class action suit
against Blockbuster,
demanding damages for
causing mental pain, agony

and invasion of privacy.
We are following the case
with fingers crossed. 

In related news,
Facebook is messing up
its ad placement
algorithms. This became
known when a user who
had kept his sexual
preferences as straight
had multiple offers from
chat Web sites offering to
set him up with gay men.
Contextual advertising is
how social sites are
supposed to earn their
revenue, and we can’t
help wondering how
fudging up something as

Random Access Memory
(RAM) was developed by
Jay Wright Forrester
around 1949. Born in 1918,
in Nebraska, Forrester
grew up on a cattle ranch.
The cattle ranch had no
electricity and is believed
to have spurred his
interest towards

electricity. In high school,
a young Forrester
assembled a 12-volt
electrical system from old
car parts, which effectively
gave the ranch its first
electrical power. This was
a wind driven system.

Forrester later attended
the University of Nebraska
and then graduated from
the prestigious
Massachusetts Institute of
Technology. He joined as a
research assistant at MIT's
high voltage laboratory.
After working and
pioneering feedback
control systems at MIT, he
went on to develop the
RAM as we know today. We
all know the importance of
the Random Access
Memory, popularly called
RAM. Contrary to magnetic
media such as hard disk
drives, there are no
movable parts in the RAM.
As a result, this piece of
technology significantly
boosts up computing speed
by reducing the access
time required for data read
/ write cycles. Forrester still
serves at the MIT Sloan
School of Management.

No Winner!
Better luck next time!

People Who
Changed

Computing

Pot Calls Kettle Black
Steve Shellhorn bought some coins from a man in North
Carolina and made a comment on eBay that he felt that the
coins were packed poorly. He was promptly sued for
$10,000 by the seller, who alleged that Shellhorn’s review
“tarnished his reputation”. The case fell flat—the seller had
no reputation to tarnish—he’s a registered sex offender!

FACE OFF

Bashed Book

Jay Wright Forrester

My Desktop

Whatever 
Happened To…

ZigBee

ZigBee is one of these
myriad wireless standards
that have a funky name

and peddled by a committee
called IEEE 802.something. 

Touted as a low-power,
low-cost and wireless mesh
networking standard ZigBee
1.0 specification was ratified in
2004. The basic goal of the
standard was to wirelessly
network and control heating,
lighting and security sensors.
The radio frequencies would
be short range with a speed of
250 Kbps, enough for such
kind of applications. The basic
premise was to set up the
network once, start it, and
replace the battery after four
to five years. This seemed ideal
for the home segment and
analysts and the media were
confidently predicting the
demise of Bluetooth and the
market being awash with
ZigBee products very soon.

Fast forward to 2008 and
the ZigBee Alliance (the body
responsible for standards) has
very little to show for their
efforts. Personal Area
Networks are still ruled by
Bluetooth, while newer
standards like WiBree are
gaining popularity. While there
are odd ZigBee products being
peddled on the Internet,
they’re few and far between. 

So what happened?
ZigBee’s proponents say that
they were too enthusiastic.
However, they also promise
that ZigBee’s time has finally
come and millions of devices
using it will be sold very soon.
Don’t bet money on that
happening soon though, and
for now, you have to switch the
toaster off manually!

User Experience
A top MS suit recently stated that the widely hated User Access
Control in Vista was not a mistake, but a carefully designed
feature. Apparently, Microsoft deliberately wanted to annoy
people so that they would not run systems as Administrator,
for security reasons. Bravo! Now more people are probably
getting infected from malicious sites that offer tips on how to “Disable UAC”

The age of the Terabyte!

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture
with a tech angle to it. The picture should have been shot by you, and should not
have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal
address, oonn oorr bbeeffoorree tthhee 2200tthh ooff tthhiiss mmoonntthh to digipick@thinkdigit.com. One
prize-winning picture will be published each month.

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

.net Interview 
Questions
by Nagaraju B

Published by

Participate and 
win next month:
Microsoft Office
PowerPoint 2007 Visual
Quick Tips
by Paul McFedries

Published by

Last month’s winner:
Abhishek Mukhopadhyay
Kanchipuram

Jay Wright Forrester

n Welsh student disgusted to find Jobcentre Plus ad for nude webcam operator n  Prank callers crash Dublin Zoo phone system n French trader scams Société Générale of €4.9bn (Rs 300bn), gets job as IT consultant n  Microsoft asks court to stop embarrassing disclosures 
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While nearly 15 per cent
males would give up
chocolate for sex,
(obviously). It’s just a
password which I can
change over the next hour.
Many may share this
opinion, while a fraud
worth a couple of millions
could take place using their
account details. That’s being
way too imaginative, yet
closer to being a possibility. 

It’s high time people
start using password
managers and even Web
browsers have password
management option. So, the
next time some one offers
free chocolate or sex / porn,
don’t get tempted.

OOPS

Dot Causes
Blood Feud

Turkish couple
Ramazan (24) and
Emine (20) Çalçoban

were having quite a
disturbed marriage and had
mutually separated.
However, the “love” still
remains—they continue to
exchange strings of text
messages over their phones. 

Yet another fight ended

with a message that
Ramazan sent to Emine
which was intend to mean
“You change the topic every
time you run out of
arguments.” Apparently,
Ramazan’s cell phone
didn’t support the Turkish
closed “i” (an “i” with no
dot). The word “sikisinca”
(see? even our font doesn’t
support it) appeared as
“sikisince”, which made it
severely offensive. 

Enraged by this message

to Emine, her father and
her two sisters attacked
him with knives. In the
ensuing kerfuffle, Ramazan
wound up with a knife in
his chest, which he
managed to extract and
share with Emine. Ramazan
managed to escape, but
Emine bled in the
ambulance, while waiting
for traffic to clear. 

Ramazan was soon
nabbed by the cops, and
still baffled by the

proceedings, killed himself,
confused for eternity.

This flaw in localisation
has apparently been the
cause of many
misunderstandings, but
none as deadly. Sadly
enough, this causes
problems with “delicate”
words more than anything,
so the result will likely
never be funny. It’s about
time someone yelled bloody
murder about these
localisation problems. 

Take A Crack, And zOther zStories
There are times when we receive letters of
adulation that brings tears to our eyes. This
month, however, we were all reduced to the
type of tears that the human body secretes
when opening the mouth way too wide to
laugh your guts out! 

A reader, who shall remain un-named,
took our “Take a Crack” section a little too
literally, and sent us a mail that said:

“Hello Digit, I want to take a crack of
Adobe Photoshop. Pls send fast.”!

In other news, Fatbeing (Nimish)
decided to bunk a day of work. He was also
shameless enough to tell Raaabo (Robert)
that he’s bunking because he didn’t “feel
like coming in to work”. Usually, we reward
honesty here at Digit, but shamelessness is
another thing altogether.
Here’s a chat transcript of

what transpired:
Raaabo: zdude, zi zgot za zvirus zthat

zadds za zz zbefore zevery zword zi ztype.
Fatbeing: riiiight!
Raaabo: zno zseriously, zand zi zcan’t zeven

zsearch zgoogle zfor za zsolution zbecause zit’s
zlike ztyping z“zvirus” zin zgoogle

Fatbeing: lol. really? You serious?
Raaabo: zdo zi zsound zlike zi zam zkidding

zaround zhere? zi zthink zit’s zadding za zz
zafter zevery zspace. zcheck zgoogle zfor zme
zplease

Fatbeing: Alrighty then. hang on.
One hour later...
Raaabo: zfound zanything?
Fatbeing: Nope, been looking for ages, can’t

find anything.
Raaabo: LOL! April Fool!

Fatbeing: You $*&#@%$!

MG Siegler
http://tinyurl.com/5m6g69
http://www.parislemon.com/2008/04/if-twitter-
breaks-in-woods-and-no-one.html
If Twitter breaks in the woods……
I noticed a few people thinking the same thing as me
today: is everyone taking a break from Twitter? People
do get burnt out from the web after all…... But no,
Twitter is broken. People are updating and most of the
updates are simply not coming through.

Click on some of your friends’ profiles. You’ll see
they have updates, yet those updates are probably not
in your Twitter stream. But some are, making things
even more confusing, and making it harder for people
to tell that Twitter is broken…

Darren Rowse
http://tinyurl.com/6q4gee
http://www.problogger.net/archives/2008/04/26/blo
g-design-does-it-matter/
Blog Design—Does it Matter?
How important is the design of your blog and how hard
a decision do you think it would be to develop a new
theme for it? There will probably be a little debate over
this one in the comments on this post because every
time I see someone write about design there are two
opposing arguments. 

On the one side are some bloggers who argue that
design is secondary and not that important, and that it’s
content that is what draws people to a blog and keeps
them there...

Evan Ackerman
http://tinyurl.com/6l9q99
http://www.botjunkie.com/2008/04/25/robot-laser-
deathmatch-is-just-practice-for-world-takeover/
Robot Laser Deathmatch Is Just Practice For World
Takeover
These little laser-equipped robots may not scare you
that much, but this is how it all starts: right now,
they’re a foot tall, but give them a couple generations
and they’ll be crushing us under their giant metal feet.
In the meantime, though, we get to watch these KHR-
1HV humaniod remote controlled robots take part in a
4 v 4 game of laser tag.

Gameplay seems to be a lot like a conventional
game of retail laser tag: run around and shoot anything
that moves on the way to the enemy base, where you
mindlessly pound away at the sensor ‘cause it’s worth
the most points. In this case, hitting another robot
causes it to fall over and become incapacitated for five
seconds and the team loses a point. Games last five
minutes, and the winners (I assume) get to strip the
losers for spare parts.

Twitter stops
twitting, and robots
plan doom!

Dress Up Games

If you were to head over to
http://www.petsin

uniform.com/, you would
have only one question in
your head—why would
anyone want to do this? This
Web site provides a valuable
service to doting pet owners
who want to see their dogs
and cats in full military
regalia. Simply chose a
uniform and a background,
upload a high resolution
close up picture of your pet
and wait for three business
days to get the photos of
your pet fitted out in
glittering ribbons and
peaked caps. For this
dressing up, the good folks

at Pets in Uniform would
charge you $19.99 (almost Rs
800). Pay up for the sake of
your cuties.

Seriously, this Web site
has convinced us that we are
wasting our time writing
articles when there is so
much easy money to be made
off the Internet. Sigh.

Documentation
Humour

Normally, technical
documentation and

signboards are dry and
boring. Manuals are the last
place for finding comic relief
while signboards convey
serious hazards with a
minimum of fuss. However,

sometimes quite
unintentionally, these dull
instructions have the
potential for a laugh or two.
Hall of Technical
Documentation Weirdness
(http://www.darrenbarefoot.c
om/hall/main.php) documents
hundreds of sources of comic
relief that sometimes make
you go crazy!

For example, what would
be your reaction when you
see a sign inside a toilet
forbidding either leaves inside
the bowl or swan dives off the
seat? Or the bit of honest
advice on a warning board for
“Wet Floor” which counsels
you to recline luxuriously in
case you happen to slip? 

whole, the picture looks
quite gloomy. However, for
geeks that are lucky to have
found a lady willing to put
up with their eccentricities,
they face the final hurdle—
how to pop her the
question! Even normal
people find it hard to utter
the golden words, so you
can imagine the stress a
geek faces! 

Bernie Peng was one
geek who was determined
not to go down that way. A
financial software
programmer, he felt lucky
to have a great girlfriend
and hoped to spend the rest
of his life with her. While
he could have taken her for
a romantic dinner and
dropped down on one knee,
he was not very comfortable
with the idea. Instead he
spent one month hacking
Bejeweled, an arcade game
that was his lady’s
favourite. The game was so
programmed that when she
reached a certain score a
ring would appear on the
screen, along with a
marriage proposal. When
Tammy Li ultimately
attained that score, she saw
the prize and happily
accepted the proposal. 

This story has another
happy ending. When the
makers of the game came to
know that it was hacked and

used to spell out the
marriage proposal, they
didn’t get mad or consider
legal action. Instead the
Seattle-based company
PopCap, plan to give all the
guests at the wedding, a copy
of the popular game and also
fly the couple down to
Seattle for their honeymoon.

PERSONAL AGAIN?

The Server
Conspiracy

Avirus is a nasty piece
of malicious code,
which wriggles

through smallest of the
holes in the big walls. In the
past, there have been a
couple of instances where
codes have even entered
manufacturing processes of
storage products and
infected a batch of them. HP
Australia happened to ship
its ProLiant servers with
optional USB keys, and they
happened to contain
viruses! Two low-risk worms
namely Fakerecy and
SillyFDC to be precise.  

If the hardware carries
a virus even before being
used, then where’s the
guarantee of protection
and security against those
that originate later!  

But why wasn’t this

found out at the factory
itself? HP is giving chance to
derive as many cool names
that might help them re-
brand themselves such as
“highly prerogative”. Sounds
cool, eh?

SEX, SWEETS AND SECRETS

Privacy For
Porn

Marketing is one viral
disease (or so they
say) and can make

anyone run for the hills.
According to a survey
conducted by Infosec,
outside Liverpool Street
Station, London, women
were far more likely to give
away their passwords than
males. The survey was part of
a social engineering exercise
for security awareness.

About 45 per cent
women shared their
password in exchange for
chocolate bars with fake
market researchers, whereas
only 10 per cent of men gave
away their login details. Now
if you ask for login details
and passwords in exchange
for something that’s
tempting, then people tend
to melt easily. A poll by
Cadbury revealed that 52 per
cent of women preferred
chocolate over sex. 
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SEO
SEM: This stands for Search
Engine Marketing. SEM is the
marketing of a Web site through
search engines, either by
improving page ranks or buying
listings on search engines.
Pagerank: Also referred to as
Google Pagerank, this signifies
the importance of a Web page
on the World Wide Web, with
respect to a search string.
Spiders: These are programs
that search engines use to
index Web pages. Spiders are
also known as crawlers and
regularly scan through Web
sites to update the search
engine's records.
CPC: This refers to cost per
click and is the amount that
the company being marketed
has to pay to the search engine
for each of its links clicked.
CTR: CTR is an abbreviation of
Click Through Rate. This signi-
fies the success of an online ad
campaign. For example, the
clicking on a banner or ad is
considered a success only if it
materialises into further busi-
ness with the company.
PPC: Pay per click is a very pop-
ular term in online marketing.
This refers to the service where
the company pays for each of
its ads that visitors click on.
Black Hat SEO: This is the act
of using “unethical” measures
to promote one's Web site. This
is done at the risk of being
blacklisted by the respective
search engine.
White Hat SEO: A white hat is
one who follows ethical meth-
ods to promote his/her site.
Usage: I had started my new
venture. I thought the best way
would be SEM. I designed my
site as per Google's spider
requirements and improved
my Pagerank. To avoid unnec-
essary costing, I chose words
with lower PPC and CPC rates,
so that with a lower budget I
could still manage an economi-
cal CTR. I have principles and
so chose to be a White Hat,
unlike others who don't mind
being Black Hats.

Wild Wild Web

n Confirmed: Google does own goooooooooooooooooooooooooooooooooooogle.com  n  Western Australia decrees laser pointers “weapons” n Japanese telecom major to provide cell phone users “fragrance download” service n Google and Yahoo work to dumb down the smartphone
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3. The A-List is a quick reference point for
the most popular technology categories.
Although we may not increase the number of
pages, we will try and cram in much more
information. And if that plan fails, we can always
try and provide it on the discs.

4. You should see more tempting
subscription offers soon.

5. We will try and let you know what’s
coming the next month, but you need to
understand that sometimes tests are delayed
because of lack of availability of products, in
which case our schedules go for a toss. Let’s see
if we can work this out.

6. ATI cards are very much here. We review
them as soon as they’re released. Currently, like
AMD vs Intel, ATI vs NVIDIA is quite a one-sided
battle. Don’t worry, we’re sure this will not last
long, and we’re eagerly awaiting AMD/ATI’s
response. Competition is what makes technology
such an exciting industry, afterall.

Team Digit

Digit On A Diet?
I am a regular reader of Digit magazine
and would like to appreciate the effort
that Team Digit puts in, to create a
magazine that makes us tech-savvy and
updates us about the latest in the
technology world. The only complaint I
have with the magazine is that you tend
to get slimmer during the February to
August period (excluding June). Your disc
casing has also become slimmer, and I
have seen that all issues before July 2007
had a casing that was 1.2 cm in thickness.
After that, the jewel case has become 0.8
cm in thickness, and this results in the
DVDs and CDs popping out of their slots
and getting scratched or worse, broken. I
cannot live without my regular Digit
software dose, so please make sure you do
something about this casing. Also, you
guys provide us with great software, but
instead of trying to find new software
every time, I would suggest you keep
providing updates to popular and good
software on a more regular basis. I also
suggest that you provide Fast Track as an
e-book, and make the main magazine
fatter. If possible, please also provide us
with a trial version of Windows Vista—we
have to try it before we buy it!

Kumar Ashok 
Jamshedpur

The magazines are always pretty much the same
number of pages (except special issues). What
does change is the paper, sometimes, which may
lead you to believe that there are fewer pages.

Inbox

Shocked Subscriber
I have been reading Digit for years, and I
should tell you that you are the ones
responsible for increasing my knowledge
about computers and other useful
technologies. You have been 100 per cent
successful in making a great magazine
that gives us all sorts of information at a
reasonable price. I decided to subscribe to
Digit and received my first copy this
month. I have a few suggestions:

1) You need to improve the packaging
of the magazine for subscribers. My
magazine came crumpled, because the
flimsy cover is of no use.

2) I am very disappointed in the way
the CD and DVD are packaged for
subscribers. I received a cracked CD, but
thankfully to my surprise, I found another
CD hidden in the Fast Track book. I’m not
so sure I will be as lucky next time. Please
give subscribers the hard plastic cases that
you give newsstand buyers. 

You need to update the prices
mentioned in the A-List as well—there is a
WD Passport drive that has been listed as
Rs 6,500 since last year.

Apart from this I have no complaints
with Digit, and I love every section. If
possible, please make the Digit Diary one
page again, so we can get to know Team
Digit better. Wishing you a very happy
anniversary…in advance!

Clinton Dias

We’re glad you enjoy Digit and thank you for
becoming a subscriber. We’re glad you got an
extra CD, which saved you from having to wait
for a replacement. The problem with the jewel
case that we’re able to provide to newsstand
buyers is that when we package it in subscriber
copies, it doubles our courier charges. It’s not so
much a question of weight, but a question of
Indian postal/courier rules. Since the cost of

everything is prohibitive now due to inflation,
which you have probably experienced yourself,
we are forced to disappoint our subscribers on
this one matter.

Team Digit

Suggestions Galore
I am regular Digit reader, but this is my
first mail to you. Digit is the best, but you
are completely ignoring programming
stuff. That would help students like me, as
would more Linux stuff. Please reserve
two pages for programming and Linux.
We also need a guide to help us install
additional software in Linux, and
demystify things like .tar, .deb, etc. You
could also add such tutorials in the form
of videos. 

Your hardware shootouts are very
helpful, but you should provide a long
folded page instead of splitting the
scoreboard over multiple pages, to help us
compare products better. 

A Fast Track to programming,
covering languages like C++, Java, and
Visual Basic, etc., would also be useful.

Your CD/DVD contents are the best,
and the interface is awesome, but try and
provide something like icon packages,
screensavers etc., to spice it up. Also try
and give newer movies, released in 50-70s
(Ben Hur, Roman holiday, etc.), instead of
only 1920s to 1930s movies.

You should also try and give hardware
as prizes for your contests, because what
would an MBBS or commerce student do
with a book called “Guide to
Programming” as a prize?

I am eagerly waiting for your
anniversary issue, and expecting
something different as usual.

Prathamesh

Whoa, that’s a lot of suggestions! We will come
out with a Fast Track to Programming soon
enough, keep your eyes peeled. You will notice
that we have already increased the Linux content,
and hopefully, we can continue to do so.
Providing the hardware test tables in a long sheet
is quite impossible, because sometimes we get so
many products, that it takes more than 8 pages
to list them all. We obviously cannot have a page
folded 8 times in Digit, because it would cost too
much (because of the irregular paper size), and
completely ruin the binding. We’re glad you like
the CD/DVD interface, and we will be adding
more features to it soon. As for our prizes, we
give books because we feel that the world has
forgotten the art of reading. Thankfully, Digit

readers do not seem to suffer from this disease,
which is evident from the fact that you are
reading this magazine. Nothing beats a book.
Period. Write in again next month and tell us how
you liked the anniversary issue.

Team Digit

Even More Suggestions
I am an 18-year old student, and an avid
Digit reader for over 3 years. Digit is a
very good tech magazine, with just the
right mix of IT content. I still have a
few complaints:

1. Digit is a little too expensive, at least
for us students. Why not make an e-mag
for people like me, obviously for a much
cheaper price tag. This would take care of
people like me who don’t buy the
magazine for the software on offer.

2. Secondly, please add more
information on IT events (tech expos,
gaming expos) going on around the
world, and cover it properly. Many of
them have gone unreported in Digit. Just
India-centric information of such events
would be nice. For example, we were
unaware of competitions like Microsoft’s
Imagine Cup until you guys reported it. 

3. Make the A-List bigger to include
more categories (budget/mid-range/high-
end), and provide information about
components like PSUs and cabinets.

4. Also try and offer subscriptions
without “free gifts” for even cheaper, for
people on tight budgets like myself. 

5. If possible, announce what you will
be reviewing the next month, so that we
can be prepared to buy issues accordingly.

6. What happened to ATI?

Gowtham Nayak

Wow! It’s truly inspiring that so many readers
are taking time out to give us suggestions.
Let’s look at them point-wise, as you have
mentioned them.

1. As for the price of the magazine, in the
ideal world, we would charge you nothing.
However, everything costs money—paper,
courier charges, DVDs/CDs, printing, salaries…
the works. We assure you that we are charging
you the bare minimum that we can, in order to
be able to deliver the quality content that we
do. We do have plans for an e-subscription
model, and hopefully we can work out all the
chinks to get it to you soon.

2. We do plan on covering as many events as
possible. You can rest assured that whether it’s
via the magazine or our Web site,
www.thinkdigit.com, we will try and cover
everything we attend.

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com
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We will look into the disc casing issue and
hopefully put an end to any such problems.

Team Digit

Intellectual Property
I was the first amongst my friends to
be introduced to computers. I quickly
grew in popularity because of my
“geek” skills. However, over the years,
everyone got a computer, and I wasn’t
exclusive anymore. I even tried
imagining fantastic technologies, but
that only lasted a while. All
throughout this phase in my life I
would see Digit gleaming on the
magazine stalls, but the cost was
prohibitive. Even my parents stopped
me from buying my first copy of Digit,
because they felt I needed to
concentrate on my studies, and not
waste time and money on magazines. 

I stayed adamant, and saved my
pocket money to buy my very first Digit.
That’s all it took. I showed it to my
parents, and ever since, everyone in our
house, including my parents and
grandparents, read Digit regularly. They
even buy me my copies the same day
that it’s released on the newsstand.

I still have an active imagination,
however, and keep dreaming up
inventions that I would like to make.
However, since I have no means to
create them, I find that a few years
later, such products are being rolled
out already. I wanted to know if there is
a way of protecting my ideas. I dreamt
up the Vision One Computer Desk
several years before it was announced,
but someone else beat me to making it.

Govind Nair P.
Kachani Karakulam, Trivandrum

We have to admire your persistence in getting
your hands on Digit. We’re glad to have helped
in what ever way we could.

As for patenting your ideas,
unfortunately, you can’t just dream of flying
cars and then go and patent the idea, unless
you have a viable way of being able to make
cars that fly. At least, you need to show  that
you are actively researching it, and show some
positive results. We would suggest that you
focus more on what you can implement,
instead of day-dreaming of fantastic
technologies. If you are technically qualified,
you can look to join research labs, where you
will not only get the tools, but the funding to
work on such projects.

Team Digit

Recreate The Magic
I want to congratulate you
for staying India’s number
one tech magazine. I’ve
been a reader for the past 6
years, and I want to thank my
college senior, who introduced
me to Digit. In the past 6 years I have
missed only 1 or 2 issues, because of the
remote place I live in, and my life felt
incomplete those months. During this
long journey with you, I have never felt
the need to complain or suggest
anything, because Digit was always
perfect. That changes today.

You guys keep innovating, and
bringing us new and exciting things,
but my suggestion is to go back to your
roots. My suggestion is actually
something you innovated yourselves!
Every issue of Digit has a section called
Q&A, that consists of… wait, who am I
trying to teach about sections? Anyway,
Q&A is something we readers find
immensely useful, and Digit already
provided us with a book that collected
the most common problems that people
faced, and gave it to us, long ago. For
the life of me I cannot remember which
issue it was, but I do remember that it
was years ago.

Why not make a Fast Track to Q&A
problems and solutions, because in the
years that have passed, the problems
have changed, so that old book are of no
use any more. I think most of us were
on Windows 98 when you made that
book. I’m even willing to pay extra to
get such a book, and I am sure other
readers feel the same way, so please give
it to us. And in case I haven’t said it
before, Digit Rocks!!!

Rhitwick Biswas
Tata Consultancy Services

First up, Rhitwick, thanks for sticking with us
through all the years. You know, we remember
that book for Q&A, and you’re right, it was ages
ago—over 4 years ago if we remember
correctly. We have followed that book up with a
Fast Track to Troubleshooting Your PC in 2006,
which was pretty much a collection of all the
problems that readers have, which we cannot
answer in the limited space of the magazine. 

We might just give you what you want
soon, and make an all new “Fast Track to
Troubleshooting Your PC #2”, but we cannot
commit to when as of now. Stay tuned! We
should be able to provide it soon enough.

Team Digit

Letter 
of the
Month

April 2008
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People And Events That Grabbed The Headlines—For Better Or For Worse

We all know that technology at times becomes so addictive, that resist-
ing it, is at times, next to impossible. Be it surfing the Web or using
gadgets, the addiction turns into an obsession which can get really

serious. In an interview with a popular lifestyle magazine, Madonna spoke about
life in general and her relationship with husband Guy Ritchie. 

While talking about dilly-dally things in her life, Madonna revealed that
every night “she sleeps with her blackberry”. Well to be specific, she keeps the
blackberry under the pillow. While she gets ready for bed, her husband plays
Brick on the phone. And how does she use Blackberry? In the middle of the
night, if she happens to recollect something that she missed out on, then she
notes it as a message on her Blackberry. 

Well, with all those occasional and supposedly private India tours that Madonna
undertakes, Research in Motion should consider signing her up as a brand ambas-
sador—especially with all the security hype over the Blackberry in India. 

When was the last time
you sent a bug report
and got a reply? Can’t

recollect? Well, try sending one
for Safari or any other bug report
to Apple Inc., using John Mayer
as the lucky mascot. You’ll get a
reply for sure. Last month when
John Mayer blogged about the
bug report on crashing iTunes,
he mentioned about his long
wait for a response. 

Mayer happens to be the gig
boy for Apple, since he per-
forms a guitar gig sometimes at
the Apple events. He also hap-
pens to be Mr. Job’s favourite
poster boy. But has anyone
heard from Apple as yet, on the
crash report submitted for the
Mac OS X? Following this, a
guest editor at popular Web site
Gizmodo, sent hundreds of bug
reports but didn’t receive any
reply from Apple.

After reading about John
Mayer’s problem, he wrote crash
reports and added “John Mayer
here” in the report, and waited
with fingers crossed. He also
mentioned that John Mayer gets
personalised replies from Apple.
To his surprise he got a mail

from Apple Support, asking
details about his PC’s hardware
configuration and OS. 

Hence, it is obviously
proved that using the “John
Mayer here” trick obviously
works. So the next time if you
have any crash reports with
iTunes or Safari for Windows,
then do try this gig. It doesn’t
matter if John Mayer knows
you personally or not, but it
does matter that you know who
John Mayer is!

Hey John, It’s me!
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Nothing can be so embarrassing for a Web site programmer,
than writing poor HTML code. What would you do if you
land up in the midst of the free way to the US elections?

Hmmm… it’s going to be tough for you to decide on whom to go
for—Obama or Hillary. 

Nothing bothers a candidate more than a goof up during cam-
paigning. Probably, that’s why Obama appeared gloomy, the past
few days when visitors got redirected to his opponent Hillary
Clinton’s site! On one fine Saturday, the visitors at Obama’s com-
munity blogs section of the site were redirected to Hillary’s site. 

Later it was discovered, that a person with user name “Mox”
had planted the hack for HTML exploit, due to cross-site scripting
vulnerability. Another user named “Zennie62” posted this hack
video on YouTube, which was later fixed.

Now if Obama is campaigning for such a high position, these
silly and common exploits can make quite a few giggle. When
small time hackers like Mox can take a dig at his site, what would
happen if Hillary hires a gang of hackers!

Soon after the exploit was fixed, Mox sent out an email to a
news site, informing that his action was mere “prank” meant for
fun. He wasn’t politically motivated and Clinton had no hands
behind the prank. Mr. Senator Obama, hope you heard that, and
your tech team might’ve heaved a sigh of relief. But be prepared for
who knows, a team of liberal hackers may gang up against you.
This is politics, dirty politics!

Caution…Election 

Haven’t we told you
about movies being
made from games and

vice versa? Somehow, either
both the concepts just don’t
appeal or weren’t given prop-
er treatment. Heard of Uwe
Boll? Doesn’t that name
sound familiar to you? He’s
the German director, produc-
er and screenwriter who
makes movies based on popu-
lar video games. 

This reminds us of Doom.
But no, Boll is more interested
in gory games like House of
Dead, Alone in the Dark,

BloodRayne, and more. Reports
indicate that there are over
200,000 petitions filed online
against him, all complaining
so that he may just stop mak-
ing movies! But does Boll feel
the lesser itch? No, because
he’s absolutely in love with the
video game industry. 

Recently, he was eyeing
World of Warcraft and intend-
ed to make a movie on it.
When he got in touch with
Paul Sams of Blizzard, he got a
very clear signal—“We will not
sell the movie rights, not to
you...especially not to you.” 

Madonna sleeps with her Blackberry

Play The Movie!
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